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Introduction 

Congratulations on your purchase of Cashflow Manager. This product has been developed 

specifically for small businesses because most of the other available options either require an 

understanding accounting or expenditure of considerable time and money attending training 

courses. 

Our goal is to provide a bookkeeping system so simple anyone can use it, whether you 

understand accounting or not. It also keeps excellent business records that makes it easy for your 

accountant. 

The bottom line is that we want to empower you to successfully manage your own business 

records. 

Cashflow Manager takes pride in our efforts to make life simpler for our business clients so that 

you have more time to do the things you love. Version 11 is our simplest ever and we have 

developed a brand-new navigation interface that enables you to jump between the sections of the 

program with a single click of the mouse. We trust you will find the program easy to use and a 

great help in running your business. 

The Cashflow Manager suite of small business bookkeeping products includes: 

Cashflow Manager 

Cashflow Manager records the money coming in and going out of your business. Simply record 

your transactions in columns. You don’t need to know anything about accounting, and 

everything is right there on the screen for you to review. Each column has a VAT type that 

automatically calculates the VAT and makes your VAT report a breeze. 

Cashflow Manager GOLD 

Cashflow Manager Gold is the complete small business bookkeeping solution. It manages your 

cash flow, prepares and manages invoices for both sales and purchases, and manages 

depreciating assets through the one amazingly simple package. You can even manage your 

inventory on items that are purchased and sold. 

Cashflow Manager is not designed to replace your accountant. It is designed to be a ‘win-win’ 

for both you and your accountant. 

Cashflow Manager is not a double-entry general ledger program that requires you to understand 

all about debits and credits, journals, and the difference between the various types of accounting 

classifications. Even if you know nothing about accounting, you will be able to provide your 

accountant with excellent records that are reconciled to your bank. 

Your accountants will be able to efficiently complete your accounts and tax returns and spend 

more time on helping you run a better business. 

With Cashflow Manager you can keep excellent records that make your accountant’s job easier 

and give you the information you need to manage your business without you having to learn how 

to be an accountant to achieve this. 

This will allow you to focus on the things that you must do to run a successful business, and cost 

effectively maximise the benefit of your Accountant's expertise. 
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Functions Common to All 
Programs 

 
 

Getting Started 

There are several functions and features that are common throughout the programs, whether you 

are in Cashflow, or Invoices, so we will review them in this section. 

 

Open the Program 

When you install the program from the download, the program icon will be put on 

your desktop. Click on the icon to open the program. 

You can also open Cashflow Manager by clicking on your computer’s START menu. 

The first thing you will see when you open the program is the Cashflow Manager Welcome 

Screen. This will disappear after a few seconds and the Start-up Options will appear giving you 

the option to Create a New Business, Open an Existing Business or Open the Sample File. 

Click on the selection you require. 

 

Create a New Business File 

The program is designed to have a separate file for each business you operate. This is different 

from earlier versions where Cashflow Manager had a separate file for each bank account and 

Invoice Manager was a separate program. 

To create a new file, simply click on the Create New Business File option from the Start-up 

Options window. Alternatively, select Create New Business File from the File menu in the top 

left-hand corner of the program. 

The program lets you setup an account for each bank, credit card or other account you wish to 

track in your business. A Wizard will assist you to set up a file for your business. Each of the 

steps in the wizard will have instructions on what to do. 

For more information, see ‘Create a New Account’ for each specific program. 

 

Getting Around 

The programs are designed to be very easy to find your way around. Each section is accessed by 

the new Side Panel on the Dashboard. Simply click on the tab for the function you want. 

On each page, there are buttons that perform various processes. For example, buttons that relate 

to the page you are on, or move you through a ‘wizard’ are at the bottom of the page. Buttons 

that move you to a new process or function are located on the right side of the page. 

Other functions are accessible from the Menu or by clicking on the icons. 
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Menus 

At the top of the screen you will find the File, and Tools menus that provide you with functions 

to use from time to time. 

When you click on these menus, a drop-down menu will appear. Position your mouse pointer 

over the option you require and click to select it. 

File, and Tools are the standard menu selections. The File and Tools menu items will change 

depending on the section of the program that is active. Consequently, you will find more 

information on the menu items in the User Guide information for each specific section. 



8  

Page / Screen Layouts and Buttons 

The programs are designed for consistency in the way they look and their functionality. 

For example, each section is accessed by ‘tabs’ on the new Side Panel. Sub-sections are also 

located on the Side Panel. 

The programs also use several buttons to perform functions. Functions that perform an additional 

function are generally located on the right. When you click on these buttons you will move to 

another page that performs another function. 

Buttons at the bottom of the page (screen) generally perform functions that relate to that page. 

For example, the [Save] button will save the information you have recorded or edited on that 

page. 

The [Cancel] button will cancel any changes you have made since you last clicked on the [Save] 

button and close the page you are in. 

So, to save your changes and then exit the page, click on the [Save] button and then on [Cancel]. 

If you just click on [Cancel] your changes will be lost. 

When you are in a sequenced process the [Back] button will take you back to previous page, 

also without saving. 

Throughout the User Guide the buttons are indicated by brackets such as the [Save] and 

[Cancel] buttons referred to here. 

 

Calendars and Date Selection 

When dates are entered, you have the option to click on the drop-down arrow to display a 

calendar that will allow you to quickly scroll through months and years to select the right date. 

Some tips for using the calendar are: 

❖ Click on the day you want to select. 

❖ Use the left and right arrows to scroll back and forth through the months. 

❖ Left-click on the month displayed to show a list of all months. 

❖ Left-click on the year displayed to show up and down arrows to scroll through the years. 

❖ The circled day is today’s date. Initially, today’s date is shown when opening the calendar. 

❖ Right-click anywhere in the calendar to go to today’s date, assuming your computer has the 

right date set. 

 

 

 

Reports 

The Reports have two purposes: 

1. To give you information to help you understand your business better, and 

2. Provide information to help you and your accountant follow the transactions you have 

recorded to prepare your taxes. 

Each section has its own specific reports and we will discuss those in the User Guide 

information for each specific section. However, the process for selecting and printing reports is 

consistent throughout all sections and programs. The process is as follows. 
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Step 1: Select a Report 

Click on the Reports tab to view the list of available reports listed with a description of the 

report. 

Click on the Report you require and then click on [Continue]. 

 

Step 2: Report Options 

The Report Options are separated into 3 areas. 

1. Account/Customer/Supplier/Employee Options 

Depending on the report you have selected, Cashflow Reports has the options for All, Current or 

Selected Accounts. Invoice Reports has options for All or Selected Customers/Suppliers. 

2. Date Options 

There are generally four options. 

This Month sets the dates to the month you are working in. 

This Quarter sets the dates to the quarter for the month you are working in. 

This Year sets the dates for the Financial Year you are working in. 

Custom lets you select the period you want to report for. 

Note: If you click on the drop-down arrows to select a date from the calendar the Select a Date 

Period will change to Custom. 

3. Other Options 

Some reports include other options such as including information from the Invoice section with 

Cashflow Reports, or printing Summary or Detailed reports etc. 

 

Step 3: Print Options 

Once you have selected the Report Options you can preview or print the report, or you can save 

the report in a different format including a HTML format, Microsoft Excel and Word formats, an 

Acrobat PDF format, as well as TIFF and tab delimited Text formats. 

Make your choice by clicking on the [Excel], [Save As], [Preview] or [Print] or buttons. 

When you choose [Excel], the file will be saved in a format that is specifically designed to make 

it easier to work in Excel. They are saved in a comma separated value (.csv) and you will need to 

open the reports in Excel and in the Excel ‘Text Import Wizard’ select ‘Delimited’ and then on 

the next screen select ‘Comma’ as the Delimiter. 

These are different to the other Excel Reports under the [Save As] option as they would not 

ordinarily fit on a page for printing and are designed for easier manipulation in Excel. 

When you choose [Save As], click on the Save files as type selector to access the different 

formats. 

When you choose [Preview], you can Print the report, email a PDF copy of the report, or Send 

to an Excel spread sheet, an Acrobat PDF file or a Rich Text File (.rtf) document. 

Click on the Zoom icons at the bottom left of the Preview to zoom in and out on your report. 

You can also view different pages using the page selector icons at the bottom left of screen. 

We recommend that you print your reports every month so you have a printed copy in the event 

of a computer catastrophe. 
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Drill-Down Reports 

Once a report is selected, there are options to select different parameters for the generation of the 

report. Different reports have different options such as the ability to select accounts, a date range 

or specific type of report. 

 
A variety of Version 11 Reports can “Drill-Down” collective amounts and transactions. This 

allows the user to locate and view individual transactions that make up these amounts. 

 
Transactions can then be selected to view and adjust, and the program will then automatically 

update collective amounts on the reports. 

 
The following reports can drill-down: 

 

Cashflow Manager 

 
 

Balance Sheet 

Cashflow 

General Ledger Listing 

Monthly Summary 

Profit & Loss 

Transaction Listing 

Trial Balance 

 
Invoice Manager 

 
 

Credit Note List 

Aged Debtors 

Sales VAT (Detailed Only) 

Order Status 

Sales by Customer (Detailed Only) Creates a Sales Invoice List Drill Down 

Sales Invoice List 

Statements 

Aged Creditors 

Purchases VAT 

Purchases by Supplier (Detailed Only) 

Supplier Balance (Detailed Only) 

Inventory Movement (Summary Only) 

Inventory Adjustments 

Inventory Valuation 

Items List 

Price List 
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Save Reports 

The program can save reports in several different formats for convenience of transferring to 

another program, for your employees, or for your accountant. 

To save a report in the format of a: HTML webpage (HTM), Excel spread sheet (XLS), Word 

document (DOC), PDF document (PDF), text file (TXT) or TIF image (TIF), click the [Save 

As...] button on the Print Options screen. 

You will be prompted with a standard Windows Save window, where you can choose the 

location to save the file, the filename and the type of file format. Click the [Save] button when 

ready, or click [Cancel] to close the Save window without saving. 

To save a report in the format of a: rich text document (RTF), Excel spread sheet (XLS) or 

PDF document (PDF), click the [Preview] button on the Print Options screen, which will load a 

print preview of the report, then click the [Save As…] button. The standard Windows Save 

window will appear where you can choose the location to save the file, the filename and the type 

of file format. Click the [Save] button when ready, or click [Cancel] to close the Save window 

without saving. 

The default location for saving reports will be the Cashflow Reports folder: 

“C:\Users\Username\AppData\Roaming\CFM\Cashflow11\Reports”. 

 

Email Reports 

Emailing a report will automatically save the report as an Adobe PDF document (PDF) readable 

by the program Adobe Reader (if installed into the default location, the folder will be in: 

‘C:\Users\Username\AppData\Roaming\CFM\Cashflow11\Reports’). You must have an 

Email Client program such as Outlook or Outlook Express configured for your email for the 

Email option to work. 

Webmail (e.g. Hotmail, Yahoo, or others accessed through a web page) will NOT work with this 

option. 

It is also advisable to have the latest version of Adobe Reader installed. This will apply also to 

the recipient of the email, who will need Adobe Reader to open the attached PDF file. 

To email a report in Cashflow Manager, you must first preview the report. Once you have the 

preview on screen, click the [Email] button. 

A new window will appear with information about the email document. Type in the recipient’s 

email address in the box marked Send To. 

A subject is not required, but can be filled in the box marked Subject. 

The third box shows a list of files attached to the email. The report just generated will be 

attached here. You can add other attachments by clicking the [Add Attachment] button at the 

bottom. This will bring up an Open Dialog window to browse and find the documents you 

require. When ready, click the [Open] button to add the items. 

To remove any added attachments, select the attachment item from the list, and click the 

[Remove Attachment] button at the bottom. 

There is a field where you can enter additional information for the email, which will be the email 

message body. Click in the ‘Message’ and type your message or select from the Email 

Templates. 

Another button at the bottom, [Show Employee Emails], will give a list of recorded email 

addresses of employees, so you can see the correct email address to send to. Click this button to 

show a tab called Email List. 

When you are ready to send click the [Send] button. 
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Also Note: Some email programs are designed to block other programs sending emails for 

security and privacy reasons. As the program tries to send an email, you may get a message or 

messages asking if you wish to allow access to send this email. You need to allow or accept this, 

or the email will not be sent 

 

Email Templates 

As a time-saver, you can create email message templates to auto-fill the message. 

 

Add, Edit or Delete Templates 
 

Click on the [Templates] button to add, edit or delete templates. 

To add a template, click the ‘Add’ option and type a name for the template. Click in the message 

area and type the template email message. Click [OK]. 

To edit a template, click the ‘Edit’ option and select the template from the drop-down menu. Edit 

the template and click [Save]. 

To delete an existing template, click the ‘Delete’ option and select the template from the drop- 

down menu. Click [Delete]. 

 

Use Email Templates 
 

To use an email template when completing an email, click on the down arrow and select the 

template you require. Click on [Fill]. 

 

 

 

Grid Font Size 

Cashflow Manager Programs are designed to have your computer’s font size set to the smallest. 

Version 11 allows you to change the “Grid Font Size” within the program. 

The program will default the grid font size to 8.25. The grid font size cannot be below this. 

To increase the Grid Font Size, click Tools/Options/Grid Font Size. Here, you can type in a 

font size applicable to you. 

The size of the grid will then change accordingly. 

This is a universal option, which you can access in Cashflow, and Invoice. This does not apply 

to Assets. 

 

Save, Back-up and Restore 

Cashflow Manager saves your data in a database file that is located in the 

C:\Users\Username\AppData\Roaming\CFM\Cashflow11\Data folder unless you have 

changed it to another location. 

‘Username’ is the name Windows uses for your account. For example, Bill Smith might have a 

Windows user name of Bill Smith. The file would then be located in 

C:\Users\Bill Smith\AppData\Roaming\CFM\Cashflow11\Data 

You should always make a backup of your data before you close the file that you are working in. 
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This means making a copy so that if something happens to your computer, or the file that 

Cashflow Manager has saved on your hard drive, you will not have lost all your information. 

We recommend backing up to a USB drive or another drive that is different to the drive that the 

program is loaded on. 

In fact, you should always keep a recent backup in a different location, so you have the 

information you need in the event of a burglary or fire. You can email your backup as well. 

The Backup and Restore utilities are a global function, meaning it affects the whole file. As the 

data file is integrated with the three programs, backing up or restoring a backup will affect all 

three programs’ data. This has the benefit of having to only back up one file containing all data. 

When restoring a backup, this will update or potentially overwrite data in the other programs, so 

caution is advised when performing this function. 

 

Back up Your Records 

1. Click on the Backup icon. 

2. Click on the [Browse] button. 

3. Click on the Save in: box and select the location for your backup file. 

4. Each backup file you make will have the “date” at the end of the file name, to indicate when 

it was made. 

5. Click on [Save]. 

6. If you wish to email your file, click on Email File When Backup Complete. 

7. Click on the [Backup] button. 

8. A message will appear advising when your backup is complete. Click on [OK]. 

 

Back up to CD 

Backing up to a CD generally involves two steps: creating a backup file that is saved to the 

computer’s hard drive, and then running a CD writing program like Nero or Roxio to burn the 

file to CD. 

Your Windows© Operating System may also include a feature to write your files to a CD. You 

will need to understand how to do this using Windows© and this is not an area that a Cashflow 
Manager CARE Support Technician can assist you with. 

 

Restore Your Data 

To restore your backup file into the program, click on the Restore icon. 

Click on the [Browse] button next to the Restore Source box to select the location of the backup 

file being restored. Select the file and click on [Open]. 

The Restore Destination Path will default to 

C:\Users\Username\AppData\Roaming\CFM\Cashflow11\Data as this is the first location 

that Cashflow Manager will look for your files when you want to open your files within the 

program. If you want the file to be saved in a different location, click on the [Change] button, 

and navigate to the location using the Save in box. You can also change the file name if you 

wish. For example, if you have used the date of the backup in your file name you may wish to 

edit that out. 

When you have finished these changes, click on the [Save] button. 

Click on the [Restore] button. 
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A message will advise when the Restore process is complete. Click on [OK]. 

You can now open the restored file. 

Restore from CD 

If you have burnt your data files onto CD then to ‘restore’ you will need to copy those files from 

your CD into the Data folder of Cashflow Manager 11 (normally 

C:\Users\Username\AppData\Roaming\CFM\Cashflow11\Data) using Windows Explorer. 

Note that in some versions of Windows© you will need to remove the Read Only attribute from 

the file before you can open it with Cashflow Manager. 

To do this, navigate in Windows Explorer to your Data folder, and right click on the file (Your 

Business Name.c11). Select Properties and then click on the Read Only Attribute box to remove 

the tick. Then click on [Save]. 

 

Reminders 

You can setup Reminders from the Menu Bar at the top of the screen. 

To add a reminder, click on the Reminder Icon in the top menu bar. Select the ‘Date to Remind’ 

and click in the Description box. Type a description for the reminder, and click [Save]. 

To view an existing reminder, click on the Reminder Icon in the top menu bar and select the 

[View List] button, select the reminder from the list and click on the [View] button. 

To edit an existing reminder, click on the Reminder Icon in the top menu bar and select the 

[View List] button, select the reminder from the list and click on the [View] button. You will 

now be able to edit the reminder 

To delete an existing reminder, click on the Reminder Icon in the top menu bar and select the 

[View List] button, select the reminder from the list and click on the [Delete] button. 

To delete all reminders, click on the [View List] button and click on the [Delete All] button. 

 

Passwords 

You can setup separate passwords (or none) for the Cashflow, and Invoice sections. You will 

however need to setup an administrator password before the section passwords can be setup, 

changed or deleted. The password is embedded in the file itself. This has the added benefit that 

when a file is sent to another party, or moved to another computer, it still retains the password 

for that file, and so increases security. 

As the password is embedded into the file itself, this makes it much harder to change or remove 

the password, so extreme caution is advised when adding a password to a critical file. If the 

password is lost or forgotten, it will be exceptionally difficult to retrieve the data from any of the 

three programs. 

Please keep your password in a safe place for access if you forget it. 

1. Click on File and then Password. 

2. Select Admin and then Add to create an Administrator password. 

3. Type in your password. Press your 'Tab' key to move to the next box and type it in again to 

confirm it. You can now setup passwords for the Cashflow, and Invoice sections of the 

program as you wish. You will be prompted to enter your admin password before you can add, 

change or delete any password in the program. 
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Close and re-open the program to allow the changes to take effect. 

 

Purge Old Data 

 
The program has a feature that enables you to purge old data. For example, if you have been 

using the program or parts of the program such as Invoice Manager for a long time, you may 

wish to purge old data to reduce your file size and speed up your program. 

WARNING: Please ensure you have printed all reports and backup to an external source before 

you purge your data. The program will do an automatic backup when the purge is conducted, but 

we recommend that you should also do one in your normal manner and keep it in a safe location. 

The purge process removes all data up to and including the month and year selected. 

The only items that won’t be deleted are those that have outstanding balances as at the purge 

date e.g. a cheque that is still outstanding in the Bank Reconciliation, or an invoice that does not 

have a 0.00 balance as at the ‘purge date’. 

1. Ensure all reports have been printed and your file is backed up. 

2. Click on the tab for any section of the program (Cashflow, Invoice). 

3. Click on the ‘Tools’ menu. 

4. Click on ‘Purge Data’. 

 
The Data Purge window will open. 

To purge Cashflow Manager data: 

1. Click on the ‘Cashflow data up to and including’ check box. 

2. Select the Month and Year for the data to be purged. Note: The purge process removes all 

data up to and including the month and year selected. The only items that won’t be deleted 

are those with related transactions after the date e.g. a cheque that is still outstanding in the 

Bank Reconciliation. 

3. Select the Accounts to be purged. All accounts are selected by default. If you do not want an 

account to be purged, click on the check box so that no tick appears in the box. 

4. Click in the check boxes for Invoices or Wages and establish the dates if you wish to purge 

these sections at the same time. 
5. When completed, click on the [Purge] button. 

 
To purge Invoice Manager data: 

1. Click on the ‘Invoice data up to and including’ check box. 

2. Select the Month and Year for the data to be purged. Note: The purge process removes all 

data up to and including the month and year selected. The only items that won’t be deleted 

are those with related transactions after the date e.g. invoices with outstanding balances. 

3. When completed, click on the [Purge] button. 

 
Note: if you have a lot of data in your file, the process may take some time. You will receive a 

message when it is complete. Do not close the program or shut down your computer while the 

purge is in process. 
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Technical Information 

Uninstall the program 

Windows 8 

To uninstall in Windows 8, move your mouse to the bottom-right corner of the screen to show 

side menu. Select Settings, Control Panel, Programs and Features. Select ‘Cashflow 

Manager 11’ in the list and click on ‘Uninstall’. 

Windows 10 

To uninstall in Windows 10, click on the Start button, and select Settings, System, and 

Installed Apps. Select Cashflow Manager 11 and click ‘Uninstall’. 

 

 

 

 

 

 

 

File Locations 

Most files are located in the C:\Users\Username\AppData\Roaming\CFM\Cashflow11 folder 

on your computer unless you have installed them elsewhere. This is a change from previous 

versions that have used the C:\Program Files folder and results from requirements for 

compatibility with recent version of Windows. 

This folder contains several sub-folders as follows: 
 

Bank For storing downloaded bank statements 

Conv This file is created when you are importing (converting) a file 

from a version 6 or below. 

Data Stores your c11 data files 

eAS Files for lodging your VAT electronically 

Export Accountant General Ledger Export files 

File Ready to 

Import 

Customer/Supplier/Inventory templates, Assets List, ready to 

import 

Import Help Instructions on how to create Customer/Supplier/Inventory 

templates 

Import 

Templates 

Customer/Supplier/Inventory Excel templates 

Reports For saving Excel, PDF and Text report files 

 
 

Templates Templates for printing in Word 

 
User Guide 

 
Version 11 User Guide in PDF format 
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The rest of the program files are located in the C:\Program Files\CFM\Cashflow11 (for 32 bit machines), or 

C:\Program Files (x86)\CFM\Cashflow11 (for 64 bit machines) folder on your computer unless you have 

installed them elsewhere. 
 

Bin Contains all the application and library files 

 

Specifications (System Requirements) 

Cashflow Manager is designed for a PC Computer running Windows©8, 8.1 or 10. 

The program requires at least 4GB of RAM with a XVGA (1024x768) or higher resolution 

monitor with 16-bit colour. You will need at least 150MB of hard disk space on your computer 

for your Program and Tutorial files, a CD-ROM drive and an Internet or phone connection for 

product activation. 

If you use a Mac you will need to use Bootcamp (free with a Mac) or VMFusion or Parallels 

together with Windows 8, 8.1 or 10. 

The Regional and Language Options (Settings) on your computer need to be set to English (UK). 

The font size on the monitor display needs to be set at the smallest option. 

 

Trademarks 

Cashflow Manager is a registered trademark of Cashflow Manager Pty Ltd in Australia and a 

trademark in other countries, and use of this trademark is prohibited without prior consent. 

Invoice Manager, Wages Manager and Rent Manager are trademarks of Cashflow Manager Pty. 

Ltd. 

Windows, Microsoft Word, Microsoft Excel, Internet Explorer, Outlook and Outlook 

Express are either registered trademarks or trademarks of Microsoft Corporation in the United 

States and/or other countries. 

Other products mentioned may be trademarks or registered trademarks of their respective 

companies 
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  Cashflow Manager Version 11 
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Cashflow Manager 

Getting Started 

Introduction to Cashflow Manager 

Cashflow Manager records the money in (receipts) and money out (payments) transactions 

of your business. You can then reconcile to your bank and cash on hand, and print reports 

for managing your business, preparing your taxes including the VAT report that makes 

completing your VAT a breeze. Cashflow Manager’s unique column system makes it 

amazingly simple to keep excellent records without knowing anything about accounting. 

 

Create a New Business File – Cashflow Manager 

Cashflow Manager 11 is designed to have a separate file for each business you operate. 

(Prior to Version 8 Cashflow Manager had a separate file for each bank account.) 

To create a new file, simply click on the Create New Business File option from the Start- 

up Options window. Alternatively, select Create New Business File from the File menu 

in the top left-hand corner of the program. 

A Wizard will assist you to set up a file for your business. Each of the steps in the wizard 

will have instructions on what to do. 

1. Do you have an existing Cashflow Manager file you wish to import? 

If you do not want to import files from an earlier version of Cashflow Manager click 

on [No]. 

Click on [Next] to move to the next step. 

If you are upgrading from an earlier version of Cashflow Manager that had a 

separate file for each bank account, and you wish to import those files into this new 

‘business’ file, click on [Yes]. More information on importing data from an earlier 

version file follows these steps. 

2. Business Details: If you have selected to import earlier version files the only 

information required in this step is your Business Name which will appear on reports 

and be the default name for your file. 

If you are not importing earlier version files you can also select the ‘business 

template’ to use, the month that your Financial Year commences and the month and 

year you would like to commence your records from. 

Select a business ‘template’: Several business templates are available to make setting 

up your columns easier. The Business Template you select will establish columns 

generally used by that type of business. You can then add, delete or modify the 

columns to personalise them for your business. To select a Business Template, click 

on the down arrow and then on the type of business that is the closest match. 

3. Create an ‘account’ for each new bank account you wish to add. 

Record a unique name for each bank account, including credit cards that you use for 

your business. If you have a separate Petty Cash system you can also create an 

‘account’ for this. 
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Each account needs a unique name, so you can easily identify which account you are 

working on. 

Click in the first box and record a unique name for your main business bank account. 

Then press your Tab key to go to the next box and record the name of your second 

account. 

Continue until you have listed all accounts. 

Note: You can record up to 10 accounts in this process. If you have more than 10 

accounts, you can add more accounts from the Home page. 

Click on [Next] to continue. 

4. Select the General Ledger System your Accountant Uses 

Cashflow Manager will export your information to most general ledger systems and 

can match the general ledger codes those systems use to make it easier for your 

accountant. 

Even if your accountant chooses to work from your reports, the ‘Account Codes’ that 

match their system will still make it easier for them. 

Ask your accountant for the name of their general ledger system and a list of account 

codes for your columns. Your accountant can also advise you on the specific columns 

you need to customize the program for your business. 

Then click on the down arrow and select the general ledger system your accountant 

uses. 

You can also select I don’t know and change this later in Options. 

Click on [Next] to continue. 

5. Congratulations: This is simply a message advising that you have completed the 

information and your file is now ready to create. Click on [Next] to continue. 

6. Saving your file: A window will appear, so you can select the location for your file. 

The standard location is 

C:\Users\Username\AppData\Roaming\CFM\Cashflow11\Data. Click on [Save] to 

save your file. 

The speed at which your file is created will depend upon the number of accounts and the 

speed of your computer. An ‘indicator bar’ will show the progress. 

When your file has been created, the program will open to the Dashboard, where you can 

select an account to start work on. 

Once you select an account you can customise your columns and options. Icons will 

appear on the tool bar or you can use the Tools menu to select these functions. 

Helpful Hint: 

When your file saves, each of the accounts will be created with the columns from 

the ‘business template’ that you selected in Step 2. 

If you have accounts that require a different ‘business template’, add these 

accounts later. 

If you use multiple bank accounts and plan to change the standard columns, 

create one bank account for your primary account. Once this process is completed 

you can then personalise your columns and use the Duplicate Account function in 

Options to create your other accounts all with your personalised columns. 
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Import Data from an Earlier Version File 

When you are creating a new business file and select [Yes] to import an earlier version 

file, the next step will be to record the name of your business. Then click [Next]. 

1. Import Cashflow Manager Data: 

Select a Cashflow Manager file to import: Click on the button to browse to the 

location and select the file. 

You can import Cashflow Manager data or backup files. 

When you click on the [Browse] button it will automatically look for Cashflow 

Manager 9 data files (.cf9) or Backup files (.bc9). If you have an earlier version file 

you will need to navigate to the location for that file. You can import files from 

version 2004, 8, or 9 and either data (.cf_) or backup (.bc_) files. 

When you have selected the file, click on the [Open] button to return to the Cashflow 

Manager wizard. If you have selected a version 8, or 9 file, click on the [Next] button. 

If you have an earlier version file, more options will be displayed. 

As version 11 has one file for the business instead of a separate file for each 

account, please type a name for the account you are importing into ‘What 

‘Account Name’ do you wish to call this file? The name of the file you are 

importing will appear, but you can change this as each account needs a unique 

name, so you can easily identify the account you are working on. 

You can now choose to import: 

a. The complete file, 

b. All transactions from a selected date, or 

c. Your reconciled bank balance and ‘outstanding’ deposits and payments 

from a date you select. 

When you are ready to proceed, click [Next]. 

Note: If the file you are importing uses the Download Bank Statement 

function you will also be asked to identify the bank before proceeding. 

2. Save In: Your new Business File is ready to create. A window will appear, so you can 

select the location for your file. The ‘default’ location will be 

C:\Users\Username\AppData\Roaming\CFM\Cashflow11\Data. Click on [Save] to 

save your file. 

The speed at which your file is created will depend upon the amount of data in the 

imported file and the speed of your computer. A ‘progress bar’ will indicate the 

progress. 

3. As versions of Cashflow Manager prior to Version 8 had separate files for each bank 

account, you now can import other earlier version files as well. 

Note: To import data from an earlier version file, you will need to have that version of 

the program also installed on the computer you are using. 

 

Manage your Bank Accounts 

The new Dashboard displays your business’s Bank Accounts, and their current balances. 

You can add, delete, restore, and manage your accounts. 
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Add a new Account 

1. Click on the Dashboard tab. 

2. The Bank Accounts will be displayed. You can add or manage the bank accounts from 

this section. 

3. Click on the [Add] button. A ‘wizard’ will guide you through the process of adding a 

new account which is the same as creating a new business file except that you only 

will asked for information necessary to create the account(s). 

 

Manage an Account 

1. Click on the Dashboard tab. 

2. The Bank Accounts will be displayed. You can add or manage the bank accounts from 

this section. 

3. Click on the [Manage] button. Here, you can delete or restore an account(s) 

 

The Cashflow Manager Menus 

At the top of the screen are the File, and Tools menus that provide you with functions to 

use from time to time. When you click on these menus, a drop-down menu will appear. 

Position your mouse pointer over the option you require and click to select it. 

The following is an overview of each menu item. 

File 
 

Create New 

Business File: 

Creates a new business file 

Open Existing 

Business File: 

Opens an existing business file 

Backup: Creates a backup of your file 

Accountant Export: Exports and Imports Cashflow Manager data for selected 

accounts and time periods so you can continue working on 

your file while your accountant works on your data. 

Restore: Restores a backup file 

Export: Creates a special export file for communicating with your 

accountant's general ledger program 

Password: Options to add, change or delete a password. Passwords can 

be set for each section. 

Exit: Exit the Program 

 
Tools 

 

Purge Data Purge old data from your file 

Map Bank 

Statement 

Description 

Map your downloaded bank statement file 

Search: Search for a transaction 

Customise: Customise columns for your business 
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Options: Refer to separate section on Options that describes the 
various options that can be used with your file. 

 

 

Options – Cashflow Manager 

Each section of the program – Cashflow Manager, Invoice Manager and Assets Manager 

has Options. Some are ‘global’ options and others are specific to the section you are in. 

To access the Cashflow Manager Options you need to be in the Cashflow Manager section 

of the program. 

Click on the Tools menu item and select Options, or click on the Options icon. 

The following options are available: 

Accountant's General Ledger Format: Match the General Ledger system used by 

your Accountant and change the Accountant’s Codes for the Bank Account and Cash 

on Hand accounts for the account you have open. 

Advanced Preferences: The following options are available after selecting Advanced 

Preferences. 

Show Details Column: Select whether the Details column is displayed. 

Open Last File Used on Start-up: Opens the last file you were using to save 

time if you often use the same file. 

Sort transactions by date before locking Bank Reconciliation 

Hide ‘Money In/Out – To Add’ tabs in the Auto Bank Reconciliation: 

This is selected by default. However, you can deselect this option if you wish 

to select which transactions from your bank statement to add to your records. 

Auto Fill Options: You can turn off the Auto Fill option that automatically fills 

customers, suppliers or details that have been previously saved. For example, turn this 

option off to correct an error. 

You can also remove items recorded in Customers, Suppliers or the Money In and 

Money-Out Details column so they do not appear in the drop down Details list. Click 

on the tab to display the list. In the ‘Remove’ column, click in the box for each item 

you wish to remove or reinstate. This will place or remove a tick in this box. Click 

[Save] when finished. 

Auto Column Selection: Use this option to establish links so that when the customer 

or supplier is recorded, the column is automatically selected. Scroll to the customer or 

supplier’s name, click on the select box and select the column you require. Click 

[Save] when finished. 

Business Name & VAT Number.: Edit the Business Name, or VAT number. Note: 

any changes will affect the Invoice section as well. 

Column Colours: Customise your column colours for the file you are working on. 

System Colours are used for columns where the column name cannot be changed. 

Allocation columns are the columns used for allocation of your Receipts and 

Payments. 

Currency Symbol: Allows people from other countries to use their own currency. 

Duplicate Account: Create another account with the same columns as the account 

you have selected. 

Financial Year Begins: In the UK, the financial year for most businesses starts on 1 

January. You can change this if yours is different. 

Grid Font Size: Increase the size of the font on your screen. 
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VAT Rate: Change the VAT rate. 

Private Use Columns: Select the private use component and column for the balance. 

Note that you must select a column for the balance for the private use calculation to be 

made. For example, if you record 80% private use for the ‘Motor Vehicle’ column and 

‘Owners Drawings’ as the Private Use column, if you enter £100 in the ‘Motor 

Vehicle’ column, it will save £20 in the Motor Vehicle column and allocate £80 to 

Owners Drawings. 

Quantity Column & Decimals Display: Rename your Quantity column for printing 

on Reports. The new name must be no more than 8 characters. You can set the 

decimal places for the quantity from zero to two. 

Remove Recurring Transactions: Delete recurring transactions that you no longer 

require. 

Rename Account and Business File: Rename bank accounts and/or your business 

file name. 

 

The Cashflow Manager Sections (Tabs) 

Cashflow Manager consists of 6 sub-sections. The Tabs are located under the main 

Cashflow Program section, on the Side Panel. They are: 

❖ Money In– for recording money received, 

❖ Money Out – for recording money paid 

❖ Bank Reconciliation – for reconciling your Money In and Money Out records to 

your bank 

❖ Cash Reconciliation – for reconciling your cash Money In and Money Out 

❖ Account Budget – for preparing and using account-based budgets 

❖ Business Budget – for preparing and using business-based budgets 

❖ Reports – for comprehensive reports 

 

Change to a Different Month 

The month and year appears at the top of the Money In and Money Out sections. To 

change a month, click on the up arrow to go forward, or the down arrow to go back. 

To quickly go back or forward several months, click on the larger down arrow to display a 

list of all months. Click on the month you require. 

 

Change to a Different Section 

To move between different sections of the program, simply position your mouse pointer 

over the tab, on the Side Panel, and click your left mouse button. There are tabs in the 

Cashflow Manager section for Money In, Money Out, Cash Reconciliation, Bank 

Reconciliation, Reports and Budget. For example, to get to ‘Money In’ simply position 

your mouse pointer on the tab labelled Money In and press your left mouse button. 



42  

Customise Columns 

Customise Columns Overview 

Click on the Customise Columns icon. 

The page that appears will give you the option to customise your ‘Money In’ or your 

‘Money Out’ columns by clicking on the tab for the section you require. 

The table lists all columns that have been included from the business ‘template’ selected 

when you created the account together with any changes you have made, and includes 

four fields of information: 

1. The Column Name can be up to 50 characters in length and needs to be unique. 

2. The Accountant's Code is used to match the codes used by your accountant's general 

ledger program. If you don’t know the code your accountant uses, leave it blank. 

3. The Tax Type determines the VAT calculation and reporting that applies to the 

column. 

4. The Profit/Loss status of the column: If the checkbox is ticked then the column will 

be included in the Profit and Loss report. If the column is not ticked, then it will 

appear on the Balance Sheet (Movement) Report. 

The buttons on the right side perform various functions: 

[Add New] Click on this button to add a new column. 

[Delete] Click on the line for the column you wish to delete and then click on the 

[Delete] button. The column will be deleted unless there is data recorded in that 

column. 

[Undo] The [Undo] button will be activated when you delete a column. You can click 

on this button to ‘undo’ the deletion. 

[Sort A-Z] Sort your columns alphabetically. 

[Sort Z-A] Sort your columns in reverse alphabetical order. 

[Add to All Accounts] Columns in one account can be added to all other accounts. 

[Up and Down Arrows] Move your selected column in the direction of the arrow, 

one position for each click. 

[Save] Click on this button to save the changes you have made. An information box 

will advise that your changes have been saved. 

[Cancel] Exit the Customise Columns table. Any changes you have made since you 

last clicked the [Save] button will not be saved. 

To save your changes and then exit the Customise Columns table, click on the [Save] 

button and then the [Cancel] button. 

 

Add a New Column 

1. Click on the Customise Columns icon and select the section (Money In or Money 

Out) that the column is in. 

2. Click on the [Add New] button. Type in your new column name. Press your tab key 

to move to the Accountant's Code. 

3. If you know the Accountant's code, type it in. (This is not essential unless you are 

going to export your information to your Accountant. It can also be recorded later.) 

Press your tab key to move to the Tax Type. 
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4. A drop-down box will appear at the side of the Tax Type. Click on the arrow and 

select the correct VAT tax type for that column. 

5. Tab to the Profit/Loss status and ensure the box is ticked if the column forms part of 

your profit and loss, or un-ticked if it does not. Ask your accountant if you are unsure. 

6. If you wish to add the column to all accounts, click on the [Add to All Accounts] 

button. 

7. You can move the column to the position you require by clicking on the Sort buttons 

or the up and down arrow buttons. 

8. Click on [Save] when you are finished and then [Cancel] if you wish to exit. 

 

 

Change a Column Name 

1. Click on the Customise Columns icon and select the section (Money In or Money 

Out) that the column is in. 

2. Click on the Column Name that you wish to change. Type in the new name. 

3. Click on [Save] when you have finished and then [Cancel] if you wish to exit. 

 

 

Change a Column’s VAT Tax Type 

Cashflow Manager has a uniquely simple system to help you calculate your VAT. You 

simply allocate a VAT ‘Tax Type’ that matches the boxes on the Business Activity 

Statement to your columns. 

When entering Money In you record the gross amount (including VAT) into the 

appropriate column and the VAT will be automatically calculated from the VAT ‘Tax 

Type’ allocated to the column. 

 
 

The VAT Tax Types for Money In are: 
 

VAT: All receipts subject to VAT either at normal or reduced rates. 

Allocating the ‘VAT’ type to your column will ensure that the 

column total will be included in box 6 in the VAT Report. 

Zero: All receipts that are Zero-rated (with the exception of EC Sales). 

Allocating the ‘Zero’ type to your column will ensure that the 

column total will be included in box 6 in the VAT report. 

Exempt: All receipts that are Exempt for VAT. Allocating the ‘Exempt’ type 

will ensure that the column total will be included in box 6 in the 

VAT report. 

EC Sales: Sales to other EC countries. (The totals of these columns are 

included in boxes 6 and 8 of the VAT Report.) 

Non-VAT: Receipts that are outside the scope of VAT and therefore not 

reported on your VAT return, e.g. transfers from your savings, 

salary & wages, amounts received from a hobby, trust and 
partnership distributions, loans etc. 

  The VAT ‘types’ for Money Out are: 
 

VAT: All business payments that include VAT except where the VAT 
Input Tax cannot be claimed because it is in relation to an exempt 
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 output. Allocating the ‘VAT’ type to your column will ensure that 

the column total is included in box 7 in the VAT Report. 

Zero: All business payments where you have not been charged VAT 

because the supply is Zero-rated. Allocating the ‘Zero’ type to your 

column will ensure that the column total will be included in box 7 

in the VAT report. 

Exempt: Payments where you cannot claim a refund of the VAT Input Tax 

because it relates to Exempt Outputs or payments that do not 

include VAT because the supply is exempt. No amount of VAT is 

to be recorded in the VAT column, as the VAT cannot be claimed. 

The totals for such columns are reported in box 7 in the VAT 

Report. 

EC-VAT: Purchases from other EC countries where you must account for 

VAT in boxes 2 and 4, and the total payment in boxes 7 and 9 in 

the VAT Report. 

EC-0%: Purchases from other EC countries where the supply would 

normally be Zero-rated and therefore the VAT does not need 

reporting in boxes 2 and 4. The totals of such columns are reported 

in boxes 7 and 9 of the VAT Report. 

Non-VAT: Payments that are outside the scope of VAT and not to be reported 

on your VAT Return, e.g. salaries & wages, owners’ drawings, or 
other acquisitions that are not for use in your business. 

 

The VAT ‘Tax Type’ of each column determines the VAT calculation and reporting of 

any amounts entered into the column. 

1. Click on the Customise Columns icon and select the section (Money In or Money 

Out) that the column is in. 

2. Click on the Tax Type for the column you wish to change. A drop-down button will 

appear. Click on the button and select the type you require. 

3. Click on [Save] when you have finished and then [Cancel] if you wish to exit. 

 

Change Accountant’s Codes 

Cashflow Manager can communicate with your Accountant's General Ledger program, 

which uses numbers instead of column headings for processing your data. 

Select your Accountant’s General Ledger program by clicking on the Options icon and 

then Accountant’s General Ledger Format. You can then edit the Accountant’s Code 

for individual columns as follows. 

1. Click on the Customise Columns icon and select the section (Money In or Money 

Out) that the column is in. Click on the Accountant's Code for the column you wish to 

change. 

2. Type in the new code. 

3. Click on [Save] when you have finished and then [Cancel] if you wish to exit. 

Note: to change the Accountant’s Code for Bank and Cash on Hand accounts, go to 

Options and select Accountant’s General Ledger Format. 
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Change the Profit/Loss Indicator of a Column 

The Profit/Loss indicator determines whether the column totals are reported in the Profit 

and Loss Report or the Balance Sheet (Movement) Report. 

If the Profit/Loss Field is ticked, then that column is designated as a Profit/Loss column. 

This means that this column will be included in the Profit and Loss Report. If the column 

is not designated as a Profit and Loss column then it will be included in the Balance Sheet 

(Movement) Report. 

Click on [Save] when you have finished and then [Cancel] if you wish to exit. 

 

Move a Column 

1. Click on the Customise Columns icon and select the section (Money In or Money 

Out) that the column is in. 

2. [Sort A-Z] Click on this button to sort your columns alphabetically. 

3. [Sort Z-A] Click on this button to sort your columns in reverse alphabetical order. 

4. The [Up and Down Arrows] will move your selected column in the direction of the 

arrow, one position for each click. 

5. Click on [Save] when you have finished and then [Cancel] if you wish to exit. 

You can also move a column from within the Money In and Money Out sections. Place 

your mouse over the column you wish to move. A box will highlight the column ‘header’. 

Hold down your left mouse button and drag the column to its new location. Release your 

left mouse button. 

 

Delete a Column 

1. Click on the Customise Columns icon and select the section (Money In or Money 

Out) that the column is in. 

2. Click on the column name to select it. 

3. Click on the [Delete] button to remove the column. Please note that if data has been 

recorded in that column at any time then the column cannot be deleted. 

4. The [Undo] button will be activated when you delete a column. You can click on this 

button to ‘undo’ the deletion. 

5. Click on [Save] when you have finished and then [Cancel] if you wish to exit. 

 

Change a Column's Width 

This function is carried out from within the Money In or Money Out sections. Columns 

have a maximum width on the screen. For example, if you want the Details column to be 

wider, there is a maximum width on the screen, but the information you type in (up to a 

maximum 150 characters) will print in your reports e.g. your Transaction Listing. 

To make a column wider, position your mouse cursor over the line at the side of the 

column. When the cursor changes to the following:  

Hold down your left mouse button and drag until the column is the width you require. 
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Record Money In and Money Out 

Money In - Overview 

The Money In Record records all receipts (money you receive) - by cheque, cash, credit 

card, or direct transfer. You will record the details of receipts, allocate them to a column 

that indicates what the receipt was for and then record what you did with it – deposit it in 

the bank or not. 

Cashflow Manager has a uniquely simple system to help you calculate your VAT. You 

simply allocate a VAT Tax Type that matches the boxes on the VAT report to your 

columns. When entering Money In you record the gross amount (including VAT) into the 

appropriate column and the VAT will be automatically calculated from the VAT type 

allocated to the column. The VAT types are: 
 

VAT: All receipts subject to VAT either at normal or reduced rates. 

Allocating the ‘VAT’ type to your column will ensure that the 

column total will be included in box 6 in the VAT Report. 

Zero: All receipts that are Zero-rated (with the exception of EC Sales). 

Allocating the ‘Zero’ type to your column will ensure that the 

column total will be included in box 6 in the VAT report. 

Exempt: All receipts that are Exempt for VAT. Allocating the ‘Exempt’ type 

will ensure that the column total will be included in box 6 in the 

VAT report. 

EC Sales: Sales to other EC countries. (The totals of these columns are 

included in boxes 6 and 8 of the VAT Report.) 

Non-VAT: Receipts that are outside the scope of VAT and therefore not 

reported on your VAT return, e.g. transfers from your savings, 

salary & wages, amounts received from a hobby, trust and 
partnership distributions, loans etc. 

 

 

How to Record Money In (Money Received) 

Ensure that you are in the correct account and the correct month and year, and then 

follow these simple steps. 

The Money In Record has 3 primary sections. The first section is for the 'Receipt 

Information'. The second is to allocate what the receipt was for, and the third is for what 

you did with the receipt (i.e. deposit it in the bank or not.) 

The basic rule is that the Total Amount must equal the total of the allocation columns and 

must also equal the total of the Bank Deposits and Receipts Not Banked columns. 

1. Record the date, the name of the customer or person from whom the money is 

received, any additional details that will help identify what the receipt was for at a 

later time and the receipt (or reference) number (if issued) in the appropriate 

columns. 

When you enter information in the Day, Customer and Details cells, you can move 

to the next cell by using either your Tab key or the Enter key. In the ‘number’ fields 

starting with the Receipt Number, you must use your Enter key to record 

information in a cell. Your tab key will simply move to the next cell. 
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For example, after you record the first Receipt Number the next line will 

automatically pre-fill. Press Enter to use this Receipt Number or press Tab to leave 

the Receipt Number blank. 

When you type in the Customer and Details columns, a selection box will appear at 

the right side and the auto-fill facility will match the letters you are typing to any 

details that have been previously saved. Continue typing or click on the selection 

box to select the customer or details you input on a regular basis to save typing 

information that occurs regularly. 

Note that the Customer and Details auto-fill facility recalls information as you have 

recorded it and if you accidentally type in a lower-case letter this will appear each 

time in the details box. To solve this, click on the Save icon, then click on the 

Options icon, select Auto Fill Options and click on the box to remove the selection 

to Use AutoFill. 

Click on the [OK] button to save the changes and exit the Options. This will allow 

you to go back into your Customer or Details and make the correction. (Go back to 

Options and select the Use AutoFill box if you want the auto-fill facility 

again). Refer to the Tips and Tricks Section under Options, Auto Fill Options on 

how to edit the dropdown details list. 

2. Record the amount of ‘Money In’ in the Total Receipt column. 

3. Record the amount into the Allocation Column(s) applicable to the type of receipt. 

Use your Tab or arrow keys to move the amount to the appropriate column. Press 

your 'Enter' key to record the amount in a column. 

4. Record what you do with the money, i.e. whether you deposit it or not. 

5. If you deposit this money intact then record the amount in the Bank Deposits 

column. 

❖ If you deduct cash from this Money In and deposit the balance, record the 

amount you deposit in the Bank Deposits column and the amount retained in 

the Receipts Not Banked column. (The combined totals of the Receipts Not 

Banked and the Bank Deposits columns must equal the amount of the Total 

Receipt). 

❖ If you combine this transaction with others to deposit them all together, Tab or 

Arrow to the Receipts Not Banked column and press 'Enter'. When you record 

the final transaction in the combined deposit, record the amount of your bank 

deposit in the Bank Deposit column. 

The program will allocate an adjustment in the Receipts Not Banked column 

because of the inbuilt control for each line that the Total Receipt must equal 

Receipts Not Banked + Bank Deposits. 

❖ Make sure you record details of all cash payments (including amounts taken for 

private purposes) in the Money Out Record. You can click on Cash 

Reconciliation at any time to check your records against the actual cash on 

hand. 

❖ Please note: For each line to balance, the amount in your Allocation Columns 

must equal your Total Receipt, and the combined amounts in your Bank 

Deposits and Receipts Not Banked columns must also equal the Total Receipt. 

If this does not occur, you will not be allowed to move to a new line. You will 

not be allowed to move to a new line if your line is not balanced. 

Click on the [Save] button when you have finished. (The program will automatically save 

when you change sections.) 
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Money Out - Overview 

The Money Out section records all payments - by cheque, by cash or directly from the 

bank. It is good business practice to make all payments by cheque (or electronic bill 

payment) wherever possible because this gives you a record of your payment. 

Of course, this is not always practical, and some payments are made by cash. The best 

way to control cash payments is to use a Petty Cash System and establish a separate 

Cashflow Manager account for Petty Cash. However, if you make cash payments from 

cash receipts or from your own resources then you should also record them in the Money 

Out Record. 

Cashflow Manager has a uniquely simple system to help you calculate your VAT. You 

simply allocate a VAT type that matches the boxes on the VAT Report to your columns. 

When entering payments, you record the gross amount (including VAT) into the 

appropriate column and the VAT will be automatically calculated from the VAT type 

allocated to the column. The VAT types are: 
 

VAT: All business payments that include VAT except where the VAT 

Input Tax cannot be claimed because it is in relation to an exempt 

output. Allocating the ‘VAT’ type to your column will ensure that 

the column total is included in box 7 in the VAT Report. 

Zero: All business payments where you have not been charged VAT 

because the supply is Zero-rated. Allocating the ‘Zero’ type to your 

column will ensure that the column total will be included in box 7 

in the VAT report. 

Exempt: Payments where you cannot claim a refund of the VAT Input Tax 

because it relates to Exempt Outputs or payments that do not 

include VAT because the supply is exempt. No amount of VAT is 

to be recorded in the VAT column, as the VAT cannot be claimed. 

The totals for such columns are reported in box 7 in the VAT 

Report. 

EC-VAT: Purchases from other EC countries where you must account for 

VAT in boxes 2 and 4, and the total payment in boxes 7 and 9 in 

the VAT Report. 

EC-0%: Purchases from other EC countries where the supply would 

normally be Zero-rated and therefore the VAT does not need 

reporting in boxes 2 and 4. The totals of such columns are reported 

in boxes 7 and 9 of the VAT Report. 

Non-VAT: Payments that are outside the scope of VAT and not to be reported 

on your VAT Return, e.g. salaries & wages, owners’ drawings, or 

other acquisitions that are not for use in your business. 

 

It is important that you set up the VAT Tax Type for your columns correctly and then 

accurately allocate your payments to prepare your VAT Report. 

 

How to Record Money Out (Payments) 

Ensure that you are in the correct account and the correct month and year, and then follow 

these simple steps. 

The Money Out Record has 2 primary sections. The first is for the 'Payment 

Information'. The second is to allocate what the payment was for. 

The basic rule is that the Total Payment must equal the total of the Allocation Columns. 
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1. Record the day, the name of the supplier or person to whom the money is paid, any 

extra details that are helpful in describing what the payment is for, and the cheque 

number (if applicable) in the columns titled for that information. 

When you enter information in the Day, Supplier and Details fields, you can move 

to the next cell by using either your Tab key or the Enter key. In the ‘number’ fields 

starting with the Cheque Number, you must use your Enter key to record 

information in a cell. Your Tab key will simply move to the next field. 

For example, after you record the first Cheque Number the next line will 

automatically pre-fill. Press Enter to use this Cheque Number or press Tab to leave 

the Cheque Number blank. 

2. If the payment is a cheque or other payment from your bank account such as direct 

debit, Electronic Funds Transfer or bank charges, record the total amount of the 

payment in the Total Bank Payments column. If the payment is cash then record the 

total amount in the Total Cash Payments column. 

3. Record the amount of the payment (including VAT) in the Allocation Column(s) 

appropriate to the type of expenditure. Use your Tab or arrow keys, or the first 

alpha letter of the column header to move the amount to the appropriate column. 

Press your 'Enter' key to record the amount in a column. 

When you complete a line of information so that the allocations equal the total 

payment, it will automatically jump to the next line. If you are unable to move to 

another line, it means that the line you are on is incomplete. The rule is that the 

Total Bank Payment or Total Cash Payment must equal the combined total of the 

Allocation Columns. 

Click on the [Save] button when you have finished. (The program will 

automatically save when you change sections.) 

 

 

Credit Card Payments 

We recommend that you create an ‘account’ for each credit card you use in your business, 

so you have a complete record that matches your credit card statement. 

In your credit card account, allocate purchases and withdrawals to the correct Money Out 

columns. When you pay your credit card this will be Money In to your Credit Card 

account. Record the ‘money in’ in a column for that purpose e.g. “Credit Card Payments 

Received” (see ‘Add a New Column’) 

In the account you used to pay the credit card, record your payment in the Total Bank 

Payment or Total Cash Payment column as appropriate, and then in a column for that 

purpose e.g. ‘Credit Card Payments’. Neither the ‘Money In’ column in the credit card 

account, nor the ‘Money Out’ column in the account from which you paid the credit card 

will be a ‘Profit and Loss’ type column. 

 

At the End of the Month 

1. Check your bank statement to find any money in (credits) shown on the statement 

but not recorded in the Money In Record. Examples are bank interest received, and 

amounts transferred from other bank accounts. 

2. Record any amounts found into the Money In Record listing them in the Total 

Receipts column, an Allocation Column and the Bank Deposits column. (If no 

Allocation Column specifically applies, record the amount in Sundry VAT 
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Receipts, or Sundry Non-VAT Receipts or create a new column if that type of 

transaction is likely to occur regularly. 

3. Check your bank statement to find any payments (debits) shown on the statement 

but not recorded in the Money Out Record. Examples are bank charges, direct 

debits for loans, leases, insurance etc. 

4. Record any amounts found into the Money Out Record listing them in the Total 

Bank Payment column and in the appropriate Allocation Column. 

5. Go to Bank Reconciliation. 

Note: If you download your bank statements and are using the automated Bank 

Reconciliation option, you can transfer unrecorded transactions to the Money In and 

Money Out sections while doing your Bank Reconciliation. 

 

Helpful Hints for Recording Money In and Money Out 

Move around 

1. Use your arrow keys or your Tab key to move to other columns and press the 'Enter' 

key to record any information in a cell. 

2. You can also move between the Allocation Columns by pressing the first letter of the 

column name on your keyboard. 

3. If you are unable to move to another line, it means that the line you are on is 

incomplete. The rule is that the Total Receipt must equal the combined total of the 

Allocation Columns and equal the combined total of the Bank Deposits and Receipts 

Not Banked columns. 

4. When you amend a line that has been previously completed you must ensure that you 

also press 'Enter' on the Bank Deposits and/or Receipts Not Banked columns to 

confirm these amounts. 

 

Correct a Mistake 

1. To change the amount, you have already entered in a column, arrow to the amount 

you wish to change and simply start typing. 

2. To delete the amount, press the 'Delete' key on your keyboard. 

 

Copy and Paste Transactions 

1. To copy a single transaction, right click on the grey box at the left side of the line you 

wish to copy. 

2. To copy multiple transactions, click in the grey selector box at the left side of the row 

for the first transaction, then hold down the ‘Ctrl’ key on your keyboard as you select 

the other transactions you wish to include. (If all the transactions you wish to include 

are together you can also hold down your ‘Shift’ key on your keyboard and select the 

first and last transactions.) They will all be highlighted to show they have been 

selected. 

3. Then press the 'Ctrl’ and ‘C' keys together on your keyboard or right click on one of 

the grey selector boxes for a highlighted row and click on Copy. 

4. Type in a name of the account, the month and the year where you wish to paste the 

copied transactions. 
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5. Click on [OK] to finish or [Cancel] to exit. 

 

Insert a Line 

You can insert a line if you want to keep your transactions in date order (although you can 

also select to view in date order by clicking on the Date ‘header’. 

1. Right click on the grey box at the left side of the line where you wish to insert. 

2. Click on Insert New Line. 

A blank row will be inserted immediately above the line you have selected. Enter a 

transaction into this row as normal. 

You could also insert a line by arrowing to the line where you wish to insert and press the 

F8 key on your keyboard. 

 

Auto Column Selection 

To speed up your recordkeeping, you can setup the program so that whenever you type in 

a customer or supplier name, the amount automatically goes to the selected column. 

For example, you can tell the program that every time you type ‘Optus’ as the supplier 

name, you want it to select ‘Telephone’ as the allocation column. 

To do this, click on ‘Options’ and then ‘Auto Column Selection’ on the left side menu. 

Click on ‘Money Out’ and the names of Suppliers you have previously typed into the 

program will appear. 

Select ‘Optus’ as the Supplier. Click on the drop down and select ‘Telephone’ as the 

column. 

Click on [Save]. 

 

Private Use Automation 

If you have a standard private use percentage that applies to payments recorded in a 

particular column, you can setup the program to calculate the amount of private use and 

record that amount in a selected ‘private use’ column. 

As an example, let’s say you have 80% private use of your motor vehicle. 

Click on the Options icon and then on ‘Private Use Columns’. 

Click on ‘Payments’ to list all your Payments/Money Out columns. 

Scroll down to the ‘Motor Vehicle’ column and click on the Percentage (it will be 0 unless 

you have previously recorded an amount of private use). Click on the drop-down box 

arrow at the right of the ‘Motor Vehicle’ line and select ‘Owners Drawings’ as the Private 

Use column. 

When you enter an amount in the Motor Vehicle column (e.g. £100), it will save the 

business proportion (e.g. 20% of £100 = £20) in the Motor Vehicle column and allocate 

the private proportion (e.g. 80% of £100 = £80) to Owners Drawings. 

Click on [Save]. 

 

Move Transactions to another account or month 

If you accidentally record transactions in a wrong month or wrong account, you can move 

them to the correct location. 
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1. To move a single transaction, right click on the grey box at the left side of the line you 

wish to move. 

2. To move multiple transactions, click in the grey selector box at the left side of the row 

for the first transaction. Then hold down the ‘Ctrl’ key on your keyboard as you select 

the other transactions you wish to include. (If all the transactions you wish to include 

are together you can also hold down your ‘Shift’ key on your keyboard and select the 

first and last transactions.) They will all be highlighted to show they have been 

selected. 

3. Then press the 'Ctrl’ and ‘X' keys together on your keyboard or right click on one of 

the grey selector boxes for a highlighted row and click on Move. 

4. Type in a name of the account, the month and the year where you wish to transfer the 

transactions. 

5. Click on [OK] to finish or [Cancel] to exit. 

 

Remove a Line 

You can remove an entire line from your Money In or Money Out Records. 

1. Right click on the grey box at the left side of the line where you wish to remove. 

2. Click on Remove Line. 

You could also remove a line by pressing the F9 key on your keyboard. 

 

Recurring Transactions - Add a Recurring 
Transaction 

If you have transactions that occur regularly, you can save them in a list of transactions for 

easy input each time they occur. To add a transaction to your list of recurring transactions: 

1. Right click on the grey box at the left side of the row for the transaction you wish to 

add. 

2. Click on Add Recurring. 

You can also do this by clicking on the grey box at the left side to select the row and 

then press the F6 key on your keyboard. 

To batch transactions together so you can insert them all at once, click in the grey 

selector box at the left side of the row for the first transaction, then hold down the 

‘Ctrl’ key on your keyboard as you select the other transactions you wish to include. 

(If all the transactions you wish to include are together you can also hold down your 

‘Shift’ key on your keyboard and select the first and last transactions.) They will all be 

highlighted to show they have been selected. 

3. Then press the F6 key on your keyboard or right click on one of the grey selector 

boxes for a highlighted row and click on Click on Add Recurring. 

4. Type in a name that identifies this transaction or group of transactions for selecting 

them later. 

5. Click on [OK] to finish. 

 

Recurring Transactions - Insert a Recurring 
Transaction 

Press the F7 key on your keyboard or right click on the grey selector box at the end of 

your transactions and select Insert Recurring. 
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The transaction will be inserted at the end of your existing transactions. 

 

Recurring Transactions - Remove a Recurring 
Transaction 

1. Click on the Options icon. 

2. Click on Remove Recurring Transactions. 

3. Click on the Money In or Money Out option as appropriate. 

4. Click on the down arrow and select the transaction you wish to remove. 

5. Click on [Save] when finished. 

 

Record a Quantity 

You can record an amount (up to 2 decimal places) for Quantities or perhaps Imputation 

Credits with any of the allocation columns in your Money In and Money Out sections. 

1. Arrow to the allocation column where your amount has been recorded. 

2. Click on the [Quantities] button at the bottom of the Money In table. 

3. Record the amount in the box that appears and click on [OK]. 

The cell in your Money In or Money Out table will now have a small red marker in 

the top corner to indicate that a quantity has been recorded. 

Quantities will be included in your Transaction Listing, Cashflow and your General 

Ledger Listing Reports. 

To rename the Quantity Column, click on Tools menu and select Options or on the 

Options icon. Click on 'Quantity Column & Decimals Displayed. Record the new 

name (up to 8 characters) and click on [Save]. 

 

Sort your Transactions 

You can sort your transactions to help you analyse your data. For example, you may wish 

to see your transactions in date order even though you have entered them in a different 

way. You may wish to see your transactions in customer order, or you may wish to look at 

all transactions for a selected Allocation Column together. 

To sort your transactions, simply click on the ‘column header’ for the column you wish to 

sort by. 

 

Search for Money In or Money Out Transactions 

1. Click on the Tools menu and then on Search. Alternatively, click on the Search icon 

at the top of the screen. 

2. A Search window will appear and default to the tab active in Cashflow (Money In or 

Money Out). You can select to search by All Accounts, Selected Accounts, Date, 

Amount, Customer and Receipt Number (if searching for receipts) or Supplier and 

Cheque Number (if searching for payments) or Details. 

3. Select your search criteria and then click the [Search] button. The search results will 

be displayed. 

4. Click on the [Open Receipt] or [Open Payment] button to view the transactions in 

your Money In and Money Out tables. 
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5. Click on the [Print] button to print your results, or the [Cancel] button to exit. 

6. Click on the START OVER tab if you wish to begin the search again. 

 

Transfer Money In and Money Out from the Invoice 
Section 

You can transfer transactions into the Money In and Money Out Records as you are 

processing them in the Invoice section. 

Refer to Invoice Manager instructions for more information. 

Note: If you delete a payment in your Invoice section, this change will not be recorded in 

your Cashflow records. You will need to open your Cashflow Manager account and make 

any changes yourself. 
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Reverse VAT Cashflow Manager 
 

What is domestic VAT reverse charge. 
From 1 March 2021 the domestic VAT reverse charge must be used for most supplies of building and construction 
services. 
The charge applies to standard and reduced-rate VAT services: 

• for individuals or businesses who are registered for VAT in the UK 

• reported within the Construction Industry Scheme 

When the Reverse Charge is applied, the recipient of the goods or services makes the declaration of both their 
purchase (input VAT) and the supplier’s sale (output VAT) in their VAT return.  In this way, the two entries 
cancel each other from a cash payment perspective in the same return. 

Cashflow Manager 
How to add records to Cashflow for Reverse VAT Invoices 
(Money Out) 

 

This is for payments made to Suppliers that attract domestic VAT reverse charge. 

As the customer you need to have amounts in BOX 1, 4 and 7 in the VAT Return to the HMRC. 

To achieve this, you will need a Money Out record and a Reverse VAT record. 

Money Out Record – Box 4 and 7 

To get the correct figures in box 4 and 7 on your VAT report you will need to add a ‘reverse VAT Balancer’ column in the 

Money out section of Cashflow Manager. 

1. Open ‘Customise Columns’ and select ‘Money Out’. 

2. Click ‘Add New’ 

3. Add a name for the balancer column EG ‘Reverse VAT Balancer’. 

4. Assign the Tax type of ‘Outside’.(Tax type must be ‘Outside’) 

5. Note: Do NOT include this column in Profit/Loss Report. 

6. Click ‘Save’ 

 

 
Recording reverse VAT records in Money Out. 

1. Enter the date and Supplier name. 

2. In Total Payments record the amount due, this will be the (The amount excluding VAT) 

3. Navigate the amount to an allocation column (must have a Tax Type of VAT) and then edit the amount to the total 

of the Reverse VAT invoice. (The amount including VAT) and press ‘Enter’. 
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4. Allocate the negative amount to the ‘Reverse VAT Balancer’ column you setup with a Tax type of ‘Outside’. 

5. Press ‘Enter’ to complete the record. 

 
 

 

Reverse VAT Record – Box 1 

Reverse VAT records are a new feature in Cashflow Manager.  

To get the correct figures in box 1 on your VAT report you will need to record a Reverse VAT record. 

Select ‘Reverse VAT records’ from the ‘Tools’ menu. 

 
1. Click ‘Add’ 

2. Set the date that is in the correct VAT period for this record. 

3. Enter the VAT amount for this record. 

4. Click ‘Save’. 

 
 

 

How to add records to Cashflow for Reverse VAT Invoices 
(Money In) 

 

This is for payments from Customers that attract domestic VAT reverse charge. 

As the supplier you need to have amounts in BOX 6 in the VAT Return to the HMRC 

To achieve this, you will need a Money In record and a Reverse VAT record. 

Money In – Box 6 
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To get the correct figures in box 6 on your VAT report you will need to add a ‘reverse VAT Balancer’ column in the 

‘Money In’ section of Cashflow Manager. 

1. Open ‘Customise Columns’ and select ‘Money In’ 

2. Click ‘Add New’ 

3. Add a name for the balancer column EG ‘Reverse VAT Receipts’ 

4. Assign the Tax type of ‘Exempt’. 

5. Click ‘Save’ 

 

 
Recording reverse VAT records in Money In. 

1. Enter the date and Customer name. 

2. In ‘Total Receipts’ record the amount due; this will be the (The amount excluding VAT) and press ‘Enter’.  

3. Navigate the amount to the ‘Reverse VAT Receipts’ (Must have a tax type of ‘Exempt’) column and press 

‘Enter’. 

4. Press ‘Enter’ again to complete the record. 

 
Figures for reverse VAT records are included in boxes 1.4.and 7 for Money Out records and box 6 for Money in records 

when running VAT report. 
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Bank Reconciliation 

What is a Bank Reconciliation? 

A Bank Reconciliation is simply a process that matches your Money In and Money Out 

Records with your Bank Account. 

It is an important process because it provides you with a check as to the accuracy of your 

records and can therefore save your accountant a lot of time at the end of the year. 

The balance of your bank account may be different from your records because someone 

hasn’t banked the cheque you sent to them, or bank charges have been applied but you 

haven’t recorded them as you haven’t seen your statement. Or maybe someone has paid a 

direct deposit into your bank that you haven’t recorded. 

You need to record your Opening Bank Balance when you first start using the program 

and then the program will automatically track the Balance per your Records. 

The monthly Bank Reconciliation is simply checking the deposits and payments on your 

Bank Statement against your records and making sure that everything on your bank 

statement is in your records. 

Sometimes there are items in your records that are not on your bank statement, such as 

cheques you have posted that have not been banked by the persons you sent them to. 

These are called ‘outstanding’, ‘unpresented’ or ‘uncleared’ items, and when your Bank 

Statement Balance is adjusted to take these into account, your Bank Balance should be the 

same as your Records Balance. 

To process your Bank Reconciliation, click on the Bank Reconciliation tab and a ‘wizard’ 

will take you step by step through the bank reconciliation process. 

If you are doing a Bank Reconciliation for the first time, ensure that the month you have 

selected is the first month of records that you want to reconcile. 

The wizard will take you to the Opening Balance. On later occasions the Opening Balance 

wizard can be accessed from the Settings button, but you should only ever need to record 

your Opening Balance when you first start using the program. 

 

Bank Reconciliation and Financial Institution 
Settings 

When you first click on the Bank Reconciliation tab the Bank Reconciliation Settings 

section will display. 

You can choose to either reconcile your Cashflow Manager records to the paper statement 

you receive from your bank or to a downloaded file if you use Internet Banking. 

So, the question asks: How do you want to reconcile your Cashflow Manager records? 

If you want to reconcile to your paper statement that option is already selected so you can 

click on the [Next] button. 

If you want to reconcile to an online file downloaded from your bank, click on that option. 
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Unfortunately, the banks all have different formats for their downloaded files, so you must 

select your bank from the Financial Institution list so that Cashflow Manager can match it, 

or add it if it does not appear in the list of pre-loaded banks. 
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Regardless of which option you choose to reconcile, you must record your Opening Bank 

Balance together with any transactions that relate to previous time periods but have not 

appeared on your bank statement. 

When you click on [Next], a wizard will walk you through the process of recording your 

opening bank balance. 

The Settings window will no longer be displayed once you have made your choice and 

recorded your Opening Bank Balance. You can return to it at any time by clicking on the 

[Settings] button in the Bank Reconciliation section. 

 

Adding a New Financial Institution 

If your bank is not listed, you can add it yourself by following these steps: 

1. Down load a file from your Bank’s website to use as a template. 

2. Click on the “Add New” button to set your default Financial Institution. 

3. Browse to the Bank file that you downloaded. Open the file. Your data will be 

displayed on the left side of the pop-up window. 

4. Answer the questions in the bottom left of the pop-up window 

a. Is there a header? This refers to whether there are column titles in the data. 

For example, date, description etc. 

b. Are the fields separated by tabs or commas? Most banks use commas, try this 

option first. 

c. How many fields are there in each row? For example, if your data has Date, 

description, debit and credit, there are 4 fields. Note: sometimes it is difficult 

to tell if there is no header row. If you see 2 commas together, the second 

comma indicates another field, even though it is empty. For example, this will 

occur if the bank file has a separate field for debits (money out) and credits 

(money in). 

5. Assign the fields. For each of the fields in your data, select a field type to map to in 

Cashflow Manager. There is a drop-down list in the field called “Field type”. 

6. Provide a name for this Bank. 

7. Provide the URL that you use to download. This will enable you to navigate to your 

bank site and download your statement at the time you are doing your bank 

reconciliation. 

8. Click on Save. 

9. Click on Next 

You are now ready to map your bank statement and enter your Opening Bank Balance. 

 

 

Map your Downloaded Bank Statement 

Bank Statement Mappings allow you to take a portion of the transaction descriptions that 

are always present in the downloaded bank statement (typically Customer and Supplier 

names), and select which column you want these transactions placed in when 

automatically adding records to Money In and Money Out during the Automatic Bank 

Reconciliation process. 

To access the Map Bank Statement Description option, click on the [Settings] tab at the 

bottom of the bank reconciliation screen. 
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Alternatively, Map Bank Statement Description option can be accessed in the Cashflow 

section, by clicking on Tools/ Map Bank Statement Description. 

 

 

Add a Mapped Bank Statement Description 

To map your downloaded bank statement, please follow these instructions: 

1. Click on the [Map Bank Statement Description] button – here, the Map Bank 

Statement Description screen will appear showing a Money In and Money Out section. If 

you have not downloaded a Bank Statement, select a bank from the drop-down menu and 

click the [Download] button. 

2. The Map Bank Statement Description screen will default to the Money In section. 

Click on [Add], and a message will appear asking you to open a Bank Statement File 

before proceeding. Click [OK]. 

3. A window will appear, defaulting to the Cashflow 11 Bank Folder, for you to select 

your Bank Statement File (CSV). If you have downloaded the file to another location, 

navigate to this destination. Select the csv file and click [Open]. 

4. The transactions on your csv file will now load into the Money In section, and in 

specific columns depending on how the file is formatted (refer to the Adding a New 

Financial Institution section on formatting the csv). 

5. To take a portion of a transactions’ description (i.e. a “Customers” name), highlight the 

word or name by using your cursor. Then right-click on the word or name and select 

Copy. 

6. In the Mapping Data field, towards the bottom left corner of the screen, right click and 

select Paste. This will now paste the word or name in the field. (Refer to the HELP option 

next to the field for additional information about the Mapping Data field) 

7. If you wish to have this description added to the Customer column automatically every 

time you process an automatic bank reconciliation, in the Money In section, click in the 

checkbox next to Add as Customer. (Refer to the HELP option next to the field for 

additional information about the Add as Customer field) 

8. You can now select the column you wish these transactions to be allocated, by 

accessing the drop-down menu in the Money In Column To Map To field. 

9. Click on [Save]. A message will appear asking if you wish to close the screen. If you 

wish to map more transactions, click [No]. To add more transactions, repeat the mapping 

process 5 – 9. 

Once you have completed mapping the Money In section, repeat the mapping process in 

the Money Out section. To access the Money Out section, click on the Money Out tab in 

the mapping screen. This will be related to Money Out transactions, allowing you to add 

portions of the description as “Suppliers”, and allocating transactions to Money Out 

columns. 

 

 
Modify a Mapped Bank Statement Description 

On the list of Mapped Bank Statement Descriptions, you have the option to modify 

Mapped Bank Statement Descriptions. 

To modify a Mapped Bank Statement Description: 

1. Highlight the description line by clicking in the square at the beginning of the line 

2. Click on [Modify] 
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3. If a Bank Statement File (CSV) has already been opened, the transactions will be 

displayed and both the ‘Mapping Data’ and ‘Money In column to map to’ fields will be 

available to change. 

If there is no Bank Statement File (CSV) opened, no transactions will be displayed and 

only the ‘Money In column to map to’ field will be available to change. If you need to 

change the ‘Mapping Data’, click the [Open Bank Statement File] button. This will load 

the Bank Statement file transactions and enable the ‘Mapping Data’ field. 

4. Click on [Save]. A message will appear asking if you wish to close the screen. Click 

[Yes] if you have finished modifying the record. 

 

 

Delete a Mapped Bank Statement Description 

On the list of Mapped Bank Statement Descriptions, you have the option to delete Mapped 

Bank Statement Descriptions. 

To delete a Mapped Bank Statement Description: 

1. Highlight the description line by clicking in the square at the beginning of the line 

2. Click on [Delete] 

 

Please Note: The Map Bank Statement Description screen includes a link to an 

Instructional Training Video on the process. Click on the link to take you to the video. 

 

 

Record Your Opening Bank Balance 

Your Opening Bank Balance is the balance that would be in the bank if all deposits that 

have been put into the bank and all cheques written on or before the date you are starting 

to use the program appeared on your bank statement. 

If you have not previously recorded an Opening Bank Balance you will have the 

opportunity when you do your first reconciliation. 

1. Record your Closing Bank Statement Balance for the month immediately preceding 

the month of your first reconciliation (or £0 if you are reconciling a new account.) 

2. Click on [Next] to continue. 

If you are unsure at any stage, click on the [Tutor] button to view a tutorial on the 

Bank Reconciliation process. 

3. This brings us to the Uncleared Deposits (Money In) page where you need to record 

any deposits from previous months that have not yet appeared on your Bank 

Statement. 

This is unusual with Bank Deposits but sometimes might occur. If it does, you only 

need to record the total deposit, not the individual transactions as we only need the 

amount to match the amount that appears on our bank statement. 

Simply record the last day of the month in Day, tab to Total Amount and record the 

amount of the deposit. Allocate the deposit to any Allocation Column (it is before 

your records commence so should not affect your reports) and then record the amount 

in the Bank Deposits column. 
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4. Click on [Next] to go to the page for recording any Uncleared Payments. This is more 

common and will occur when you send a cheque to someone and they don’t bank it 

until after the end of the month. 

5. Record any Bank Payments from previous months that have not yet appeared on 

your Bank Statement. Remember to record the cheque number as well as the amount 

in the Total Bank Payments column. 

6. When you have recorded all uncleared deposits and payments, click on [Save] to save 

your reconciled Opening Bank Balance. 

Your Opening Bank Balance will now be displayed in the first line of the My Records 

information on the Bank Reconciliation window. 

If you wish to change between the manual and ‘downloaded statement’ options, or 

process your Opening Bank Balance again, click on the [Settings] button from the 

Bank Reconciliation window. 

 

Processing your Bank Reconciliation 

Click on the Bank Reconciliation tab. 

The opening window will show the current balances from both your Records and your 

Bank Records. To change between the ‘download’ and ‘manual’ Bank Reconciliation 

options, click on [Settings]in the centre of the bottom bar of the program. To begin 

reconciling your records to your bank statement, click on [Next]. (As an alternative, you 

can also press the Alt and N keys on your keyboard at the same time.) 

 

Reconciling with a Downloaded Bank Statement 

If you are registered with your bank for internet banking, you can download your Bank 

Statements and automate much of the Bank Reconciliation process. This can potentially 

save you hours of time, particularly in looking for discrepancies. 

You will need to have selected ‘reconcile to a downloaded file’ and the name of the bank 

in the Bank Reconciliation Settings. 

There are several steps in this process as indicated by the tabs at the top of the Bank 

Reconciliation screen, but this can have a number of advantages. 

For example, many of your transactions can be automatically matched to save you hours 

of time. Some banks are better than others in this regard because some list cheque 

numbers separately, while others include the cheque number as part of a description that is 

not easy to separate. 

Plus, any transactions on your bank statement that have not been entered into Cashflow 

Manager can be imported and quickly allocated the correct columns. 

Step 1: Download your Bank Statements. 

You can do this at any time you are logged on to the internet and from within the Bank 

Reconciliation wizard. 

1. Select the name of your Bank and click on the [Download] button to go to your 

Bank's website. If you have already downloaded your bank statement, click on [Next] 

or press Alt-N on your keyboard. 

2. Login and follow the Bank's instructions to 'Download' or 'Export' transactions. For 

example, if you bank with HSBC you would do the following once you arrive at the 

HSBC Banking site: 

a. Sign in to your Online Banking Account. 
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b. Click on the 'Banking' Tab at the top of the screen. 

c. Click on the 'Export' tab. 

d. Click on the down arrow to select your account 

e. Select your date range. (Do one month at a time from the first to the last days of 

the month. 

f. Click on the down arrow for 'Software' and select 'Cashflow Manager'. (If your 

bank doesn't have Cashflow Manager as a software option, click on 'Date Format' 

and select 'dd/mm/yy' or 'dd/mm/yyyy' and then click on the down arrow for 'File 

Format' to select 'Comma Separated File (csv)'. 

g. Click on the 'Download Now' button. 

h. You will be asked if you wish to Open the file or Save it to your computer. Click 

on 'Save'. 

i. Change location to: 

C:\Users\Username\AppData\Roaming\CFM\Cashflow11\Bank and click on 

‘Save’ 

3. Unfortunately, the Bank's export files do not generally include the Balance so while 

you are signed in for online banking with your account selected, click on the 

'Statement' option and select the last day of the month to find out your Closing Bank 

Balance on this day. Write this balance down for future reference. 

4. Click on [Next] or press Alt-N on your keyboard to continue the Bank Reconciliation. 

Step 2: Import your Bank Statement File 

1. Browse to select your downloaded file. If you saved it in the location described in step 

1 this should be: C:\Users\Username\AppData\Roaming\CFM\Cashflow11\Bank. 

2. When you have selected the file, click on the [Next] button or press Alt-N on your 

keyboard. You should receive a message advising that your file has been successfully 

imported. 

Step 3: Closing Bank Balance 

1. Type the closing bank statement balance for the month in the box provided. 

This is the balance on your bank statement after the last transaction for the month. 

You may need to look up your closing bank statement balance in your internet 

banking statement as this information is not included in your downloaded file. 

(Hint: if the balance is in overdraft, record the amount as a minus.) 

2. Click on [Next] or press Alt-N on your keyboard to continue. 

Step 4: Reconcile Money In (Deposits) 

There are several stages in the Reconcile Deposits process. 

1. Money In – Auto-Matched. 

Your Money In Record deposits are matched to your Bank Statement on the basis of 

date and amount. Review these entries to ensure they are correct. If any are not 

correct, click on either the Records or Bank Statement checkbox to remove the 

match. Then click on [Next] or press Alt-N on your keyboard. 

2. Money In – Unmatched i.e. Deposits Not Found in Your Records 

Your unmatched entries are listed in amount order, although you can click on the 

header for any column that you may wish to sort by. 
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To match a transaction, click on the checkbox in My Records list, and the checkbox 

for the corresponding transaction in the Bank Statement list. These matched entries 

will be moved to the top of the list. 

Note: Transactions will only match if the amounts are the same. If you recognise a 

match but the amounts differ, you will need to correct the amount in your Money In 

Record before finishing your Bank Reconciliation. 

After making any corrections, any un-ticked amounts in the My Records section 

should be deposits recorded in the Money In Record but not appearing on your Bank 

Statement (i.e. outstanding deposits). 

Click on [Next] or press Alt-N on your keyboard to continue. 

3. Money In – To Add 

This will only appear if selected in Options – Advanced Preferences. It displays any 

entries for deposits listed on your bank statement but not entered in your records and 

allows you to select any entries that you wish to include in your records. Note: this 

option is turned off by default because it would be unusual not to add all such entries 

on your bank statement into your records. 

When you have done this, click on [Next] or press Alt-N on your keyboard to 

continue. 

4. Allocate Money In 

The Money In Record screen will now list the transactions you have selected to add so 

you can apply the amounts to the correct Allocation Columns. 

Arrow to or click on the amount you wish to reallocate and press your ‘Delete’ key to 

delete the amount from that column. Arrow across to the correct column and press 

‘Enter’ to save the amount in that column. 

You can also breakdown the transaction into more than one Allocation Column. 

When you have finished, click on [Next] or press Alt-N on your keyboard. 

Step 5: Reconcile Money Out (Payments) 

There are several stages in the Reconcile Money Out process. 

1. Money Out – Auto-Matched. 

The Total Bank Payment transactions from the Money Out Record are matched to 

your Bank Statement on the basis of cheque number, date and amount. Review these 

entries to ensure they are correct. If any are not correct, click on either the My 

Records or Bank Statement checkbox to remove the match. Then click on [Next] or 

press Alt-N on your keyboard. 

2. Money Out – Unmatched i.e. Payments Not Found in Your Records 

Your unmatched entries are listed in cheque number then amount order, although you 

can click on the header for any column that you may wish to sort by. 

To match a transaction, click on the checkbox in My Records list, and the checkbox 

for the corresponding transaction in the Bank Statement list. These matched entries 

will be moved to the top of the list. 

Note: Transactions will only match if the amounts are the same. If you recognise a 

match but the amounts differ, you will need to correct the amount in your Money Out 

Record before finishing your Bank Reconciliation. 

After making any corrections, any un-ticked amounts in the My Records section 

should be payments recorded in the Money Out Record but not appearing on your 

Bank Statement (i.e. outstanding payments). 

Click on [Next] or press Alt-N on your keyboard to continue. 
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3. Money Out – To Add 

This will only appear if selected in Options – Advanced Preferences. It displays any 

entries for payments listed on your bank statement but not entered in your records, and 

allows you to select any entries that you wish to include in your records. Note: this 

option is turned off by default because it would be unusual not to add all such entries 

on your bank statement into your records. 

When you have done this, click on [Next] to continue. 

4. Allocate Money Out 

The Money Out Record screen will now list the transactions you have selected to add 

so you can apply the amounts to the correct Allocation Columns. 

Arrow to or click on the amount you wish to reallocate and press your ‘Delete’ key to 

delete the amount from that column. Arrow across to the correct column and press 

‘Enter’ to save the amount in that column. 

You can also breakdown the transaction into more than one Allocation Column. 

When you have finished, click on [Next] or press Alt-N on your keyboard. 

Step 6: Balance and Lock your Records 

The summary information from both your records and the bank will be displayed. If you 

reconcile then the Records Balance and the Bank Balance will agree. 

Click on the [Finish] button to continue. 

A message will ask whether you wish to lock your records. When you have completed 

recording transactions for any month and it has been reconciled it is advisable to lock your 

records to prevent any accidental changes that might affect your records. 

To lock your records, click on [Lock]. If you do not want to lock your records at this time, 

click on [Don’t Lock]. 

If there is a discrepancy between your records and bank statement, the [Finish] button will 

be replaced by a [Next] button that will save the deposits and payments you have checked 

off to give you the opportunity to find what is causing the discrepancy without having to 

check everything off when you process your Bank Reconciliation again. 

When you lock your records, a padlock will appear next to the Account Name in your 

Money In, Money Out, Bank Reconciliation and Cash Reconciliation sections. 

If you need to unlock your records for any reason such as changing an allocation, go to the 

Bank Reconciliation screen and click on the [Unlock] button. 

If you unlock a month and change anything in the Bank Deposits column of your Money In 

Record, or the Total Bank Payment column in your Money Out Record this will affect your 

reconciliation, not only for this month but for any future month as well. 

Therefore, we recommend that you print your Bank Reconciliation report every month. 

Please also see the Tips and Tricks section regarding cancelling or amending cheques 

from a previous month. 

NOTE: The Bank Reconciliation process has Tabs that allow you to select a different step 

in the process. However, we highly recommend that you use the [Next] button or press 

Alt-N on your keyboard and only use the Tabs to make changes such as changing the 

Bank Statement balance. 

 

Reconciling to your Paper Bank Statement 

Click on the Bank Reconciliation tab. 
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The opening page will show the current balances from both your Cashflow Manager 

Records and your Bank Records together with the Discrepancy. 

To begin reconciling your records to your bank statement, click on [Next] or press Alt-N 

on your keyboard. 

Step 1: Closing Bank Balance 

Type the closing bank statement balance for the month in the box provided. This is the 

balance on your bank statement after the last transaction for the month. (Hint: if the 

balance is in overdraft, record the amount as a minus.) 

Click on [Next] or press Alt-N on your keyboard to continue. 

Step 2: Reconcile Money In (Deposits) 

The Reconcile Deposits window lists all the deposits entered in the Money In Record. 

Check the deposits on your Bank Statement against the list of Deposits. When the deposit 

on your Bank Statement agrees with the deposit on your list, click in the checkbox at the 

right side of the deposit in the list. Tick them off on your Bank Statement as well. 

If a deposit on the list differs from the amount on the bank statement, it may be caused by 

an error in the bank deposit or the entry in your Money In Record. 

If it is an error in the deposit addition, a correction should appear on your bank statement 

a few days later. The two amounts added together should equal the deposit on your list. If 

so, click in the checkboxes for the two amounts. If the error is in your Money In Record 

correct the entry. 

Any entries left un-ticked should correspond to the deposits that have been put into the 

bank too late to appear on the bank statement for the month. This will be rare but may 

occur on the last day of the month. 

Generally, the deposits listed will be those that are outstanding i.e. have not yet appeared 

on your bank statement. The Reconcile View provides the opportunity to vary the list. 

Once you have checked all your deposits, click on the [Next] button. 

The Allocate Money In window will appear so you can record any transactions you have 

discovered on your bank statement that have not been entered into the program without 

having to leave the Bank Reconciliation process. As you are entering these transactions 

during the Bank Reconciliation process they will automatically be treated as reconciled. 

When you have finished, click on [Next] or press Alt-N on your keyboard to continue. 

Step 3: Reconcile Money Out (Payments) 

The Reconcile Money Out window lists all amounts recorded in the Total Bank 

Payments column of your Money Out Record. 

Check the debits on your Bank Statement against the transactions in your Reconcile 

Money Out list. When you get a match, click in the checkbox at the right side of the 

payment in the list and tick the entry on your Bank Statement. 

If a cheque on the list differs from the amount on the bank statement, you have probably 

made an error on your cheque stub. Leave the transaction unchecked. When you have 

completed the rest of the reconciliation you will need to correct this in your Money Out 

Record and then redo the Bank Reconciliation that should only require matching of this 

transaction. 

Any entries left un-ticked should correspond to the cheques you have written that have not 

yet been presented at the bank. The total of these entries will be displayed as Payments 

Not Shown in the Bank Statement information section on the Bank Reconciliation screen. 

Any cheques that are not reconciled in the current month will automatically show up in 

the following month's Reconcile Money Out list. Generally, the payments listed will be 
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those that are outstanding i.e. have not yet appeared on your bank statement. The 

Reconcile View provides the opportunity to vary the list. 

Once you have checked all your deposits, click on the [Next] button or press Alt-N on 

your keyboard. 

The Allocate Money Out window will appear, so you can record any transactions you 

have discovered on your bank statement that have not been entered into the program 

without having to leave the Bank Reconciliation process. As you are entering these 

transactions during the Bank Reconciliation process they will automatically be treated as 

reconciled. 

When you have finished, click on [Next] or press Alt-N on your keyboard to continue. 
 

Step 4: Balance and Lock your Records 

The summary information from both your records and the bank will be displayed. If you 

reconcile then the Records Balance and the Bank Balance will agree. 

Click on the [Finish] button or press Alt-F on your keyboard to continue. 

A message will ask whether you wish to lock your records. When you have completed 

recording transactions for any month and it has been reconciled it is advisable to lock your 

records to prevent any accidental changes that might affect your records. 

To lock your records, click on [Lock]. If you do not want to lock your record, click on 

[Don’t Lock]. 

If there is a discrepancy between your records and bank statement, the [Finish] button will 

be replaced by a [Next] button that will save the deposits and payments you have checked 

off to give you the opportunity to find what is causing the discrepancy without having to 

check everything off when you process your Bank Reconciliation again. 

When you lock your records, a padlock will appear next to the Account Name in your 

Money In, Money Out, Bank Reconciliation and Cash Reconciliation sections. 

If you need to unlock your records for any reason such as changing an allocation, go to the 

Bank Reconciliation screen and click on the [Unlock] button. 

If you unlock a month and change anything in the Bank Deposits column of your Money In 

Record, or the Total Bank Payment column in your Money Out Record this will affect your 

reconciliation, not only for this month but for any future month as well. 

Therefore, we recommend that you print your Bank Reconciliation report every month. 

Please also see the Tips and Tricks section regarding cancelling or amending cheques 

from a previous month. 

NOTE: The Bank Reconciliation process has Tabs that allow you to select a different step 

in the process. However, we highly recommend that you use the [Next] button and only 

use the Tabs to make changes such as changing the Bank Statement balance. 

 

What to do if you cannot reconcile 

1. Check that the Opening Balance per your Records is the reconciled balance from the 

month before. 

2. Check that the amount you have typed into the Bank Statement Closing Balance is the 

end of the month balance according to your Bank Statement. 

3. Check that every credit (receipt) that has appeared on your Bank Statement is entered 

into your Receipt Record. This includes transfers from other accounts and bank 

corrections. 
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4. Check that every debit (payment) that has appeared on your Bank Statement is entered 

into your Money Out Record. This includes bank charges, government charges, direct 

debits for loans or insurance and telephone banking bill payments. 

5. Check that the amounts you have typed into your Money Out or Money In Records 

are the same as the amounts on the Bank Statement. 

6. Print out a Transaction Listing for the period you are reconciling. Get a friend or 

associate to assist you with one reading from the Bank Statement and the other from 

the Transaction Listing. Tick each transaction off as you agree. The entries left 

unchecked on the Transaction Listing should be the deposits and cheques that are 

outstanding at the end of the month (together with any that are still outstanding from 

the previous month.) 

7. If you still cannot reconcile, call your Accountant for assistance. 

 

Cash Reconciliation 

What is a Cash Reconciliation? 

A Cash Reconciliation is simply a check that the Cash on Hand per your Records equals 

the Actual Balance of Cash on Hand. This can be done as often as you wish. The Cash on 

Hand per your Records automatically calculates from the Opening Cash Balance which 

transfers from the previous month, the Receipts Not Banked entries in your Money In 

Record and the Total Cash Payments column in your Money Out Record. 

The formula that is used is simply: 

Opening Cash Balance 

+ Receipts Not Banked (from your Money In Record) 

- Cash Payments (from your Money Out Record) 

= Cash on Hand per your Records. 

 

Record Your Opening Cash Balance 

1. Click on the Cash Reconciliation tab. 

2. Change to the month in which you are commencing your records. 

3. Click on the [Settings] button. 

4. Record the Opening Cash Balance. (Your records may be locked because of your 

Opening Bank Balance. If so, click on the Bank Reconciliation tab and on the 

[Unlock] button. Then return to Money In.) 

5. Click on [OK]. 

 

Reconcile Your Cash 

Click on the Cash Reconciliation tab. 

Count your cash on hand and type the amount into the box for the current amount of 

cash on hand. 
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If the Cash on Hand per your Records is the same as the Actual Cash on Hand, then your 

cash reconciles. If they do not agree you should check your records and recount your cash 

on hand to see if there is an error. 

If you cannot find an error and your cash does not reconcile, the discrepancy must be 

recorded in the Money In or Money Out Records to correct the error. 

For example, if your actual cash on hand is £5.00 less than the balance per your records, 

you need to record the discrepancy in your Money Out Record. 

Open the Money Out Record and go to the next line available. 

Record the date of your reconciliation in the Day column. Arrow to the Details column 

and type ‘Cash Discrepancy’. Record the amount of the discrepancy in the Total Cash 

Payments column. Now record the amount in Sundry Other Non-GST Payments column. 

If you now click on the Cash Reconciliation tab, the Balance of Cash on Hand per your 

Records has been changed to reflect the entry you have made and should now reconcile 

with the cash amount you typed in. 

If your actual cash is greater than the amount of balance per your records, record the 

‘overage’ discrepancy in your Money In Record. 

Open the Money In Record and go to the next line available. 

Record the date you are reconciling in the Day column. Type "Cash Discrepancy" in the 

Details column. Record the amount of the discrepancy in the Total Receipts column, 

Other Non-VAT Receipts and Receipts Not Banked columns. If you now click on the 

Cash Reconciliation tab, the Current Cash on Hand per My Records has now changed to 

reflect the entry you have made and should now reconcile with the cash amount you typed 

in. 

You can complete your Cash Reconciliation at any time. However, you must record any 

discrepancies in the Money In or Money Out Record at the end of every month so that you 

do not carry forward an incorrect balance to the new month. 

 

Reports – Cashflow Manager 

Report Options – Cashflow Manager 

Once a report is selected, there are options to select different parameters for the generation 

of the report. Different reports have different options such as the ability to select accounts, 

a date range or specific type of report. 

The Choice of Reports table includes a column showing the different Report Options. 

These are: 

A – Account selection. Choose either All Accounts, Current Account or Select Accounts 

(brings up a list of all accounts to select from). 

C- Custom Date Only. Report relates to a specific period and the only option is to select 

a custom date. 

D – Date Period. Choose a report date range from Last Month, Last Quarter, Last 

Year, This Month, This Quarter, This Year or Custom (select report start and end 

periods where appropriate). 

E – Includes reports formatted especially for Microsoft Excel. 

F – Filter report. Report will show information based on filters e.g. Include Invoice 

Manager balances, Single or Multiple Columns etc. 

T – Type of printout. Choice of print layout or specific print media. 
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Types of Reports – Cashflow Manager 

The following table summarises the reports available in Cashflow Manager. More 

information is included below for reports highlighted by an asterisk*. 
 

REPORT EXPLANATION Report 

Options 

Balance Sheet 

(Movement)* 

The value of the movement in each of the 

columns that relate to the Balance Sheet (i.e. 

not Profit & Loss) 

A, D, F,T 

Bank Reconciliation Compares your bank balance per your records 

and your bank statement and lists any 

outstanding deposits and cheques 

C, T 

VAT* VAT Report for use in completing your VAT 

Return. You can also lodge your VAT Return 

online from this report. 

A, D, F,T 

Budget (Account) A month by month budget of your total Money 

In and Money Out for individual accounts 

C, F, T 

Budget (Business) A month by month budget of your total Money 

In and Money Out for the entire business 

C, F, T 

Cashflow Lists total Money In by column less total 

Money Out by column to calculate your net 

Money In or net Money Out 

A, D, T 

Cash Reconciliation Compares cash on hand per your records with 

actual cash on hand 

C, T 

Columns Listing A list of Money In and Money Out columns 

including Column Name, Tax Type, 

Accountant's Code, Profit & Loss Type 

A, T 

General Ledger 

Listing 

Lists the transactions for each Money In and 

Money Out column (in alphabetical order) 
A, D, F, T 

Money In Record The Money In Record as it appears on your 

screen. This is a Send to Excel Only Report 

A, D, E 

Money Out Record The Money Out Record with Columns and 

Totals as they appear on your screen. This is a 

Send to Excel Only Report 

A, D, E 

Monthly Summary A month by month picture of your total Money 

In and Money Out 

A, C, E, T 

Profit and Loss* Lists P&L Money In column total less P&L 

Money Out column totals to calculate your net 

profit or loss 

A, D, T 

Transaction Listing List of every transaction entered in your Money 

In and Money Out sections. Money In is 

followed by Money Out and printed in date 

order. 

A, D, F, T 
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Trial Balance Totals of each column in your Money In and 

Money Out Records together with the total 

movement in your Bank and Cash on Hand 

A, D, T 

 

Balance Sheet (Movement) 

NOTE: Cashflow Manager is not a ‘double entry’ general ledger program that retains 

opening balances. Nor does it classify columns as Assets, Liabilities or Equity. Therefore, 

a Balance Sheet Report is not possible. 

However, the Balance Sheet (Movement) Report will report the value of the movement in 

each of the columns that relate to the Balance Sheet. These cash 'movements' can be 

added to the Opening Balance to create the Balance Sheet. 

The Balance Sheet will list Money In, followed by Money Out, then Bank, Cash on Hand 

and finally the amount of Profit or Loss. 

You will also have the option to include the Invoice balances of Opening and Closing 

Receivables, or Opening and Closing Receivables and Payables. This report will be 

useful to your accountant when preparing your financial statements. 

Profit and Loss 

Lists Profit and Loss Money In column totals less Profit and Loss Money Out column 

totals to calculate your net profit or loss. You can print this as a ‘cash’ report or you can 

choose to include Invoice Manager totals. 

Trial Balance 

Lists the totals of each column in your Money In and Money Out Records together with 

the totals of your Bank and Cash on Hand amounts. Money In and Money Out columns 

are printed in alphabetical order. 

You also have the option to include Invoice Manager balances. 

This is an accounting check on your entries to ensure they balance in accordance with 

accounting principles. Therefore, this report will be useful for your accountant. 

Note: Cashflow Manager is not a general ledger program that reports opening and closing 

balances of accounts. The totals reported in the trial balance, including the bank and cash 

on hand accounts, reflect the transactions for the period selected and not the balances of 

accounts. 

 

Lodge VAT Online 

The VAT Report includes the option to Lodge Online. 

When you click on the [Lodge Online] button, the VAT information is updated ready to 

process and lodge. 

 

 

 

Budget 

Version 11 allows you to create Account-based & Business-based budgets. 

This means you can produce budgets for specific Cashflow “accounts”, or for the entire 

“business”. 

Both the ACCOUNT and BUSINESS BUDGETS can be accessed via the Side Panel. 
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Account-based Budget 

How do I create, save and delete an Account Budget? 

In Cashflow Manager you can create a budget which is based on the estimation on the 

total income and expenses for each month. 

To create and save a new Account Budget: 

1. Click on the ACCOUNT BUDGET tab on the Side Panel. 

2. Use the ACCOUNT-selector at the top of the screen to ensure you are in the 

correct account. 
3. Click on the NEW tab – a “New Budget” window will appear 

4. Type in a name for your new budget. Please note: only letters and numbers can be 

used. 

5. If you have not entered any data into Cashflow, and just want to obtain a budget 

set up first, choose “No Initial Data”, and then click [OK]. 

6. Your budget will appear ready for the months of the Financial Year and categories 

to be filled in. The amounts can only be entered in full dollar amounts. 

7. To the far right it will total the entire ‘Allocation Columns’. Down the bottom of 

the budget it will give you your monthly totals. 

8. Click the [Save] button towards the bottom of the budget screen. 

 
To delete an Account Budget: 

If you need to delete a budget, ensure that you have the correct budget name in the 

BUDGET-selector at the top of the screen. 

Click the [Delete] button at the bottom of the screen. 

Select the budget you wish to delete from the drop-down list and click [OK]. 

 

How do I increase the estimated figures in the Account Budget? 

If you have loaded historical data to help create your budget, you may wish to increase 

your totals by a set percentage for inflation. In fact, you can also use this option to 

increase the whole budget, a time-period or a selected column by an amount. 

To do this: 

1. When in your budget, click on the [Increase] button at the bottom of the screen. 

2. A "Percentage Increase" box will appear. This will then allow you to increase to 

*Pound* Value or *Percentage* Value, for a specific time-period, or allocation 

column. 

3. Click on the [OK] button to apply the increase. 
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How do I save the Account Budget as a CSV file? 

1. While in the Budget, click on the [Save As..] button at the bottom of the screen 

2. In the bottom, left corner where it says, "File name", be sure to type in a name for 

the Budget that you have just created 

3. Navigate to the location you wish to save your budget [e.g. Desktop] 

4. Click on the [Save] button in the bottom right corner and you can also see that this 

will then save your Budget as a csv file. 

 
How do I print my Account Budget? 

1. Click on the Cashflow REPORTS tab on the Side Panel. 

2. Double left click on the BUDGET (ACCOUNT) report 
 

 

3. You can then select the month and year of the Budget and the Budget you would 

like to print 

4. On the bottom right hand corner, you can either chose to click on [Preview] or 

[Print] your Budget. 

5. The report will display the type and name of the budget 

Account Budget Comparison – comparing your Actual Cashflow to the Account 

Budget 

Comparing actual results with your account budget each month highlights the differences 

between your budget and your performance. This enables you to examine the reasons for 

the differences and to act on the reasons to improve future performance. 

1. When in your budget, click on the [Comparison] button at the bottom of the 

screen. 
2. Select the period you want to compare using the options at the top of the screen. 

3. Click on [Compare]. 

4. Type in any comments or action required. 

5. Click on the [Print] button to print or email your comparison. You can also export 

your comparison by clicking on [Export] to create a comma separated value 

delimited text file that can be opened in programs such as Microsoft Excel. 
6. Click on [OK] when you have finished. 

 
How do I save the Budget Comparison as a CSV file? 

1. While in the Budget, click on the [Comparison] button at the bottom of the screen 

2. Then click on the [Save As..] button at the bottom of the screen 

3. In the bottom, left corner where it says, "File name", be sure to type in a name for 

the Budget Comparison you have created 

4. Navigate to the location that you would like to save your Comparison [e.g. 

Desktop] 

5. Click on the [Save] button in the bottom right corner. The Comparison will then 

be saved as a csv file. 
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Business-based Budget 

How do I create, save and delete a Business Budget? 

In Cashflow Manager you can create a budget which is based on the estimation on the 

total income and expenses for each month. 

To create and save a new Business Budget: 

1. Click on the BUSINESS BUDGET tab on the Side Panel. 

2. Click on the NEW tab – a “New Budget” window will appear 

3. Type in a name for your new budget. Please note: only letters and numbers can be 

used. 

4. If you have not entered any data into Cashflow, and just want to obtain a budget 

set up first, choose “No Initial Data”, and then click [OK]. 

5. Your budget will appear ready for the months of the Financial Year and categories 

to be filled in. The amounts can only be entered in full dollar amounts. 

6. To the far right it will total the entire ‘Allocation Columns’. Down the bottom of 

the budget it will give you your monthly totals. 
7. Click the [Save] button towards the bottom of the budget screen. 

 
To delete a Business Budget: 

If you need to delete a budget, ensure that you have the correct budget name in the 

BUDGET-selector at the top of the screen. 

Click the [Delete] button at the bottom of the screen. 

Select the budget you wish to delete from the drop-down list and click [OK]. 

 
 

How do I increase the estimated figures in the Business Budget? 

If you have loaded historical data to help create your budget, you may wish to increase 

your totals by a set percentage for inflation. In fact, you can also use this option to 

increase the whole budget, a time-period or a selected column by an amount. 

To do this: 

1. When in your budget, click on the [Increase] button at the bottom of the screen. 

2. A "Percentage Increase" box will appear. This will then allow you to increase to 

*Pound* Value or *Percentage* Value, for a specific time-period, or allocation 

column. 

3. Click on the [OK] button to apply the increase. 

 
How do I save the Business Budget as a CSV file? 

1. While in the Budget, click on the [Save As..] button at the bottom of the screen 

2. In the bottom, left corner where it says, "File name", be sure to type in a name for 

the Budget that you have just created 
3. Navigate to the location you wish to save your budget [e.g. Desktop] 

4. Click on the [Save] button in the bottom right corner and you can also see that this 

will then save your Budget as a csv file. 

 
How do I print my Business Budget? 

1. Click on the Cashflow REPORTS tab on the Side Panel. 

2. Double left click on the BUDGET (BUSINESS) report 
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3. You can then select the month and year of the Budget and the Budget you would 

like to print 

4. On the bottom right hand corner, you can either chose to click on [Preview] or 

[Print] your Budget. 

5. The report will display the type and name of the budget 
 

 

Business Budget Comparison – comparing your Actual Cashflow to the Business 

Budget 

Comparing actual results with your business budget each month highlights the differences 

between your budget and your performance. This enables you to examine the reasons for 

the differences and to act on the reasons to improve future performance. 

1. When in your budget, click on the [Comparison] button at the bottom of the 

screen. 

2. Select the period you want to compare using the options at the top of the screen. 

3. Click on [Compare]. 

4. Type in any comments or action required. 

5. Click on the [Print] button to print or email your comparison. You can also export 

your comparison by clicking on [Export] to create a comma separated value 

delimited text file that can be opened in programs such as Microsoft Excel. 
6. Click on [OK] when you have finished. 

 
How do I save the Budget Comparison as a CSV file? 

1. While in the Budget, click on the [Comparison] button at the bottom of the screen 

2. Then click on the [Save As..] button at the bottom of the screen 

3. In the bottom, left corner where it says, "File name", be sure to type in a name for 

the Budget Comparison you have created 

4. Navigate to the location that you would like to save your Comparison [e.g. 

Desktop] 

5. Click on the [Save] button in the bottom right corner. The Comparison will then 

be saved as a csv file. 

 

 

Helpful Hints to Create a Budget 

❖ Use the Enter, Tab and arrow keys to move around the screen. 

❖ Remember to estimate when you are likely to receive payment where goods are sold 

on credit. Don't forget receipts from loans, sales of plant and your own money. 
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❖ Some Money Out such as rent, and loan repayments may be the same each month. 

Others, such as Stock Purchases, will vary with the expected level of sales. Other 

payments, such as equipment replacements will vary for other reasons. 

❖ Be realistic - sometimes it is valid to take last year's amount but often it is not. 

❖ Remember that holiday pay means a big payment followed by a reduction in wages 

for the next few weeks. 

❖ Don't forget that some payments such as insurance and income tax only occur 

occasionally, or commitments recently entered or planned. 

❖ REMEMBER - you are looking at when the payment will be made, not when you 

receive the bill. 

❖ If you have an amount that will repeat, type the amount in the first month and click on 

the amount to highlight it. Then right click on the amount and select ‘Copy’. Right 

click on the next cell and select ‘Paste’ to paste the amount into that cell. 

 

 

 

Tips and Tricks 

Cancelling or Amending Cheques for a Previous 
Month 

Going back and amending the original transaction in past months that have been 

reconciled can cause problems with your Bank Reconciliations. 

To cancel a cheque, enter the same cheque details in the current month but with a negative 

amount. When you process your Bank Reconciliation, the same cheque number will 

appear twice, one with a positive amount and the other with a negative amount. Click 

them both as if they have been presented. 

To adjust the amount of a cheque, make the adjustment in the current month. If the cheque 

amount is more than your records show, the adjustment will be positive, but if it is less, 

the adjustment will be negative. Click both amounts off in the Bank Reconciliation. 

 

Duplicate an Account 

You can quickly and easily create new accounts with the same columns by duplicating an 

account that you have already customised. 

1. Open the account you wish to duplicate from the Dashboard. 

2. Click on the Options icon. 

3. Click on Duplicate Account. 

4. Enter the name of the new account in the white box that appears. Click on [Save]. A 

new account with the same column headings but no data will be created. 

 

Lock and Unlock your Records 

Once you have completed your Bank Reconciliation for the month, your records will be 

locked. This is to protect you from accidental changes that will not only affect that 

month's reconciliation, but also any reconciliation you have completed for future months. 
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The reconciled bank balance carries forward from month to month. Also, deposits and 

cheques that were outstanding at the end of a month may have subsequently appeared on 

your Bank Statement and are no longer recognised as outstanding. 

Consequently, if you make a change to an earlier month you can create yourself a disaster 

and must complete your reconciliation again. Provided you have reconciled correctly, the 

only time you should need to make a change is when you have entered an amount into an 

incorrect column and you want to move it to another column. 

However, extreme care is required to ensure that you do not alter anything affecting your 

Bank Reconciliation. (If you have already transferred information to your Accountant you 

should only make changes advised by your Accountant.) 

To unlock a month, you must first click on the Bank Reconciliation tab. Now click on the 

[Unlock] button. Your Money In and Money Out Records will also be unlocked. 

You can now make the changes you wish. To lock it again, return to the Bank 

Reconciliation. If you have not made any changes that affect the reconciliation, the 

[Finish] button will be displayed, and you can click on that button followed by the [Lock] 

button. If the [Next] button is displayed, you will need to go through the Bank 

Reconciliation process again. 

 

Providing Information to your Accountant 

There are four ways to transfer information to your accountant. 

 

1. Printed Reports 

Your accountant may want you to provide printed reports. If so, print them and provide a 

copy. You can also save reports in a PDF for to give them electronic ‘printed’ reports. 

 

2. A Complete Backup of your File 

Most accountants who have Cashflow Manager on their computers would prefer to get a 

backup of your file as it allows them to review your work in Cashflow Manager before 

transferring the information into their general ledger programs. 

The simplest way to accomplish this is to send a backup file to your accountant. 

However, if your accountant is going to send you back any changes to incorporate into 

your file, anything you have done since creating the backup file you sent to the 

accountant, including transactions recorded in the invoice section of the program, will be 

lost. The program has a feature that enables you to export information from your 

Cashflow Manager accounts to your accountant, continue working and then import the 

data back into your file when the accountant sends it back to you – see below. 

 

3. Export Cashflow Manager Accounts To and 
Import Accounts From Your Accountant 

Cashflow Manager Version 11 has a feature that enables you to: 

1. Export Cashflow Manager data to your accountant 

2. Continue working in your program, and then 

3. Import Cashflow Manager data received back from your accountant. 

Prior to version 8, when you sent your file to the accountant you either needed to delay 

doing any other work, or manually make any changes advised by your accountant. But 
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now you can send your data to the accountant, continue working in the program, and 

import any changes from your accountant back into the program. 

Another excellent feature is that you can just export the data for a selected period instead 

of the whole file. 

 

 
3a. Export Cashflow Manager Data TO Your Accountant 

 
1. Click on the File menu. 

2. Click on ‘Accountant Export’ 

3. Click on ‘Export to Accountant’ 

4. Select the account(s) you wish to export. ‘All Accounts’ is the default selection, but 

you can change this to Current Account you are working in, or you can click on 

‘Select Accounts’ and choose the accounts to be included. 

5. Choose the starting month and year, and the ending month and year for the data you 

wish to be included by clicking on the up and down arrows. 

6. We are now ready to select the Export File Name. 

a. Click on Browse. 

b. The Windows ‘Save As’ window will appear, so you can choose a location 

and file name for the export file. 

c. The default location for the file to be saved is the 

C:\Users\Username\AppData\Roaming\CFM\Cashflow11\Data folder. 

d. The default file name is the name of your current business file with 

information about the dates you are exporting. For example, if my current file 

name is Sample and I am exporting from January 2014 to March 2014, the file 

name for the export file will be Sample Jan2014-Mar2014. 

e. The file will be saved as an Accountant Export File with an .e11 extension. 

f. The months will be locked for each of the accounts included in the export, so 

you do not make any unwanted changes. A red padlock will appear next to the 

account name in your Cashflow Manager work area to indicate that the month 

is locked. (See ‘Unlock Months Exported to Accountant’) 

7. If you wish to email the file to your accountant, click so a tick appears in the 

checkbox for ‘Email File When Export Complete’. 

8. Click on the [Export] button. The program will now create the file. 

If you select ‘Email File When Export Complete’ the ‘Email Document’ window will 

appear. 

1. Type in your accountant’s email address in ‘Send To:’ (or select the address by 

selecting from ‘Show Contact Emails’. 

2. Type in a Subject for the email e.g. Cashflow Manager Files 

3. Type in any additional text for the email. 

4. Click on the [Send] button. 

Note: you can also add attachments such as PDF copies of your reports by clicking on the 

‘Add Attachment’ button. 

 

 
3.b. Import Files Returned FROM Your Accountant 
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3.b.1. Selecting the File 
 

Important: Please back up your file before importing files from your accountant. 

Note: If your accountant emails your file to you, you will need to right click on the file in 

your email, select ‘Save As’ and save the file to a location on your computer before 

completing the following steps. 

1. Open your Cashflow Manager program and the normal business file. 

2. Click on the File menu when in the Cashflow section. 

3. Click on ‘Accountant Export’ 

4. Click on ‘Import from Accountant’ 

5. Click on the [Browse] button for the Import File Path. 

6. Navigate to the location of the file that your accountant returned to you and select the 

file. 

Note: The file name will generally be the same as the file you sent to the accountant but 

will have the addition of the date that the accountant created the file to return to you. 

For example, if the export file you sent to the accountant was Sample Jan2014- 

Mar2014.e11, the file that you receive back from the accountant will generally be Sample 

Jan2014-Mar2014_20140430.e11 if the accountant created the file on the 30th April 2014 

(The dates are in YYYYMMDD order, so they appear chronologically when your files are 

sorted in ‘name’ order.) 

 

3.b.2. Importing the Data 
 

Once you have selected the file, the information in that file will display in a table with 

columns as follows: 

• ‘Account Name’: the Cashflow Manager account name 

• ‘Month’ and ‘Year’: each month that has data in it will be listed separately. 

• ‘Bank Rec. This File’: advises whether the Bank Reconciliation in the current file 

(before import) is locked or unlocked. 

• ‘Bank Rec. Import File’: advises whether the Bank Reconciliation in the file being 

imported is locked or unlocked. 

• ‘Locked State’: advises whether the month in the current file (before import) is locked 

because it was exported to the accountant, or whether it has subsequently been 

unlocked. 

• ‘Action’: the action that will occur when the [Import] button is activated. 

o ‘Replace’: replaces all the existing month’s data and bank reconciliation 
information with the data in the accountant’s file. 

o ‘Merge’: merges the existing month’s data with the data in the accountant’s file 
(import file). 

▪ Each receipt and payment transaction in the import file is compared to the 

existing file. 

▪ If it is a ‘full match’, the existing transaction is not changed. 

A ‘Full Match’ is when all fields for both records are equal. 

▪ If it is a ‘partial match’, the existing transaction will be replaced by the 

transaction in the import file. 

A ‘Partial Match’ is when 
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• Dates and Receipt Totals are equal, or 

• Dates, Customers and Details are equal, or 

• Dates and Total Bank/Cash Payments are equal or 

• Dates, Suppliers and Details are equal. 

▪ If there is ‘no match’ the transaction from the import file is added to the 

existing file. 

No match is when there is neither a full match nor a partial match. 

WARNING: The ‘Merge’ option is not recommended because any bank 

reconciliations that have previously been processed will be lost and will need 

to be done again. However, it is an option if you have added transactions to 

that month after you exported to your accountant. 

o ‘Ignore’: ignores the data in the accountant’s file. 

 
1. Review the information on each line (for each separate month for each account) and 

select the action to be taken. 

a. The default action is ‘Replace’ which will replace your existing data with the 

data in the file sent to you by the accountant. 

b. If your accountant advises they have only made changes to one or two 

months, you can select ‘Ignore’ for all other months to reduce the time it takes 

to do the import. Alternatively, you can simply choose to ‘Replace’ all 

months if you have not made any changes since you sent the file to the 

accountant. 

c. If you have unlocked and made any changes to transactions in a month sent to 

the accountant, the ‘Merge’ option is available. However, this should only be 

used with great care, as any bank reconciliations that have previously been 

processed will be lost and will need to be done again. 

2. When you are ready to proceed, click on the [Import] button. A message will appear 

to confirm you wish to proceed. Click on [Yes] and the import will take place. 

Once the import is completed: 

1. The file will be reloaded, 

2. the ‘Export Lock Icon’ will have disappeared on any months imported, 

3. and you can check the information. 

 

 
3.c. Unlock Months Exported to Your Accountant 

 
If you have exported information to your accountant you can unlock months that have 

been exported if you need to make some changes for some reason. 

Note: Extreme care is needed in making changes to the information sent to your 

accountants, particularly if they are unaware of the changes you are making. If you 

subsequently receive adjusted files back from your accountants you will lose the changes 

you have made unless you use the ‘Merge’ import option, and in that case, you will need 

to redo your bank reconciliations. 

To unlock months exported to your accountant: 

1. Click on the File menu. 

2. Click on ‘Accountant Export’ 
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3. Click on ‘Unlock Months’ 

4. Click in the ‘Unlock’ check box for any months you wish to unlock. 

5. Click on the [Unlock] button. 

6. A message will ask you to confirm that you wish to do this. Click on [Yes]. 

7. The ‘Export Lock Icon’ will be removed and you can process the month as normal. 

 

4. Export to Accountant’s General Ledger 

You can also export to a file that your accountant's general ledger program can read as 

Cashflow Manager has automatic export routines for most software packages used by 

accounting firms. You will need to find out the general ledger package that your 

accountants’ use and the account code number for each of your columns. 

If you have not previously established the export format used by your accountants, click 

on the Options icon at the top of the screen and select Accountant’s General Ledger 

Format. Select the name of your accountant's general ledger system from the drop-down 

list and record your accountant's code for your Bank Account and Cash on Hand account. 

To export: 

1. Print a Trial Balance Report and check that the accountant's codes are the same as 

those advised by your accountant. If you need to change any codes, refer to the 

instructions on ‘Customising your Columns’. 

2. When you have checked these details, and made any required changes, select Export 

from the File menu. 

3. Select the From and To dates for the data you wish to export. 

Extreme care needs to be taken to avoid either missing transactions or duplicating 

transactions that have already been supplied to your accountants. Only export when a 

month has been reconciled and locked, and then select the beginning date and ending 

date of the month. 

4. Click on the [Browse] button for Destination File Name. 

5. Select a location and type a file name for your export file. If you export a monthly file, 

identify the export file for each month separately. By giving each file a unique name 

you have protection if something is wrong with the information in a file. 

6. Click on the [Save] button. This will return you to the export window and the 

destination will now appear in the Destination Filename box. 

7. Click on [Export]. Your export file will be created for you to send to your accountant 

and a message will advise when the export is complete. 

 

Information for Accountants When Clients Export 
Cashflow Manager Accounts 

1. Restoring the Client’s Exported File 
 

1. Open your Cashflow Manager program and click on the ‘Restore’ icon. 

2. Click on the [Browse] button for ‘Restore Source’ and navigate to the location where 

the client export file is located. 

3. Click on the File Type button to change the file type from ‘Backup Files (*.b11)’ to 

‘Accountant Export Files (*.e11)’ 
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4. The “Restore Destination Path” will automatically pre-fill and default to the Cashflow 

11 Data Folder. 

5. If you wish to change the “Restore Destination Path”, click on the CHANGE tab, and 

navigate to the location where the file is to be saved. 

Note: You can change the name of the file if you wish, but the file will have a normal 

Cashflow Manager (.c11) file type so be careful not to duplicate the name with any 

other files. 

6. Click on [Restore]. 

The file will now open as a normal Cashflow Manager file although only the 

relevant Cashflow Manager sections will be active. 

You can now make any changes that are required including processing any Bank 

Reconciliations that are required. 

 

2. Backing up the File for Return to the Client 
 

1. Click on the ‘Backup’ icon on your toolbar. 

a. The Backup File Name will auto-fill. 

b. The date (in format YYYYMMDD) will be added to the Backup File Name 

so it is easy to identify the correct file. 

c. The Backup File Type is e11 to indicate it is an Accountant Export backup 

file. 

2.  If you wish to email the file to your client, click so a tick appears in the checkbox for 

‘Email File When Export Complete’. 

3. Click on the [Backup] button. 

The backup file will now be created ready to send to the client. 

 

Import an Account from another Cashflow Manager 
File 

You can transfer an account in one Cashflow Manager file to another. For example, if you 

create an account and record transactions in a business file and then realise it is the wrong 

business, you can use this process to transfer the account into the correct business file. 

Step 1: Export the data from the first file by following the ‘Export Cashflow Manager 

Data TO Your Accountant’ instructions. If you wish to transfer the complete account, 

choose all months where data is recorded. Save the ‘export file’. 

Step 2: Import the data into the second file by following the ‘Import Files Returned 

FROM Your Accountant’ instructions. 

 

What Changes Can Be Made and Imported Back into 
the File 

Probably the most frequent changes that accountants need to make are correcting 

allocations to ensure they are in the right column. But other changes can also be made, 

such as: 

1. Add a New Account: However, there must be at least one transaction in the file. 

2. Add a New Column 
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3. Add Transactions 

4. Delete Transactions 

5. Bank Reconciliations can be processed and locked 

6. Move Columns 

 

Rename an Account or Business File Name 

1. Click on the Options icon 

2. Click on Rename Account & Business File. 

3. The Current Account Name and Current Business File Name will be displayed. Type 

the new name and click on [Save]. 
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Troubleshooting 
 
 

Problem Potential Solution 

Program jumps to the end of the 

section instead of typing a number. 

Check the 'Number Lock' on your keyboard is 

switched on. 

Unable to enter a date in Day 

column. 

Check the 'Number Lock' on your keyboard is 

switched on. 

Unable to edit information in Money 

In or Money Out. 

Is there a padlock at the top of the section? This 

means your records are locked. Unlock your 

records to make the changes. (Click on the 

padlock in the Bank Reconciliation section). 

Money Out transactions are missing 

from My Records section in the 

Bank Reconciliation. 

Open Money Out section. Check that missing 

payments are not in the Total Cash Payments 

column. If so, arrow to the total and press your 

'Delete' key. Arrow back to Total Bank 

Payments column and press 'Enter'. 

Don't know whether backup has 

worked. 

Use Windows Explorer to navigate to the 

location you selected for the backup. Ensure that 

your backup file (filename.b11) is there. Backup 

regularly to more than one drive. 

Printing a report and print preview 

screen displays a blank page or 
words are overlapping. 

Check the printer settings are set as A4 (i.e. 

paper size) and portrait (i.e. orientation). 
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  Invoice Manager Version 11  
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Invoice Manager 

Getting Started 

Introduction to Invoice Manager 

Controlling money owed is one of the most vital parts of business. There is an old saying that 

goes “The sale is not made until the money’s in the bank”. 

From a legal viewpoint, this saying is not true. The sale is made when you provide the goods or 

services and the customer incurs the liability to pay. So, while your profit or loss can include 

sales made on credit, your cash flow can be severely affected if you are not collecting the money 

owed to you for goods or services provided on credit. 

You must have procedures in place to ensure that they are collecting money owed to you and 

that you are collecting it as quickly as possible. Invoice Manager will help you to prepare your 

invoices and manage the money owed to you. 

It is very easy to use so that it becomes a valuable tool in running your business. However, while 

it will provide you with the information you need, it cannot collect the money for you. 

Many people dislike following up outstanding debts and therefore procrastinate in attending to 

this function. 

Bear in mind that you are providing interest free credit to your customers and many customers 

(particularly those in financial trouble) will use this facility for as long as you let them. We again 

emphasise that properly managing money owed to you is one of the most vital management roles 

in business. 

Invoice Manager has 4 sections: 

1. Creating sales invoices and managing money owed to you for sales on credit (your debtors). 

This section is included with Cashflow Manager. 

2. Creating purchase orders and managing money owed by you for purchases on credit. 

3. Tracking inventory on goods purchased and sold. 

4. Reports 

 

Open Invoice Manager 

To open Invoice Manager, click on Invoice on the Side Panel. 

 

Create a New Invoice Manager Account 

You will have already created your business file when you first started to use Cashflow 

Manager. If you have recorded, imported or rolled over any information into the Cashflow 

section please backup before creating your Invoice Manager account. 

When you first click on the Invoice tab, you will need to complete the information required for 

Invoice Manager. A Wizard will assist you to set up your Invoice Manager account. Each of the 

steps in the wizard will have instructions on what to do. 

1. Do you wish to import data from an existing Invoice Manager file? 



84  

If you do not want to import files from an earlier version of Invoice Manager, click the [No] 

button. 

If you are upgrading from an earlier version of Invoice Manager and you wish to import 

those files into this new ‘business’ file, click the [Yes] button. 

The following steps are based on selecting [No] to importing earlier version files. For more 

information on importing files, see ‘Importing Data from an Earlier Version File’. 

Click on [Next] to move to the next step. 

2. Business Details: Record your Business Name, and VAT Number. Details already recorded 

in other areas of the program will automatically pre-fill and any changes will apply across 

the whole program. Click on [Next] to continue. 

3. Street Address: Record the street address of your business. Click on [Next] to continue. 

4. Postal Address: Record the postal address for your business. If the postal address is the 

same as your street address, tick the Use Street Address checkbox. Click on [Next] to 

continue. 

5. VAT Calculation: When preparing sales invoices, VAT can be added to your VAT 

Exclusive Prices or calculated from VAT Inclusive Prices. Select the method you wish to 

use and click on [Next] to continue. 

6. Congratulations: Click on [Next] to add the data you have just recorded to your Invoice 

account. The program will then open to the Customers page. 

 

Import Data from Version 6 or previous 

When you are creating a new Invoice account and select [Yes] to import an earlier version file, 

the following steps apply. 

NOTE: You can only import one earlier version file, and the data will be imported into the same 

file as your Cashflow Manager records, so it is critical that you backup your business file before 

processing. 
 

 

 

 

 

 

 

 
1. Import Invoice Manager Data: Select an Invoice Manager file to import: Click the 

[Browse] button and select the file to import. 

You can import Invoice Manager data or backup files. When you click on the [Browse] 

button it will automatically look for Invoice Manager 2004 data files (.im6). Click on the 

Down Arrow in the Files of type field to change your selection to version 4 (.im4) of 

Invoice Manager or backup files for Version 4, or 2004 (.bi4 or .bi6). 

When you have selected the file click on the [Open] button to return to the wizard. Click on 

[Next]. 

If you choose not to import from an earlier version file when creating the Invoice account, 

you can do so later by selecting the File menu and select Import. Although we have included 

this option, we highly recommend that you import the file during the wizard process. If you 

want to do this but are not ready now, please [Cancel] and create the Invoice account when 

you are ready to proceed. 
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2. Business Details: Record or update your Business Details. Details already recorded in other 

areas of the program will automatically pre-fill and any changes will apply across the whole 

program. 

3. Street Address: Record the street address of your business. 

4. Postal Address: Record or update your Postal Address. If the postal address is the same as 

your street address, tick the Use Street Address checkbox. 

5. VAT Calculation: When preparing sales invoices, VAT can be added to your VAT 

Exclusive Prices or calculated from VAT Inclusive Prices. Select the method you wish to 

use. 

6. Congratulations: This is simply a message advising that you have completed the 

information and your information is now ready to import. Click on [Next] to continue. 

You will be asked if you wish to back up the business file prior to importing the data. Click 

on [Yes] if you have recorded information in any other section of the program and have not 

backed up prior to importing. Process the backup. The data will then be imported, and the 

program will then open to the Customers page. 

 

Menus - Invoice Manager 

At the top of the page you will find the File, and Tools menus that provide you with functions to 

use from time to time. When you click on these menus, a drop-down menu will appear. Position 

your mouse pointer over the option you require and click to select it. 

The following is an overview of each menu item: 

File 
 

Create New Business File: Creates a new business file 

Open Existing Business 

File: 

Opens an existing business file 

Backup: Creates a backup of your file 

Restore: Restores a backup file 

Import: Imports customer, supplier or inventory data. 

Export: Export customer, supplier or inventory data. 

Password: Options to add, change or delete a password. Passwords can be 

set for each section. 

Exit: Exit the Program 

 
Tools (Customers) 

 

Purge Data Purge old transactions 

Search Search for a transaction 

Invoice Setup Wizard The easy way to customise Invoice Layouts 

Customised Layouts More technical than the Invoice Setup Wizard 

Change Decimal Points Change from 2 to 3 decimal points for invoice calculations 

Move Invoice to Another 

Customer (Supplier) 

Remove Credit 

(Overpayment) 

Move an invoice from one customer (supplier) to another 

 
Remove Credit and Overpayment amounts that have been 

applied to invoices 

Remove Money In 
(Money Out) Transaction 

Remove receipts (payments) that have been applied to 

invoices. 
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Restore Default Column 

Widths 

Restore the column widths in work areas back to the default 

widths 

Unfinalise Invoice Unfinalise an invoice that has been previously finalised 

Jobs List Create and manage jobs 

Email Create an email 

Options Refer to separate section on Options in Tips & Tricks – 

comprehensive options that can be used with your file 
 

 

Icons – Invoice Manager 

See ‘Icons’ in ‘Functions Common to All Programs’. 

 

Options – Invoice Manager 

Each section of the program – Cashflow and Invoice have Options. Some are ‘global’ options 

and others are specific to the section you are in. 

To access the Invoice Manager Options, you need to be in the Invoice section of the program. 

Click on the Tools menu and select Options, or click on the Options icon on the tool bar: 

The following options are available: 

Address Details: Change the street or postal address. 

Advanced Preferences: The following options are available after selecting Advanced 

Preferences. 

Picking Slip Name: Change the name to print on Picking Slips (E.g. Packing Slip, 

Delivery Docket etc.) 

Customer: Change the title to match your business. For example, you might have 

clients, or patients. Personalise the program for your type of customers. 

Extra Column: If you require an extra column in your invoices, click in the 

checkbox for Show extra column on all forms and then type the name for the 

column. 

Other Preferences: Default Money In Transfers to Bank Deposits or Receipts Not 

Banked. 

Use Job Numbers: Turns the Job Number Option on and off. 

Use Transfers: Turns the transfer function on and off. When the transfer function 

is on you can use this function to batch money received at the time of creating the 

invoice to transfer to Cashflow Manager. 

Business Details: Change the Business Name, VAT Number, Company Registration 

Number, and License Number. 

Cash Invoice Settings: Select the settings for transferring Cash Invoice receipts to 

Cashflow Manager. Select ‘Always’ to have cash transferred every time you create a cash 

invoice, ‘Never’ if you wish to use the ‘Transfers’ function or you also have the option to 

make the decision at the time by selecting ‘Ask me each time a Cash Invoice is Finalised’. 

There is also an option to generate a message to print the Receipt after the Cash Invoice is 

finalized. 

Contact Details: Change the phone numbers, fax number, email and web address. 
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Currency Symbol: Change the currency symbol used in your business. 

Customer Types Settings: Select to use and record descriptions for multiple customer types 

with different selling prices. 

Customised Layouts: (This will only appear if you have customised layouts). Customise 

layouts for your Invoices, Credit Notes, Purchase Orders, Picking Slip, Receipts, Returns 

and Statements. One of the Customised Invoice Layouts can be selected to use as the layout 

for the Picking Slip. 

Grid Font Size: Increase the size of the font on your screen. 

Invoice Layout Settings: Select the default layout for your invoices and whether to include 

a remittance advice that also includes credit card options. You can also add your logo if this 

is the only customisation you require. 

Print Settings: Choose whether to use your pre-printed letterhead or print your company 

details. Also select margins and fonts for your invoices. 

Microsoft Word Settings: Set up templates to print invoices etc. using Microsoft Word. 

Rename Business File: Change the file name. 

Tax Settings: Select the VAT Rate, PR VAT Rate, EC VAT Rate, and whether to calculate 

VAT using Exclusive or Inclusive prices. 

 

Customer Types 

The program allows you to record different Customer Types that can have different prices e.g. 

Retail and Wholesale customers. Use Customer Type 1 for your most regular customer group. 

1. Click on the Options icon and select Customer Types. 

2. Click on the checkbox for Use Customer Types. 

3. Click on the checkbox for each customer type you wish to use and type a description e.g. 

‘wholesale’ into the Description box. 

4. Click on the [Save] button. 

When adding or modifying a customer you can assign a Customer Type. This will appear when 

adding invoices and will default to the unit sale price for that Customer Type. 

 

Invoice Layouts 

The program includes standard layouts for your type of business (and you can choose whether to 

include your company details or print on your company's pre-printed letterheads) 

The standard layouts include: 

❖ General Invoice – Item Code Layout 

❖ General Invoice – No Item Code Layout 

❖ Service Invoice 

❖ Professional Invoice 

❖ Medical Layout 

You can view each of the invoice layout settings by clicking on the Options icon when you are 

in Invoice Manager. Then click on Invoice Layout Settings. Click on the [View] button next to 
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Default Layout to view the selected layout. Click on the dropdown for the Default Layout, select 

an alternative layout and then click on the [View] button again to view the alternatives. 

You can customise your layouts if the standard layouts do not meet your needs. 

1. The ‘Invoice Setup Wizard’ is an easy way to customise your invoice layout. 

2. There is an option to ‘Customise your Layouts’ including invoices, statements, picking slips, 

purchase orders and more. This is a more flexible but complicated process than the ‘Invoice 

Setup Wizard’. If you need assistance, you can also call the CARE Support Team who can 

customise layouts for you. However, a fee is charged for this service. 

3. You can print some reports such as invoices to Microsoft®  Word if you have Microsoft 

Word 2007 to 2016 installed. Select templates by clicking on the Options icon and then 

Microsoft Word Settings. Templates are in the folders specified. You can use these, or 

create your own. If you create your own templates, click on the Browse button and browse to 

select your template files. More information is included in the section on ‘Printing with 

Microsoft Word’. 

Information regarding Standard Layouts and the Invoice Setup Wizard are included here. 

Information about ‘Customise Layouts’ and ‘Word’ are included under ‘Other Functions’ 

 

Standard Layouts 

To select a standard layout: 

1. Click on the Options icon and select Invoice Layout Settings. 

a. Click on the down arrow for Default Layout and select the layout you require. 

b. To include a Remittance Advice, click on the checkbox for Include Remittance Advice 

and Credit Card Options. 

c. You can upload your corporate logo by “browsing’ to a .bmp, .jpg or .gif file on your 

computer. For best results use a 339 x 154-pixel image. 

2. Click on the Options icon and select Print Settings 

a. Select whether to use your own pre-printed letterheads or to print your company details 

on your invoices. 

b. You can also change the type of font and font size you wish to use in your reports. To 

change the font, click on the Font down arrow to select one that is available on your 

system. 

c. You can also adjust your margins. 

3. Click on [Save] when you have finished. 

Note: If you change your standard layout, the new layout will only apply to customers added 

after the change. To use the new layout with existing customers, select to Modify Customer and 

change the standard layout selection in the customer details. 

 

 

Invoice Layout Wizard 

The Standard Layouts are designed to meet most business’s needs. However, if you need to 

change your layout further, you also have that opportunity. 

Click on ‘Tools’ in the menu, and then ‘Invoice Setup Wizard’. This will open the wizard to 

customize your layout. 

Step 1: is the ‘Invoice Template Layout’. You can choose to create a new layout in which case 

you need to type in a name for the template, or select an existing layout to modify. Click on 

[Next] to continue. 
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Step 2: Now we can begin to change the layout by selecting what to include. In this step, we can 

edit Company Details, Invoice Details, Customer Postal Address, Customer Delivery Address, 

Invoice Line Details, Invoice Totals and Extra Fields. 

Simply click on the [Edit] button for the fields you wish to edit. This will open another window 

that enables you to select which fields you want to appear on your invoice. In some cases, there 

will also be the opportunity to change the label that appears on the invoice as well. 

When you edit the ‘Invoice Line Details’ you will also have the option to have lines printed 

around the data fields. 

When you have finished editing each section, click on [Save] which will save the changes and 

return you to the main ‘Customize Layout’ screen. 

You will see a [Preview] button at the bottom of the window that will give you a preview of the 

changes you have made. However, note that changes must be saved before they will display on 

the preview. 

When you have finished editing the fields and labels, click on the [Next] button. 

Step 3: Select whether you wish to include a remittance advice and then click on [Next]. If you 

answered ‘No’ go to step 9. 

Step 4: Select your company details that you wish to appear on the remittance advice and then 

click [Next]. 

Step 5: Select the Customer Details you wish to appear on the remittance advice and click on 

[Next]. 

Step 6: Select the invoice details you wish to appear on the remittance advice and click [Next]. 

Step 7: Select whether you wish to give your customers the opportunity to pay you by direct 

bank deposit (electronic funds transfer) and if so, type in your bank details. Click on [Next]. 

Step 8: Select whether you accept payment by credit card and setup the details. Click [Next]. 

Step 9: enables you to upload your logo. The recommended size is 339 x 154 pixels. However, if 

your logo is a different size the program will resize it for you. 

Click on [Save-Finish] to complete your customized logo. 

To use this layout, return to Options > Invoice Layout Settings and select your new layout as 

‘Layout in use’. Click on [Save]. 

 

 

Sections (Tabs) in Invoice Manager 

There are four sub-sections of Invoice Manager. The Tabs are located under the main Program 

Tabs on the Side Panel. They are: Customers, Suppliers, Inventory and Reports. Each of these 

Tabs is outlined in sections of this user guide. 

 

Customers and Sales 

Note: Throughout this section we will refer to ‘Customers’. However, there is an option in 

‘Options’ to change that title if another such as ‘Clients’ or ‘Patients’ is more suitable. 

The Customers tab is located on the Side Panel. 

This consists of: 

Customer List: The Customer List is the main window of the Sales section of Invoice Manager 

and includes a list of your customers. 
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The Customer List can be sorted by Customer Code, Company Name, Contact Name or Phone 

by clicking on the column heading at the top of the list. 

A triangle to the right of the column name will indicate the sort order of the column: an ‘up’ 

triangle indicates ascending order, and a ‘down’ triangle descending order. 

To quickly and easily search for an existing customer, sort by Company Name and then type the 

first letter of the Company Name. The closest match will be highlighted in the list. 

Function Buttons: To the right of the Customer List are buttons for the common functions 

undertaken in the program. These are divided into groups: Functions, Information and 

Customers. 

Each function button performs a different task in the program. They allow you to add or edit 

invoices, adjustment notes, apply receipts and credit amounts. To use a function, select a 

customer by clicking on their name, and then click the function button desired. 

For example, if you need to edit a customer’s details, select the customer in the Customer List by 

clicking their name, and then click on the [Modify Customer] button. 

 

Add, Modify or Manage a Customer 

To add a new customer, click the [Add Customer] button. 

Record the customer’s details, and make sure a unique Customer Code is included. You can 

‘Tab’ through the fields, or press ‘Enter’. 

Click on the [Save] button to save and exit, or [Save & New] to add another customer. 

To avoid retyping the same information if your shipping/delivery address is the same as the 

mailing address, tick the checkbox next to Use Company Address. 

There are four extra fields that can be used for any extra information you require for this 

customer. To enable these extra fields, click the [Extra Fields] button, and a new window will 

appear. Record the details you require, and click [Save]. You can rename the title of these extra 

fields by positioning your mouse over the name and double clicking. A box will appear to 

change the title. 

Layouts: You can select a Default Layout for customer invoices and you can also select 

customised layouts for each customer. 

Once a customer is added, you can modify their details by selecting them from the list, then 

clicking the [Modify Customer] button. 

To hide a customer, click on the [Manage Customer] button. Tick the checkbox, next to the 

customer, in the [Hide] column, and click [Save]. A customer can only be hidden from the list if 

there has been no activity for that customer in the last 12 months (i.e. created invoices, 

outstanding payments, etc.). 

NOTE: The Customer Code used by the deleted customer cannot be re-used. However, you can 

change the Customer Code in the customer’s details before deleting. 

 

Show a Hidden Customer 

If you have hidden a customer, they can be restored or shown. 

Click on the [Manage Customer] tab, and click the [Hidden] option. 
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Customer Diary 

The Customer Diary allows you to record notes in relation to the employee. These are purely for 

your records, and do not affect any other part of the program. 

To add, view or delete entries in the Customer Diary, select the customer in the Customer List 

and then click on the [Customer Diary] button. 

A list of recorded notes is displayed together with the date. You can sort the list by clicking on 

the column headings. Clicking again will sort the list in reverse order. 

1. To add a new note, click on the [Add] button. 

2. Type in the note, with a maximum of 250 characters. 

3. Set the date for the note at the top. Today’s date will be set as default. 

4. Click on [Save] to record the note, or click [Cancel] to exit without saving. 

To edit a note, select the note in the list, and click on the [View/Edit] button. Make the changes, 

and click [Save] to save changes. 

To delete a note, select the note in the list, and click the [Delete] button. The note will be 

removed. 

To print diary notes, click on the [Preview] button to show a print preview. 

 

Customer Inquiry 

The Customer Inquiry page shows a history of transactions in your customer's account. This will 

include Finalised Invoices, Adjustment Notes and Money In. A transaction can be viewed by 

double-clicking on it. 

NOTE: Unfinalised Invoices and unassigned Adjustment Notes will not appear in the Customer 

Inquiry list of transactions. 

To print a selection of the Customer Inquiry transactions, click on the [Print Inquiry] button. 

Select the dates to include and click on [Print]. 

 

Change Decimal Points 

By default, Invoice Manager uses 2 decimal places for all Unit Price currency values. You can 

toggle between using 2 Decimals Format or Variable Decimal Format. Click on the Tools 

menu and select Change Decimal Points to toggle between the options. A message will appear 

to inform you of which format is now in use. 

 

Opening Balances (Customers) 

The Opening Balance is the amount the customer owes you before you create any more invoices 

in the program. 

If you already have customers with outstanding balances when you start to use Invoice Manager 

you will need to record sales invoices for the balance outstanding. This is particularly important 

if you issue statements. 

For the most accurate reporting, add the outstanding invoices. If those invoices have had Money 

In applied to them you will need to decide whether to record both invoice and receipt, or an 

invoice for just the balance outstanding, 
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If you just want to have an accurate opening balance for statements you can record one invoice 

for outstanding balance. (Make sure the invoice date is prior to any transaction in your first 

statement.) 

Also see ‘Sales’ Invoices’ 

 

Sales Invoices 

Sales Invoices are the bread and butter of your business, so to speak. For goods that you sell, or 

services you provide, a tax invoice is issued, and payment is expected from the customer. 

Invoice Manager helps you keep track of outstanding invoices and which customers owe you 

money. 

The Invoices page allows you to see what invoices you have for the selected customer and when 

they were created. It also shows the total of the invoice and the current amount owing. 

You can create new sales invoices and view/edit existing invoices from the buttons on the right. 

At the top are four options to filter the viewable list: This Month’s Customer Invoices, 

Outstanding Customer Invoices, All Customer Invoices and Show Quotations. Select the 

required function. 

 

Add a New Sales Invoice 

Select the customer from the Customer List. Click on the [Add Invoice] button. 

The top left corner displays the Customer Code and Company Name. Underneath this is the 

Invoice Number. The next numerical sequenced invoice number is generated, but can be 

changed e.g. to set a manual invoice number by typing the new number in the box. 

The Invoice Date displayed at the top of the next column defaults to today’s date per the 

computer, but you can change this as necessary. 

The Invoice Status or Invoice Options are then displayed, and the choices are: 

❖ Order/Invoice: A standard tax invoice or agreement for provision of goods & services 

❖ Quotation: Quote a customer for goods or services, expecting an order. When the quote is 

successful, the status can be changed to Invoice 

❖ Hold Open: Create an invoice but do not allow finalising just yet 

❖ Finalised: A tax invoice issued to a customer ready for payment (also referred to as ‘posted’ 

or ‘closed’, but does not necessarily mean ‘paid off’) 

The P.O. Number field can be used to reference a Purchase Order that may have been placed in 

relation to this invoice. 

If payment has been received at the same time the invoice is created, click in the Cash Invoice 

checkbox. When the invoice is finalised, a receipt will be applied automatically for the amount 

owing and for the same date as the invoice. 

NOTE: If using a Cash Invoice, you can set up automatic transfer to Cashflow Manager of the 

receipt. See ‘Cash Invoice Settings’ in ‘Options – Invoice Manager’. Alternatively, if you 

have a lot of Cash Invoices, you can select not to transfer each individual invoice to Cashflow 

Manager and just record the total at the end of the day or use ‘Transfers’ to batch receipts and 

transfer them as one entry. 

The Credit Limit and Current Balance are references to the credit limit you have established 

for the customer together with the current balance of their account, for ease of use. 

If there is a credit on the customer’s account this will be displayed. Click on the [Credit 

Amounts] button to apply the credit amount to the current invoice. 
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If Use Customer Types has been selected in Options, a Customer Type field and the Customer 

Type allocated to this customer in Add Customer/Modify Customer will display under the 

Current Balance. You can click on the down arrow and select a different Customer Type if 

required. To change the Customer Type permanently, click on [Modify Customer] next to the 

Customer List. The prices for items chosen from inventory will default to that mapped price list 

for that Customer Type. 

If Use Jobs Number has been selected in Options, a Job Number field will display under the 

Current Balance and Customer Type. The invoice can be assigned to a Job from the drop- 

down arrow, so you can allocate invoices to track specific jobs. 

 

Add Items to Your Sales Invoice 
 

Adding items to an invoice can be done in two ways. You can simply type in the details of the 

item to be included on the invoice, or you can choose from the Item Code or Description drop 

downs that list items recorded as Sell or Buy/Sell in Inventory. 

Note: Management Sales Reports designed to give you information to analyse your sales and 

purchases only include items that are listed in Inventory and require selection from the Inventory 

List to be included in these reports. 

Cashflow Manager GOLD can also track inventory on items that are purchased and sold. To use 

this feature, you must add inventory items to invoices through the Item Code or Description 

selections. 

On a Sales Invoice, only inventory items marked as Sell or Buy/Sell will appear in the list to 

choose from. If Inventory Tracking is enabled, these items will then be deducted from your item 

count. 

If you know the Item Code, start typing this into the Item Code field, and as the right code 

appears, press ‘Enter’. Alternatively, click on the drop-down arrow and choose the item from the 

inventory list. 

The item’s stored details will be pre-filled into the Description, Tax Type and Unit Price fields, 

which can be edited if required. Enter the quantity of items supplied, and press ‘Enter’. The next 

line will become available for more items. Continue filling in item details for your Sales Invoice, 

and press ‘Enter’ at the end of each line. 

If you simply type in a description, the tracked inventory will not automatically adjust the item 

count or be included in the Sales Reports. 

NOTE: The Description can be a maximum of 250 characters. If you wish to type more, go to 

the next line, and type the rest in the next description field. 

Each of the column widths can be resized. For example, if you wish the Description column to 

be wider, position your mouse cursor over the right side of the Description Column Header. 

Hold down your left mouse button and drag the column to the width you require, and then let go. 

The grey box at the left side of the invoice work area indicates the line you are working on as 

well as offering several other functions for editing the lines in the invoice. 

To access these functions, left-click on the grey box on the left side of the line. An arrow will 

appear to indicate the row is selected. Right-click to list the functions and then left-click on the 

function you require. The functions are: 

❖ Insert Blank Line – Insert a blank line above the currently selected line 

❖ Remove Line – Remove a line permanently (you will be prompted) 

❖ Move Line Up – Move the currently selected line above the preceding line 

❖ Move Line Down – Move the currently selected line below the following line 
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You can delete multiple lines at a time by holding down the ‘CTRL’ key and selecting each row 

for deletion. Then press the ‘DELETE’ key. You will be prompted if you wish to remove the 

selected lines permanently. 

There is also an option to add an additional column to your invoice. For example, some 

businesses create one invoice for transactions that span more than one day so the extra column 

can be used for the transaction date. To enable this extra column, click on the Options icon and 

select Advanced Preferences. 

 

Adding a Message to Your Sales Invoice 
 

The Message field is used for a brief note, usually such as “Thank you for your business” or 

“Terms 30 days”. It normally shows near the bottom of the invoice printout. To add a message, 

click in the box below the invoice items work area, and type your message. You can save this 

message in a list to add to other invoices by clicking on the green tick button. To use a 

previously saved message, click on the drop-down arrow and select the saved message from the 

list. The message can be up to 150 characters long. 

To delete an existing message, select the message and then click on the red ‘cross’ button. 

 

Extra Details 
 

In the bottom left corner of the Invoice page are some Extra Fields for information you may 

require including on the invoice. For example: a construction job’s building address, or more 

details for the job. The Extra Field titles can be changed by double-clicking on the title. A text 

box will appear to change the name. Press ‘Enter’ when done. The title of the Extra Field is 

global; therefore, all customers’ invoices will show the same Extra Fields titles. If using Extra 

Fields, you will need to add these fields to a Customised Layout, as they are not shown by 

default. See the section ‘Invoice Setup Wizard’ on how to add text boxes and turn them into 

data fields. 

 

Apply Discount 
 

Click on the Discount tab in the bottom left corner and type in the amount or rate of discount in 

the box. 

Choose either Percent (%) or Pound (£) and click on the [Apply Discount] button below. A 

line will be added to the invoice items showing the discount in the Line Total column as a 

negative as well as calculate the adjustment to the VAT for the items discounted. 

NOTE: The discount you add will be calculated from the invoice balance at the time the 

discount is added, so if you add more lines to the invoice and then another discount the original 

items will be discounted further. You can remove a discount line like any other invoice item line 

(i.e. select the row, click on the Delete key on your keyboard). 

 

Cash Invoices 

The Cash Invoice option allows you to quickly and easily finalise the invoice and process the 

receipt, and can be used with any customer. However, you may also want to establish a ‘Cash 

Customer’ for cash sales where you do not want to record the customer’s details. 

Select this as your customer each time you have such a cash sale and tick the Cash Invoice 

checkbox on the Invoice page. (Remember that VAT tax invoices greater than £1000 require the 

customer’s name and address or VAT on a valid tax invoice.) 

Process the Cash Invoice and click on the [Finalise] button. A receipt will be automatically 

applied to the invoice and the balance reduced to ‘£0.00’. 
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The process that follows depends on the Cash Invoice Settings set in Options. Click on the 

Tools menu, select Options and then Cash Invoice Settings. You can choose to transfer Cash 

Invoice receipts to Cashflow Manager in three ways: 

1. Always 

2. Never 

3. Ask me each time a Cash Invoice is Finalised 

If you choose Always or Ask me... to transfer the Cash Invoice Receipt to Cashflow Manager, 

make sure you also select the Cashflow Account and Receipt Column in which the amount will 

be recorded. 

If you process a lot of Cash Invoices you may wish to select Never and then use the Transfers 

function to transfer one entry to your Cashflow Money In Record for the total batch. You will 

also need to select ‘Use Transfers’ in Options > Advanced Preferences. 

A message to print a receipt, after a cash invoice is finalised, will be automatically generated if 

this option has been selected in Tools/Options/Cash Invoice Settings. 

 

Recurring Invoices 

If you have invoices that are repeated, or have similar item details, you can save them as a 

Recurring Invoice to save time preparing your Sales Invoices. 

First, create or open an invoice that has the relevant item details filled in. Save the invoice by 

clicking on the [Save] button. 

Click on the [Recurring] button (You cannot make a finalised invoice recurring). 

A window will appear prompting you to type in a description for the new Recurring Invoice. 

Click the [Add] button when done. 

To use a Recurring Invoice for a new invoice, add a new invoice, then click the [Recurring] 

button at the bottom of the New Invoice page, and click the Use Recurring Invoice tab. 

Select the description of the saved Recurring Invoice from the list, and click the [Use] button. 

The item details will be loaded into the current invoice. Then close this window, and save the 

new invoice. 

 

Finalise an Invoice 

‘Finalising an Invoice’ signifies it is ready to issue to the customer, no changes will be made, 

and to expect payment. In accountant terminology, it is often referred to as ‘Posting’ because it 

is when the invoice is finalised that it is ‘posted’ into the Debtors Ledger. In other words, it is at 

this point that the sale is made, and the customer becomes liable to pay. 

Similarly, in Invoice Manager an invoice is not treated as a sale and therefore not included in 

statements, sales reports, Aged Debtors or the Customer Inquiry until it is finalised. 

When preparing an invoice, you are given the option to Hold Open the invoice if you do not 

wish to finalise it, for example, if delivery has not been made prior to statement date. 

The invoice is treated as a draft (or ‘open’) until it is finalised. 

To finalise the invoice currently displayed, click on the [Finalise] button. 

Invoices can also be finalised all at once by clicking on the Finalise Invoices icon on the 

toolbar. This will open a window displaying all Sales Invoices whose status is Order/Invoice, 

but not any with status of Hold Open. Tick the checkboxes for the invoices to be finalised, and 

click the [Finalise] button. Or if you want to finalise all invoices, click the [Select All] button. 
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Amount Received 

Once the invoice is finalised, an [Amount Received] button will appear to record a deposit or 

part payment received. 

Click on the [Amount Received] button in the bottom right corner above the Balance Due field. 

An Amount Received window will appear to record the Receipt Reference, Receipt Date, 

Amount to Pay and transfer to Cashflow Manager. 

 

View or Edit an Invoice 

Select the customer from the Customer List and click the [Invoices] button. 

The Invoices page will list any created invoices for the selected customer. Options above filter 

the list, by This month’s, Outstanding, or All invoices. Normally it is set to show Outstanding 

Customer Invoices, and will show all Open (unfinalised) invoices and, when ticked, Quotations. 

Select an invoice from the list and click the [View/Edit] button, or double-click on the invoice. 

Any invoice / quote can be viewed to reprint or print a picking slip, but only open invoices can 

be edited. If an invoice is finalised, it will need to be unfinalised. See the section ‘Unfinalise an 

Invoice’ below. 

 

Print a Sales Invoice 

If the invoice is displayed, click the [Print] button. If not, open the invoice for viewing/editing 

as per section above. When the Print Preview appears, there are options to [Email], [Save As] a 

file, or [Print] it to the printer. Click the required button at the bottom. 

Other features when printing include: 

❖ Choosing a different customised layout (assuming you have more than one layout) and 

❖ Picking Slips (which does not show prices) 

For more information on printing and emailing reports, see the section on Reports in Functions 

Common to all Programs. 

 

Picking Slips, Packing Slips, Delivery Dockets 

You can print an invoice that does not show prices to use for picking inventory or as a despatch 

notice. Print the Picking Slip by clicking on the [Picking Slip] button. 

The layout for the Picking Slip can be customized if it needs to be adjusted to meet your needs. 

See the section Customise Layouts. 

You can also rename the title ‘Picking Slip’ e.g. ‘Packing Slip’ or ‘Delivery Docket’. Click on 

the Options icon and select Advanced Preferences. Type in the new Picking Slip Name and 

click [Save]. 

 

How to Correct Sales Invoice Mistakes 

NOTE: Please make a backup of your file before making changes. Extreme care should be used 

in fixing mistakes, as you do not want to compound the problem. We recommend that these 

options should only be used by, or under supervision of, business management. 

The most common mistakes are forgetting an item, putting the wrong price on an invoice, or 

creating an invoice under the wrong customer. These can be corrected, if the problem isn’t made 

worse by not understanding what is happening. If you are unsure, contact CARE Support for 

help. 
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The process of invoicing is sequential, and must be reversed if changes need to be made. 

❖ Sequential: An invoice is created then saved, finalised, then a receipt is added. 

❖ Reversal: To edit the invoice directly, remove the receipt, then unfinalise the invoice, 

make the changes, finalise, and then reapply the receipt if necessary. 

If changes need to be made to the invoice and it is not fully paid off, a Credit Note can be used to 

remove items or reduce the price. See the section ‘Credit Notes’. 

 

Unfinalise an Invoice 

An invoice can be ‘unfinalised’ only if it has not had a Receipt, Credit Amount or Credit 

Note applied to it. 

There are two options: 

One is to select the [View/Edit] the invoice and click on the [Unfinalise] button. 

You can also unfinalise an invoice from the Tools menu. This may be the better option of you 

need to remove a receipt first as this can also be done from the Tools menu. 

Click on the Tools menu, select Remove Receipt, and then Unfinalise Invoice. If a Credit Note 

needs to be removed, you will need to unassign and then click the [Delete] button. 

Select the Invoice Number from the drop-down arrow, and click the [Unfinalise] button. 

The invoice’s status will now be marked as open, and changes can be made. 

For more information, see the sections ‘Unassign/Delete a Credit Note’ and ‘Remove a 

Receipt’. 

 

Move an Invoice to another Customer 

If the invoice was created under the wrong customer, it can be reassigned to another customer, 

but only if the invoice does not have a Receipt or Credit Note applied to it. Remove these first if 

necessary. 

Click on the Tools menu and select Move Invoice to Another Customer. 

Under Select Invoice, choose the Invoice Number from the drop-down arrow. The Company 

Name the invoice is assigned to will also show. 

When selected, the invoice details will show underneath, including the Customer Code and 

Company Name. At the bottom, select the intended Customer from the drop-down arrow. 

Click the [Move] button. 

The invoice will now be located under the new Customer Code, and will be viewable in the 

Invoices section. 
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Credit Notes 

A Credit Note usually occurs when goods are returned for credit, or there is a dispute with a 

customer that results in a negotiated reduction in an account. 

In other words, a credit note applies a credit to an account. 

Select the customer from the Customer List, and click the [Credit Notes] button. 

The Credit Notes List has two views: This Month’s Credit Notes, and All Credit Notes to 

select from. You can also choose to include Overpayments in the list by ticking the Show 

Overpayments checkbox. 

To view an existing Credit Note, select it from the list and click the [View/Edit] button. You 

cannot edit a Credit Note that has been assigned. 

To add a new Credit Note, click the [New] button. 

The top left corner displays the Customer Code and Company Name. Underneath this is the 

Credit Note Number. The next numerical sequenced number is generated, but can be changed by 

typing the new number in the box. 

The Credit Date displayed at the top of the next column defaults to today’s date per the 

computer, but you can change this as necessary. 

Next is the Invoice Number. Click on the drop-down arrow to choose the Invoice Number the 

Credit Note will be assigned to. All Credit Notes must be assigned to an invoice. When chosen, 

the Invoice details will appear in the bottom left corner. 

Choose the Credit Type from the drop-down arrow. 

There are three Credit Types: 

1. Assign to Invoice is used to reduce the amount of an invoice that has a balance outstanding. 

If the amount of the Credit Note exceeds the balance outstanding, when you click on the 

[Assign] button a message will advise to select either the Write a Refund or Assign a 

Credit and click on the [Assign] button again. This will advise what to do with the excess 

balance. 

2. Write a Refund reduces the balance owing on an invoice and refunds the surplus to the 

customer. Note: the payment to the customer needs to be recorded manually in Cashflow 

Manager. 

3. Assign a Credit can be used the same way as a refund, but instead of refunding the surplus 

to the customer, you hold it in credit to apply to future or other outstanding invoices. In the 

Type drop-down box, choose the Assign a Credit option. 

You can allocate a Reference Number if required. Beneath that the Customer Type and Job 

Number details from the invoice will be displayed. 

Record the items that apply to the Credit Note. Note that if you are tracking inventory you will 

need to select the item using the Item Code or Description drop down selections to accurately 

adjust the inventory count. 

Record or select a message under the Items work area if required. 

When finished, click the [Save] button to save the Credit Note for later use, or click the [Assign] 

button to finalise and assign the Credit Note. 

Click on the [Print] button to print the Adjustment Note. You can also save as an Excel, PDF or 

rtf document or email the Credit Note. 

NOTE: If the amount of the Credit Note is less than or equal to the balance remaining on the 

selected invoice, the adjustment will be deducted from the invoice. If the amount of the Credit 

Note is greater than the balance remaining on the selected invoice, then the balance remaining on 
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the invoice will be reduced to £0.00. The surplus can either be refunded to the customer or added 

to the customer’s credit balance by selecting the appropriate Credit Type option. 

 

Unassign / Delete a Credit Note 

You can delete a Credit Note that has been saved but not assigned. A Credit Note that has been 

assigned to an invoice can be unassigned for editing or removal. 

To unassign and/or delete a Credit Note, click on the [Credit Notes] button next to the Customer 

List and click on the [Unassign] or [Delete] button as appropriate. (A Credit Note needs to be 

unassigned in order to delete it.) 

 

Money In 

Process a Receipt 

Select the customer from the Customer List, and click the [Money In] button. 

Record the Receipt Date. This defaults to today’s date per the computer but can be edited. 

Record a Reference Number if required. 

The Current Balance for the customer will display. 

Select from the Auto-Apply options. 

1. Earliest Date First is the default selection. While this is selected, when you enter the 

total amount received in the Amount Received box and press ‘Enter’, the receipt will be 

automatically applied to the oldest invoices first. 

2. Lowest Invoice Number First applies the receipt in sequence starting with the lowest 

invoice number. 

3. Don’t Use Auto Apply allows you to select the invoices yourself. 

To use either of the Auto-Apply options, select the option, record the receipt amount in the 

Amount Received box and press ‘Enter’. Alternatively, record the amounts next to each invoice 

listed in the grid in the Amount Received column. 

If this is the first receipt applied to an invoice, you have the option to apply a discount. Click the 

[Add Discount] button for the invoice, enter the amount, and choose whether it is a percentage 

of the total or a dollar amount. Click the [Apply Discount] button. 

To transfer the amounts received into a Cashflow Manager Account: 

1. Click in the Transfer to Cashflow Manager Checkbox. 

2. Select the Cashflow Manager Account in which to record the receipt 

3. Select the Banked or Not Banked option where applicable. 

4. If you want to combine into a single transaction, tick the Group as one entry checkbox 

5. Click the [Continue] button 

6. Allocate the amount(s) to the appropriate Allocation Column(s) 

7. Click the [Save] button. 

 

Remove a Money In Transaction 

The Remove Money In Transaction option allows you to remove a Receipt that has been 

applied in error. Click on the Tools menu and select Remove Money In Transaction. From the 

drop-down box, select the Receipt. Click the [Remove] button. 
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If the Money In transaction has resulted in a credit that has been applied to any invoices, the 

invoices will be listed and when you remove the Money In transaction, the credits will also be 

removed from those invoices. 

 

Apply Credit Amounts 

A Credit Amount can occur when a customer pays more than the balance of their outstanding 

invoices, or pays a deposit for an invoice that has not yet been prepared. 

When applying a receipt for more than the total of the invoice, the surplus is saved as a Credit. 

This can also happen when assigning an Credit Note to an invoice for greater than the amount 

owing. The surplus is added to the customer’s Credit Amount. 

To refund a credit balance or apply it to an invoice, click on the [Apply Credit Amounts] 

button on the Customer List page. 

Change the ‘Credit date’ as necessary. 

1. To apply the credit balance to an invoice, click on the down arrow next to the Invoice 

Selected box to display a list of the customers’ ‘Finalised’ invoices with outstanding 

balances. Select the required invoice. 

The details of the invoice will appear and the Credit to Apply will pre-fill with the amount 

of credit remaining or the ‘Balance Outstanding’ on the invoice. Edit the amount if 

necessary. 

Click on the [Save] button. 

2. To refund the credit, click on the [Refund] button rather than selecting an invoice. 

To transfer the receipt to Cashflow Manager: 

1. Click on the Transfer to Cashflow Manager Checkbox. 

2. Another field will appear to select the Cashflow Manager account in which to record 

the payment. 

3. Click on [Continue]. 

4. Allocate the amount to the appropriate Allocation Column 

5. Click on [Save]. 

Alternatively, a credit amount can be applied to an invoice at the time you create it. (Refer to 

‘Add a New Sales Invoice’) 

 

Remove Credit Amounts 

Credits can be removed from Invoices without the need to remove the Receipt that created the 

credit. 

Click Tools>Remove Credit. Select the credit amount by clicking in the checkbox, and click 

[Remove]. 

When a receipt is removed that created a credit, the credit amount is also removed. 

 

Statements 

A Statement summarises transaction activity and balances for each customer. Businesses that 

issue statements usually do so at the end of each month. 
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Many programs’ statements tend to list the age of the amount outstanding and classify these into 

30, 60, 90, >90-day amounts. As this signals to your customers that you expect delayed receipts, 

Invoice Manager does not do this. 

The standard statement includes a summary that displays Opening Balance + Net Transactions = 

Balance Due. 

An alternative would be to display this as Overdue + Current Transactions = Balance Due. To 

use this alternative, click on the Tools menu, select Customised Layouts and then Statement. 

Edit the text boxes accordingly. 

Prior to version 8, ‘processing statements’ was required to accurately track outstanding invoices 

and print customer statements. This is no longer required. All invoices, credit notes and receipts 

need to be processed and finalised, but there is no requirement to process statements. Simply 

click on the Reports tab and select the Statements Report. 

The Statement Period is now set each time a report is generated by the report dates chosen. 

There are choices, governed by Windows’ set time and date, to print the report for This Month, 

This Quarter, This Year, Last Month, Last Quarter or Last Year or for Custom Dates (select start 

and end period dates) 

There is an option to Exclude Nil Transactions that will exclude statements for any customers 

who have a zero balance and no transactions during the period, and to select the Statement Type. 

There is also an option to Exclude Nil Balances that will exclude statements that have a zero 

balance even though they may have had transactions during the period. 

Normal Statements show the Opening Balance for the period start date, and then separately lists 

receipts, invoice balances outstanding from prior periods, and current transactions to arrive at the 

Closing Balance. 

History Statements show the Opening Balance and then list all transactions for the selected 

period. 

Note: Any transactions for the Statement Period that are processed after you print the statements 

will affect the balances. So, it is important to ensure that all transactions for the period have been 

completed before printing statements. 

 

Print Statements 

To print Statements for your customers, click on the Reports tab, select the Statements Report 

from the list and click on the [Continue] button. 

Choose the options for the report as detailed in the above section. 

Click on the [Preview] or [Print] button as required. The Preview also allows you to email your 

statements or save as an Excel, PDF or rtf document. 

WARNING: If you choose to Email the statement to your customer, make sure you select that 

customer only. The program is not designed to “bulk” email. 

 

Reports (Customers and Sales) 

The Reports tab in the Invoice Manager section lists reports for Sales, Purchases and 

Inventory. 

 

Report Options - Sales 

Once a report is selected, there are options to select different parameters for the generation of the 

report. The Report Options listed in the following table are: 
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C – Customer selection. Choose either All Customers or Select Customers (opens a list of all 

customers to select from). 

D – Date Period. Choose a report date range from Last Month, Last Quarter, Last Year, This 

Month, This Quarter, This Year or Custom (select report start and end periods where 

appropriate). 

eD- End Date Only. Report relates to a specific time period and the only option is to select an 

end date for the report. 

E –Includes reports formatted especially for Microsoft Excel. 

F – Filter report. Report will show information based on filters e.g. Detailed or Summary, 

Include Invoice Manager balances, Single or Multiple Columns etc. 

T – Type of printout. Choice of print layout or specific print media. 

 

 

Types of Reports – Customers/Sales 

The following table summarises the reports available in the Invoice Sales (Customer) section. 

More information is included below for reports highlighted by an asterisk*. 
 

 

REPORT DESCRIPTION Report 

Options 

Activity Summary of sales and customer activity for the period. D 

Credit Notes Includes all Credit Notes for the period. Options are to print all 

or unassigned Credit Note as well as to include overpayments. 

C, D, F 

Credit Notes 

List 

Lists Credit Notes. D, T 

Aged Debtors Classifies outstanding balances according to age from the date 

of the finalised invoice. Net invoices are classified into ‘0-30’ 

days, ‘31-60’ days, ‘61-90’ days & ‘91+’ days from the 

selected Date. 

C, eD, E, 

F, T 

Customer List List of customers including customer name, contact, address, 

phone, fax and e-mail details. The Detailed list also includes 

the shipping address. Labels can also be printed. 

C, E, F, T 

VAT* The totals from the VAT types used in your invoices and your 

credit notes for the selected period 

D, F, T 

Order Status Lists invoices in the period with the selected Invoice Status. C, D, F, T 

Processed 

Receipts List 

Lists receipts (money in) processed C, D, T 

Receipts Actual receipts (money in) recorded C, D 

Sales by 

Customer 

Lists Total Sales including VAT, VAT and Total Sales 

excluding VAT per customer and also calculates the average 

sale per invoice and the average sale per customer based on the 

Total Sales Excluding VAT. The Detailed report also shows 

specific sales details per item. 

C, D, eD, 

F, T 

Sales by 

Product* 

Lists the item, unit price and number of items in the Inventory 

List sold to each customer, as well as the total sales. 

C, D, F, T 
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Sales Invoices Sales invoices created during the period. C, D, F 

Sales Invoices 

List 

A list of invoices created during the period with options to 

include All, Selected, Finalised, Unfinalised or Unprinted 

Invoices. You can also choose to include Quotations. 

C, D, F, T 

Statements Lists all transactions for each customer during the period and 

is combined with the opening balance to determine the 

customer’s outstanding balance. 

C, D, T 

 

Sales by Product: This report lists the item, unit price and number of items in the Inventory List 

sold to each customer, as well as the total sales. 

NOTE: Items need to be listed in Inventory to be included. However, prices are updated 

from invoices. 

You can choose to print either a Sales Report with Summary or Detailed formats or a Sales 

& Profit Report. 

You can also order by any of the column titles. For example, if you want to know which 

products give the highest level of sales, order by the ‘Total’ column. 

The Sales and Summary options list the item, the unit price, the number of products sold to 

each customer, and the total sales. (The Detailed option provides a list of volume sold and 

total for each customer who has purchased each product.) 

The Sales & Profit option provides an indication of the contribution each Inventory Item 

makes to the profitability of the business. For each item, it advises the number sold, Total, 

Average Sale Price, Unit Cost (as per the Inventory List), Profit per Unit and Total Profit. 

VAT: There are four choices for printing the VAT report: 

1. The Sales VAT Report is designed to match the Outputs section of the VAT Calculation 

Worksheet. It reports the totals from the VAT types used in your invoices and your credit 

notes for the selected period. 

2. The Sales VAT (Closing Balances) Report provides the same information as the Sales VAT 

Report but only includes closing balances at the selected date. 

3. The Sales and Purchases VAT Report provides the VAT Calculation Worksheet information 

for both sales and purchases. 

4. The Sales and Purchases VAT (Closing Balances) Report provides the VAT Calculation 

Worksheet information for both sales and purchases but only includes closing balances at the 

selected date. 
 

 

 
Suppliers 

Suppliers and Purchases 

 

When you click on the Suppliers tab in the Invoice section, the Supplier List will display. 

This consists of: 

Supplier List: The Supplier List is the main window of the Purchases section of Invoice 

Manager. 

The Supplier List can be sorted by Supplier Code, Supplier Name, Contact Name or Phone by 

clicking on the column heading at the top. 
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A triangle to the right of the column name will indicate the sort order of the column: an ‘up’ 

triangle indicates ascending order, and a ‘down’ triangle descending order. 

To quickly and easily search for an existing supplier, sort by Supplier Name and then type the 

first letter of the name. The closest match will be highlighted in the list. 

Function Buttons: To the right of the Supplier List are buttons for the common functions 

undertaken in the program. These are divided into groups: Functions, Information and 

Suppliers. 

Each function button performs a different task in the program. They allow you to add or edit 

purchase orders, purchase invoices, returns, apply payments and overpayments. To use a 

function, select a customer by clicking on their name, and then click the function button desired. 

For example, if you need to edit a supplier’s details, click on their name in the Supplier List and 

then click on the [Modify Supplier] button. 

 

Add, Modify or Manage a Supplier 

To add a new supplier, click the [Add Supplier] button. 

Record the supplier’s details, and make sure a unique Supplier Code is included. You can ‘Tab’ 

through the fields, or press ‘Enter’. 

Click the [Save] button at the bottom to save and exit the supplier’s details, or click [Save & 

New] to add another supplier. 

To avoid retyping the same information if the shipping/delivery address is the same as the 

mailing address, tick the checkbox next to Use Company Address. 

Four extra fields can be used for any extra information you require for this supplier. To enable 

these extra fields, click the [Extra Fields] button, and a new window will appear. Record the 

details you require, and click [Save]. You can rename the title of these extra fields by 

positioning your mouse over the name and double clicking. A box will appear to change the title. 

Each supplier can also make use of customised layouts. Click the [Customised Layouts] button 

to choose which layouts will be used for printing. You can change the layout used for the 

Purchase Order, Purchase Invoice and Return printouts. 

Once a supplier is added, you can modify their details by selecting them from the list, then 

clicking the [Modify Supplier] button. 

To hide a supplier, click on the [Manage Supplier] button. Tick the checkbox, next to the 

supplier, in the [Hide] column, and click [Save]. A supplier can only be removed from the list if 

there has been no activity for that supplier in the last 12 months (i.e. created invoices, 

outstanding payments, etc.). 

NOTE: The Supplier Code used by the deleted supplier cannot be re-used. However, you can 

change the Supplier Code in the supplier’s details before deleting. 

 

Restore a Hidden Supplier 

If you have hidden a Supplier, they can be restored, or shown. 

Click on the [Manage Supplier] tab, and click the [Hidden] option. 

 

Supplier Diary 

The Supplier Diary allows you to record notes in relation to the employee. These are purely for 

your records, and do not affect any other part of the program. 
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To add, view or delete entries in the Supplier Diary, select the supplier in the Supplier List and 

then click on the [Supplier Diary] button. 

A list of recorded notes is displayed together with the date. You can sort the list by clicking on 

the column headings. Clicking again will sort the list in reverse order. 

1. To add a new note, click on the [Add] button. 

2. Type in the note, with a maximum of 250 characters. 

3. Set the date for the note at the top. Today’s date will be set as default. 

4. Click on [Save] to record the note, or click [Cancel] to exit without saving. 

To edit a note, select the note in the list, and click on the [View/Edit] button. Make the changes, 

and click [Save] to save changes. 

To delete a note, select the note in the list, and click the [Delete] button. The note will be 

removed. 

To print diary notes, click on the [Preview] button to show a print preview. 

 

Supplier Inquiry 

The Supplier Inquiry page shows a history of transactions in your supplier's account. A 

transaction can be viewed by double-clicking on it. 

You can select to view Financial Transactions Only, and All Transactions. Financial 

Transactions Only will not display Purchase Orders. 

To print a selection of the Supplier Inquiry transactions, click on the [Print Inquiry] button. 

Select the dates to include and click on [Print]. 

 

Purchase Orders 

Purchase Orders are used to order goods from your suppliers. The Purchase Orders page allows 

you to see what orders you have for the selected supplier and when they were created. You can 

create new Purchase Orders and view/edit existing orders from here. At the top are two options 

for viewing: This Month’s Purchase Orders, and All Purchase Orders. 

 

Add a New Purchase Order 

To create a Purchase Order, select the Supplier in the Supplier List and click on the [Purchase 

Orders] button. Then click on the [New] button to the right of the Purchase Orders list. 

The top left corner displays the Supplier’s Details and the Purchase Order Number. The next 

numerical sequenced number is generated but can be changed e.g. to set a manual Purchase 

Order Number by typing the new number in the box. 

Record a Purchase Order Date and a Reference Number if required. 

Click the [Save] button. 

Print the Purchase Order by clicking on the [Print] button. 

To close the page, click the [Cancel] Button. However, click on [Save] first to save the Purchase 

Order before closing. 

Adding items to your Purchase Order is the same as preparing an invoice. However, the 

Item Code column will only list the inventory items marked as Buy or Buy/Sell 

See Add Items to Your Sales Invoice and Add a Message to Your Sales Invoice in the 

Customers and Sales for more information. 
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Purchase Invoices 

Purchase Invoices are generally recorded when you have received the goods and have an invoice 

from your supplier. This enables you to keep track of payments you owe to your suppliers. It is 

also used for inventory control as Purchase Invoice items update your inventory list, and 

therefore increase the number of items on hand. 

Select the supplier from the Supplier List and click on [Purchase Invoices]. Existing purchase 

invoices will be displayed according to the filter selection of: This Month’s Purchase Invoices, 

Outstanding Purchase Invoices and All Purchase Invoices. 

 

Add a New Purchase Invoice 

Select the supplier from the Supplier List. Click on the [Purchase Invoices] button and then 

click on the [New] button. 

The top left corner displays the Supplier’s Details and the Purchase Invoice Number. The next 

numerical sequenced number is generated but can be changed e.g. to set a manual Purchase 

Invoice Number by typing the new number in the box. 

The Invoice Date defaults to today’s date per the computer. Change this to reflect the date on 

the supplier’s invoice. 

The Payment Terms pre-fill from the information stored in your Supplier’s Details. You can 

type in amended payment terms if this invoice is different to the normal terms offered by this 

supplier. 

The Due Date is automatically calculated from the date of the invoice and the payment terms. 

This can be changed by clicking the drop-down arrow next to the date. 

The Reference Number can be used to record the invoice number on your supplier's invoice. 

If this Purchase Invoice relates to a previously saved Purchase Order for the same supplier, you 

can load in the item details from the Purchase Order. Click on the drop-down arrow and choose 

the P.O. Number from the list. Then click the [Load P.O.] button to load the order’s item details 

into your invoice. You can then make any modifications to it to coincide with the invoice 

supplied with the goods. 

Click the [Save] button. 

When the invoice is complete, click on the [Lock] button to lock the invoice to stop unwanted 

editing. 

Click on the [Print] button if you wish to print the Purchase Invoice. 

To close the page, click the [Cancel] Button. However, click on [Save] first to save the Purchase 

Invoice before closing. 

 

Apply Discount 
 

Type in the amount or rate of discount in the ‘Apply Discount’ box. 

Choose either Percent (%) or (Pound £) and click on the [Apply Discount] button. A line will 

be added to the invoice items showing the discount in the Line Total column as a negative as 

well as calculate the adjustment to the VAT for the items discounted. 

Adding items to your Purchase Order is the same as preparing an invoice. However, the 

Item Code column will only list the inventory items marked as Buy or Buy/Sell. 

See Add Items to Your Sales Invoice and Add a Message to Your Sales Invoice in the 

Customers and Sales for more information. 
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NOTE: The discount will be calculated from the invoice balance at the time the discount is 

applied, so if you add more lines to the invoice and then apply another discount, the original 

items will be discounted further. You can remove a discount line like any other invoice item line 

(i.e. select the row, click on the Delete key on your keyboard). 

 

Recurring Purchase Invoices 

If you have invoices that are repeated, or have similar item details, you can save them as a 

Recurring Invoice to save time preparing your Sales Invoices. 

First, create or open an invoice that has the relevant item details filled in. Save the invoice by 

clicking on the [Save] button. 

Click on the [Recurring] button (You cannot make a finalised invoice recurring). 

A window will appear prompting you to type in a description for the new Recurring Invoice. 

Click the [Add] button when done. 

To use a Recurring Invoice for a new invoice, add a new invoice, then click the [Recurring] 

button at the bottom of the New Invoice page, and click the Use Recurring Invoice tab. 

Select the description of the saved Recurring Invoice from the list, and click the [Use] button. 

The item details will be loaded into the current invoice. Then close this window, and save the 

new invoice. 

 

Unlock a Purchase Invoice 

If you have locked an invoice, an [Unlock] button will appear on the Purchase Invoice window. 

Click on the [Unlock] button to unlock it and make changes. 

 

Opening Balances (Suppliers) 

If you already have suppliers with outstanding balances when you start to use Invoice Manager 

you will need to record the balances for accurate reporting. 

The most accurate way is to record each invoice that has a balance outstanding. As a shortcut, 

you may wish to record one invoice for the Opening Balance, so you can apply payments to that 

invoice. 

 

Returns 

Process a Return 

Returns apply when goods you have purchased are returned to the Supplier. To process a Return, 

select the supplier from the Supplier List and click the [Returns] button. 

Click on the [New] button. 

The top left corner displays the supplier’s details and the Return Code. The number will be 

automatically generated based on the next available number. You can change this number if you 

wish, if there is no other saved Return with the same number. 

Record the date you returned the goods. 

Select the Purchase Invoice No. that the returned item applies to using the drop-down arrow. 

The Purchase Invoice details are then displayed, including Invoice Number, Date, Total and 

Amount Owing. 



108  

Select the Return Type, either a ‘Credit’ when you are expecting a credit to your account or 

‘Refund’ if the value of the return exceeds the outstanding amount on the invoice. 

You can record a Reference Number for the return, for example, if the supplier issues an RA 

(Return Authorisation) consignment. 

Record the item(s) being returned with their tax, price and quantity details. If you wish to 

include an explanation of the return, use the description field to type in the details. This can be 

up to 250 characters. 

You can add a shorter message at the bottom, but keep this under 150 characters. 

The [Save] button will save the Return but not assign it. When you are ready to assign it the 

selected invoice, click the [Assign] button. 

A credit will be applied to your invoice and then a credit or refund will be recorded depending 

on the Return Type selected. When you select Refund the amount of the refund will be included 

in the Supplier Inquiry. However, you will need to manually record the refund in Cashflow 

Manager. 

Note: When you click the [Assign] button the Return will be locked from further editing. 

 

Unlock / Unassign a Return 

If changes need to be made to an Assigned Return, you can unassign it, make the changes, and 

then re-assign it again. 

Open the Return from either the Supplier’s Inquiry (by double-clicking the Return), or open the 

Returns List and View/Edit the required Return. 

Click on the [Unassign] button and the Return will be available to edit. 

Make sure you assign it again once editing is completed. 

 

Money Out 

Process a Payment 

Open the Money Out section by clicking on the [Money Out] button to the right of the Supplier 

List. This will list all the Purchase Invoices waiting to be paid for all suppliers. 

The Payment Date will automatically have today’s date per the computer, but you can change 

this to the actual date the amounts are paid. 

The list of unpaid invoices can be filtered by the Display Options drop-down box. Selection can 

be Show This Month’s Invoices, Show Overdue Invoices or Show All Outstanding Invoices. 

The Select Supplier option allows you to select an Individual Supplier or All Suppliers. 

Record the amounts in this Payment under Amount To Pay next to each invoice. You can also 

select Payment options at the top, from the following options: 

❖ Pay All will record the Amount to Pay column with the total amount owing for each 

invoice listed. 

❖ Pay Overdue will only update the Amount to Pay column with amounts for the overdue 

invoices only. 

❖ Clear All will clear all the amounts in the Amount to Pay column. 

To transfer the payment to Cashflow Manager: 

1. Tick the Transfer to Cashflow Manager Checkbox. 

2. Select the Cashflow Manager account in which to record the payment. 
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3. Select the Column to allocate the payment. 

4. To record the payment on a single line, click in the Group as one entry checkbox. 

5. Click on the [Continue] button. 

6. Allocate the payment to the appropriate allocation column(s), if not already selected 

Click on the [Save] button. Each invoice being paid off will be assigned a separate Payment 

Number so that if a Payment needs to be removed in the future, it won’t affect other invoices that 

were paid at the same time. 

 

Remove a Money Out Transaction 

1. Select the Supplier and click on the [Supplier Inquiry] button to ascertain the Payment 

Number of the payment to be removed. 

2. Click on the Tools menu and select Remove Money Out Transaction. 

3. Select the Payment Number from the drop-down box and click the [Remove] button. 

4. A message informing you the payment has been deleted. If you had entered this payment 

into Cashflow Manager, you will need to manually remove it from Money Out. 

 

Apply Overpayments 

An overpayment may occur if you pay more than the balance of an invoice. The overpayment 

amount will be saved as credit with the Supplier, to be used to pay off another invoice. 

To apply the overpayment to another invoice, select the supplier in the Supplier List and click on 

the [Apply Overpayment] button. 

1. Change the date as necessary. 

2. Click on the drop-down arrow next to the Invoice Selected box to display a list of the 

supplier’s invoices with outstanding balances. Select the required invoice. 

The invoice details will display and the Credit to Apply will pre-fill with the amount of 

credit remaining or the ‘Balance Outstanding’ on the invoice. Edit the amount if necessary. 

Click on the [Save] button. 

3. If the credit is refunded to you, click on the [Refund] button rather than selecting an invoice. 

To transfer the receipt to Cashflow Manager: 

1. Tick the Transfer to Cashflow Manager Checkbox. 

2. A field will appear to select the Cashflow Manager account for recording the payment. 

3. Click on the [Continue] button. 

4. Allocate the amount to the appropriate allocation column. 

5. Click on the [Save] button. 

 

 

Remove an Overpayment 

Overpayments can be removed from Invoices without the need to remove the payment that 

created the overpayment/credit. 

To remove an overpayment, click on Tools/Remove Overpayment. Select the overpayment by 

clicking in the checkbox, and click [Remove]. 
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Reports (Suppliers and Purchases) 

The Reports tab in the Invoice Manager section lists reports for Sales, Purchases and 

Inventory. 

 

Report Options - Purchases 

Once a report is selected, there are options to select different parameters for the generation of the 

report. The Report Options listed in the following table are: 

D – Date Period. Choose a report date range from Last Month, Last Quarter, Last Year, This 

Month, This Quarter, This Year or Custom (select report start and end periods where 

appropriate). 

eD- End Date Only. Report relates to a specific period and the only option is to select an end 

date for the report. 

E – Includes reports formatted especially for Microsoft Excel. 

F – Filter report. Report will show information based on filters e.g. Detailed or Summary, 

Include Invoice Manager balances, Single or Multiple Columns etc. 

S – Supplier selection. Choose either All Suppliers or Select Suppliers (open a list of all 

suppliers to select from). 

T – Type of printout. Choice of print layout or specific print media. 

 

 

Types of Reports – Suppliers/Purchases 

The following table summarises the reports available in the Invoice Purchases (Suppliers) 

section. More information is included below for reports highlighted by an asterisk*. 
 

 

REPORT DESCRIPTION Report 

Options 

Activity Summary of purchases and supplier activity for the period. D 

Aged 

Creditors 

Classifies outstanding balances according to age from the 

date of the finalised invoice. Net invoices are classified into 

‘0-30’ days, ‘31-60’ days, ‘61-90’ days & ‘91+’ days from 

the selected Date. 

eD, E, F, T 

VAT* The totals from the VAT types used in your invoices and 

your returns for the selected period 

D, F, T 

Processed 

Payments 

List 

Lists all payments (money out) applied to invoices S, D, T 

Purchase 

Invoices 

Invoices created during the period with options to include 

All, Outstanding or Unprinted Invoices. 

S, D, F, T 

Purchase 

Orders 

Purchase orders created. S, D, F 
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Purchases by 

Item 

Lists the item, unit price and number of all or selected items 

in the Inventory List purchased from each supplier together 

with the total purchases 

D, E, F, T 

Purchases by 

Supplier 

Invoices recorded for each supplier. Also has choices for 

sorting the information. 

S, D, F, T 

Returns Documentation to accompany your returns S, D, F 

Supplier 

Balance 

Lists the balance owed to suppliers. The detailed report also 

includes the outstanding invoices. 

S, E, F, T 

Supplier List The summarised supplier list provides a list of suppliers 

including supplier name, contact, address, phone, and fax 

details. The detailed list also includes the second phone, e- 

mail and terms. 

S, E, F, T 

 

VAT: 

❖ The Purchases VAT report is designed to match the ‘Inputs’ section of the VAT Worksheet. 

It reports the totals from the VAT ‘types’ used in your invoices and your credit notes. 

Section 1 calculates the totals from your Supplier Invoices. 

Section 2 calculates the total from your Returns. 

Section 3 provides adjusted totals 

❖ The Sales and Purchases VAT Report provides the VAT Calculation Worksheet 

information for both sales and purchases. 

❖ These reports are also available as ‘Closing Balance’ reports providing the same information 

as the primary reports but only including closing balances at the selected date. This will 

provide you with the closing balance information to combine with your Cashflow Manager 

VAT Report. 
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Reverse VAT Invoice Manager 
 

How to record Reverse VAT Invoices in Invoice Manager 
Switching on reverse VAT functionality on invoices 

Open Invoice Manager Options.  

Select Advanced preferences and tick the option ‘Use Domestic Reverse VAT Charge’. 

Click Save. 

 
When this option is ticked Customer and Supplier invoices will show a check box to ‘Apply Domestic Reverse VAT’ 

 
If not ticked balance due on the invoice will include VAT. 

If ticked balance due on the invoice will exclude VAT. 
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Reverse VAT Customer Invoices. 
When generating a Customer invoice that attracts Domestic Reverse VAT, 

1. Add items to your invoice. 

2. Tick box to ‘Apply Domestic Reverse VAT’, this will change Balance Due to exclude VAT. 

3. Click ‘Save’ 

4. Click ‘Finalise’ 

 
When printing Reverse VAT invoices, a note is automatically inserted showing that Reverse Charge applies, and the 

customer is to pay the VAT to the HMRC. 

 
 

 

 

 

 

 

 

 

Transferring reverse VAT customer invoices to Cashflow.  

1. Enter Receipt Date. 

2. Enter Amount received. 

3. Tick Transfer to Cashflow. 

4. Select the column setup for Reverse VAT receipts (Tax type must be exempt). 
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5. Click Save. 

 
 

 

 

 

 

Reverse VAT Supplier Invoices. 
 

When generating a Customer invoice that attracts Domestic Reverse VAT, 

6. Add items to your invoice. 

7. Tick box to ‘Apply Domestic Reverse VAT’, this will change Balance Due to exclude VAT. 

8. Click ‘Save’ 

9. Click ‘Lock’ 
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When printing Reverse VAT invoices, a note is automatically inserted showing that Reverse Charge applies, and the 

customer is to pay the VAT to the HMRC. 

 

 
 

 

 

 

 

 

 

Transferring reverse VAT supplier invoices to Cashflow.  

1. Enter Payment Date. 

2. Enter Amount to pay. 

3. Tick Transfer to Cashflow. 

4. Select column for transfer. (Must have a tax type of VAT). 
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5. Edit the amount to the total of the Reverse VAT invoice. (The amount including VAT) and press ‘Enter’. 

6. Allocate the negative amount to the ‘Reverse VAT Balancer’ column you setup with a Tax type of ‘Outside’. 

7. Click Save. 

 
8. After transferring the record to Cashflow remember to Add the Domestic Reverse VAT record. 

 

 

Inventory 

Inventory Items make it easy to prepare your invoices and provide you with management 

information to help run your business. 

The program allows you to list Sell Items for use in Sales Invoices, manage Sell Prices, and 

Import and Export Inventory data. 

It also includes extra features such as Supplier, Category, Buy Items, Sell/Buy Items, Reorder 

Levels and Quantities, automatically adjusted On Hand values and track inventory on items that 

are bought and sold. 

When you click on the Inventory tab in the Invoice section, the Inventory List will display. 
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This consists of: 

Inventory List: The Inventory List lists your inventory together with ‘summary’ information 

about each item. Generally, all items will be listed, but you can select to just see Buy Items, Sell 

Items or Sell/Buy Items by selecting that option on the top left of your screen. 

The Inventory List can be sorted by any of the columns by clicking on the column heading at the 

top of the list. 

A triangle to the right of the column name will indicate the sort order of the column: an ‘up’ 

triangle indicates ascending order, and a ‘down’ triangle descending order. 
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To quickly and easily search for an inventory item, sort by Description and then type the first 

few letters of the Description. The closest match will be highlighted in the list. 

Function Buttons: To the right of the Inventory List are buttons for the common functions 

undertaken in the program. These are divided into groups: Items and Inventory. 

Each function button performs a different task in the program. They allow you to add, edit or 

delete items as well as track inventory, modify prices and import inventory items. 

 

Inventory Items 

The Inventory consists of Items. Items make it easy to create all sorts of invoices, orders and 

adjustments. An Item can be: 

• A physical item that you buy and sell. 

• A physical item you buy. For example: you may buy items that are incorporated as 

components into a manufactured product. 

• A physical item you sell. For example: a manufactured product. 

• A service item that you record in the inventory section, so you have standard 

descriptions and prices to make invoicing easier. 

‘Labour’ is an example of a ‘service’ item. 

Another example is the standard descriptions that some businesses have for numerous 

services that make up an invoice. These can be recorded as inventory items and selected 

when the invoice is being created. 

You can also track physical inventory items that are bought and sold so that you know the 

number and value of items in stock. 

 

Track Inventory Overview 

You can track inventory items that are bought and sold so that you know the number and value 

of items in stock. 

Not all inventory items are tracked. Only items that are Buy/Sell can be, and only those where 

you select to track inventory in the Add Inventory or Modify Inventory functions will be tracked. 

When you first commence to track an inventory item you need to record the quantity on hand 

(opening quantity) and the opening value of that item. 

Thereafter, transactions affecting that item are tracked as follows. 

1. Supplier Transactions 

a. Items in purchase invoices will increase Inventory on Hand 

b. Returns will decrease Inventory on Hand 

2. Customer Transactions 

a. Items in sales invoices will decrease Inventory on Hand 

b. Credit Notes will increase Inventory on Hand 

Then there is the unknown. The Inventory on Hand may change because of pilferage, 

breakage, or other reasons. These require manual adjustments which are performed in 

[Modify Item] for individual items, or by using the [Track Inventory] button on the 

Inventory List page. 
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Add a New Item 

To add a new item to the inventory, click the [Add Item] button. The New Inventory Item 

window will appear. 

NOTE ON PRICING AND VAT: The values you enter for price depends on whether you have 

chosen for Invoice Manager to use VAT Inclusive or VAT Exclusive prices. VAT Exclusive 

means the program will add VAT to any values you enter. 

1. Select whether the item is one that you Sell Only (including physical and service items), one 

that you Buy Only, or one that you both sell and buy (Sell/Buy). 

2. Select the Category that applies to the item (refer to Maintain & Assign Categories) 

3. Sell Details: Sell Details are only active if Sell Only or Sell/Buy item types are selected. 

a. Type in a unique Sell Code for the product. (If you type in a code that already exists 

you will receive a message asking you for a new code when you click on [Save].) 

b. Record the description (up to 250 characters) that you want to generally appear on your 

invoices in the Sell Description box. 

c. Select the Sell Tax Code to allocate the correct VAT to the product. Note that the 

Description, Sell Tax Code and Sell Price can be changed for individual invoices 

where the standard option does not apply. 

d. Record the Sell Price. 

i. If you use VAT Exclusive Prices, the Sell Price would be excluding VAT. If you 

have selected to use VAT Inclusive Calculations, then record the VAT Inclusive Sell 

Price. 

ii. If you are using different Customer Types, record the Sell Price for each Customer 

Type. 

Note: There is no need to record a price for a ‘Service Item’ that will form part of a 

composite list of items with one overall price at the end of the list. 

4. Buy Details 

a. If you have selected Buy/Sell, as you record your ‘Sell’ information the Buy Code, Buy 

Description and Buy Tax Code duplicate what has been entered. Change these as 

required. For example, the Buy Code should match the Item Number of your main 

supplier. 

b. Record the current Buy Price. 

c. Record the Supplier Code. This is not mandatory as sometimes the same item may be 

purchased from more than one supplier. However, selecting the Supplier Code will 

match the Buy Code to a Supplier to make it easier when you are creating Purchase 

Orders and recording invoices from suppliers. 

5. Quantities 

Quantities only apply if you want to track inventory levels for an item. For such items the 

opening quantity and value needs to be recorded for accurate reporting. 

a. To track inventory levels on an item, click on the Track Inventory? Checkbox. 

b. Click on the [Opening Inventory] button. 

i. Record the Initial Value Date. This is the date from which you are commencing to 

track inventory. See ‘Inventory Tracking’ for more details. 

ii. Record the Initial Quantity on hand for this item. 

iii. Record either the Average Cost per Item or the Total Value of Opening Inventory. 

(The alternate field will calculate for you.) 
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iv. Click [Close]. 

c. Record the Reorder Level for this item if you have one. 

d. Record the standard Reorder Quantity for this item. 

6. Click on [Save] to save and exit or [Save & New] to save this item and add another. 

 

 

Modify an Item 

To modify an item’s details, including adjusting stock levels and pricing, select the item from the 

Inventory List and click the [Modify Item] button. 

The Quantities section now has a [Current Inventory] button instead of [Opening Inventory] 

as well as On Hand information for any items that are tracked. Sometimes your inventory will 

require manual adjustment, e.g. because of loss, theft or breakage. You can adjust the amount 

shown by clicking on the [Adjust] button, and entering the amount in the box provided. 

The Current Inventory Value summarises the quantity on hand and value of inventory on hand at 

any time. It will include the Opening Inventory plus any transactions that have occurred since 

the Opening Inventory date. Click [Close] to return to the Inventory Item. 

To start tracking an inventory item, click on the Track Inventory checkbox. Click on the 

[Current Inventory] button, then on [Opening Inventory] and record the Opening Quantity 

and Value. Click on [Close] to return to the Current Inventory Value and [Close] again to 

return to the Edit Inventory Item page. 

Make the required changes, and click the [Save] button, or click the [Cancel] button to exit 

without saving changes. The Sell and/or Buy Code must still be unique. 

 

Delete an Item 

Select the item from the list, and click the [Delete Item] button. You will be prompted if you are 

sure you wish to delete the item, click [Yes] to do so. The item and all its details, including stock 

levels will be permanently deleted. This will not affect previously saved invoices. 

 

 

Categories 

Inventory Items can be assigned to a Category to give flexibility in reporting, price changes etc. 

 

Manage Categories 

To add a new category, click on the [Manage Categories] tab on the main Inventory List screen. 

The ‘Add’ option will automatically be selected. Type in the category name and press [Save]. 

To edit the name of an existing category, click on the [Manage Categories] tab. Select the 

‘Edit’ option, choose the category from the drop-down menu, edit the name, and click [Save]. 

To delete a category, click on the [Manage Categories] tab. Select the ‘Delete’ option, choose 

the category from the drop-down menu, and click [Delete]. 

 

Assign Categories 

You can assign a category to an individual item by selecting a category from the “Category” 

drop-down menu when adding or modifying the item. 
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To assign categories to multiple items, click on the [Assign Categories] button on the main 

Inventory List screen. 

The inventory items for all Suppliers are loaded by default. You can filter the list by using the 

Select Supplier drop-down menu. Tick the checkbox next to the Supplier(s), and select the 

category from the Category to Assign dropdown list. To save the selections, click the [Assign] 

button. 

The Supplier & Category names can be seen on the Inventory List screen. 

 

 

Modify Prices 

1. Individual Items 

Select the item from the Inventory List and click on the [Modify Item] button. Change the price 

and click [Save]. 

2. Multiple Items 

To modify the Sell or Buy prices for multiple items marked as Sell, Buy, or Sell/Buy, click the 

[Modify Prices] button to the right of the Inventory List. 

This will display the list of items (which can be sorted by clicking on the column headers) 

together with the Sell/Buy Code, Sell/Buy Description, Supplier, Category, Sell/Buy Price 

(including prices for Customer Types you have established) and the date last modified. 

Click on the price you wish to change and record the new price. 

To decrease the price, type in a negative amount. If this occurs, the price will not be changed if 

the result is less than zero. There will be no modifications to zero prices that are loaded. 

If you wish to modify all prices at once, ensure you have a backup and then click on the [Modify 

All] tab at the bottom of the screen. 

1. Select the prices you wish to modify, by clicking in the appropriate checkbox. 

2. Select the type of price change, by clicking on the drop-down menu and selecting 

Percent or Pound. 

3. Type the amount of the change. (Type in as a negative if prices are being decreased.) 

4. Click [OK]. 

Click on the [Save] button when you have finished. In fact, we would recommend to periodically 

click the [Save] button to save along the way. Then click on the [Cancel] button to close the 

page and return to the Inventory list. 

 

 

Count Inventory Items (Stock-take) 

An Inventory Count (or Stock-take) is a count of your inventory to ensure that the physical count 

agrees with your accounting records. 

Make sure all Invoices, Credit Notes and Returns are processed before counting your stock to 

ensure that your Adjusted Inventory is accurate. 

Before beginning, it is recommended to back up your data file. 

Click on the [Track Inventory] button. 

Click on the [Print] button to print an ‘Inventory Count’ report that lists tracked items ready 

for physical counting. The ‘On Hand’ quantity on the report will be the quantity per your records 

at that time. 

Count the actual items in stock and record the amount on the ‘Inventory Count’ report printout. 
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NOTE: You can exit from the Track Inventory page while the count is being conducted but the 

‘On Hand’ quantity will change if you record an Invoice, Credit Note or Return prior to 

recording the count. It is therefore advisable not to process Invoices, Credit Notes or Returns 

while an Inventory Count is being conducted. If you do, the changes need to be manually 

accounted for in the count. 

Once the count is complete, enter the counted quantities into the Count column for each item. 

To carry out the adjustment, click on the [Adjust Inventory] button (make sure all invoices that 

affect your inventory up to and including the Count Date have been recorded first). The On 

Hand values will be updated to reflect the quantity entered into the Count column. 
If you need to exit this page before adjusting amounts, click the [Save] button to save the Count 

entries, but not adjust the On-Hand amounts just yet. 

 

 

Reports (Inventory) 

The Reports tab in the Invoice Manager section lists reports for Sales, Purchases and 

Inventory. 

 

Report Options - Inventory 

Once a report is selected, there are options to select different parameters for the generation of the 

report. The Report Options listed in the following table are: 

D – Date Period. Choose a report date range from Last Month, Last Quarter, Last Year, This 

Month, This Quarter, This Year or Custom (select report start and end periods where 

appropriate). 

eD- End Date Only. Report relates to a specific period and the only option is to select an end 

date for the report. 

E –Includes reports formatted especially for Microsoft Excel. 

F – Filter report. Report will show information based on filters e.g. Detailed or Summary, 

Include Invoice Manager balances, Single or Multiple Columns etc. 

I – Item selection. Choose either All Items or Select Items (open a list of all items to select 

from). 

T – Type of printout. Choice of print layout or specific print media. 

 

 

Types of Reports – Inventory 

The following table summarises the reports available in the Invoice Purchases (Suppliers) 

section. More information is included below for reports highlighted by an asterisk*. 
 

 

 
 

REPORT DESCRIPTION Report 

Options 

Inventory 

Adjustments 

A report of all adjustments made to your tracked inventory 

items including the Buy Code and Buy Description, 

together with the Adjustment Quantity. 

D, T 
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Inventory 

Count 

A list of tracked inventory items together with the current 

quantity on hand for conducting a manual inventory count. 
T 

Items List: A list of items in your inventory. 

Options are to include All Items or Selected Items, to 

include Buy Only, Sell Only or Buy/Sell items and 

includes the Quantity On Hand. 

I, T 

Price List A list of Sell items including descriptions and prices. If 

you use Customer Types, you can choose to print the 

report for a selected Customer Type. 

I, T 

Inventory 

Movement 

Reports the movement in your tracked inventory items. 

The Summary report summarises the total movement 

while the Detailed reports include details of transactions. 

D, F, T 

Inventory 

Reorder 

A list of tracked inventory items where the reorder level 

has been reached. 

T 

Inventory 

Valuation 

A list of tracked inventory items including on hand values 

and total inventory valuation. 

The summary report lists the Quantity On Hand, the 

Average Cost and the Value of the Inventory Items on 

Hand. The detailed report also includes the Opening 

Quantity and Opening Value as well as the Movement in 

Quantity. 

NOTE: Invoice Manager uses the Average Cost method to 

value inventory. The Average Cost is calculated by 

combining the Total Cost of Purchases with the Opening 

Value and dividing this by the Opening Quantity plus 

Quantity Purchased. The Average Cost is then multiplied 

by the Quantity on Hand to calculate the Closing Value. 

eD, F, I, T 

 

 
 

Other Functions 

Invoice Layouts 

Sales Invoices, Credit Notes, Picking Slips, Purchase Orders, Purchase Invoices, Receipts or 

Statements 

Invoice Manager has standard layouts for Invoices, Credit Notes, Picking Slips, Purchase 

Orders, Purchase Invoices, Receipts and 2 standard layouts for Statements included with the 

program. To use these standard layouts, see the section ‘Invoice Design (Layouts)’ in the 

‘Options’ section. 

If you have Microsoft® Word installed, another alternative is to print your invoices and others 

using Microsoft Word. If you would like to use Word, see the section on ‘Printing Invoices 

Using Microsoft Word’. 
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Print Invoices with Microsoft Word 

To print using Microsoft Word you must have Microsoft Word installed on this computer. 

Version 11 is compatible with MS Word 2007-2016. The option to use Word for printing must 

be enabled in the Options. To do this, click on the Tools menu, select Options and then 

Microsoft Word Settings. 

Tick the sections you wish to use Word for printing, and click the [Browse] button for each to 

select the Word template file to use. A default template will be selected if no change is made. 

Once you have chosen to print using Microsoft Word, your selected printouts will automatically 

open Microsoft Word when you click on the [Print] button. 

When you close the Microsoft Word page you have the option to save the document if you wish, 

the default location is the ‘C:\Users\Username\AppData\Roaming\CFM\Cashflow11\Data’ 

folder. 

To remove the option to print using Word, click on the Options, select Microsoft Word 

Settings and un-tick the selection boxes for the items you do not wish to use. 

 

Creating a Word Template 

To set up your own template, start by using an existing template that comes with the Invoice 

Manager program. Make a copy of the original before making changes. 

The existing templates are stored in subfolders of the program folder, by default installed to 

“C:\Users\Username\AppData\Roaming\CFM\Cashflow11\Templates”. There is a subfolder 

for each template type i.e. Invoice, Adjustment Note, Purchase Invoice, Purchase Order, 

Receipts, Returns and Statements. 

Invoice Manager fills in the data fields from the information gathered from the document, and 

company details. On the template, each data field is denoted by square brackets. For example, 

[MyCompName] will display your Business Name. It will NOT print the words 

“MyCompName”. 

A list of field markers is set out in the table below. You can add each field marker as many times 

as you like. However, the field marker will need to match exactly to the one in the list, including 

capitals. 
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Special Considerations 
 

The template has three parts: 

1. Supplier and Customer address details 

2. Transaction Details 

3. Totals 

The Transaction (Invoice Line) Details and Totals must be kept in the tables already provided. 

If you add other tables to the templates, use the ‘Advanced Template Settings’ in Options – 

Microsoft Word Settings to control the position of the tables required by the template to work 

correctly. 

 

Codes / Field Markers for Word Templates 
 

Marker Field Description Invoice Credit 

Note 

Purchase 

Invoice 

Purchase 

Order 

Receipts Returns Statements 

My Company Details        

[VATRegNo] Your VAT Number ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

[MyCompName] Your Company Name ✓ ✓ ✓ ✓ ✓ ✓ ✓ 
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[MyAdd1] Your Address Line 1 ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

[MyAdd2] Your Address Line 2 ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

[MyCity] Your City ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

[MyCounty] Your County ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

[MyPC] Your Post Code ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

[MyPhone] Your Phone Number ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

[MyFax] Your Fax Number ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

[MyEmail] Your Email Address ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

[MyCountry] Your Country ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

[MyPhoneAlt] Your Phone Alternate ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

[MyPhoneMob] Your Phone Mobile ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

[MyLicenseNo] Your license Number ✓ 
      

[MyWebAddress] Your Web Address ✓ ✓ 
 

✓ ✓ ✓ ✓ 

Customer Details        

[CustCode] Customer Code ✓ ✓ 
  

✓ 
 

✓ 

[Cust 

VATRegNo] 

Customer VAT Number ✓ ✓ 
  

✓ 
 

✓ 

[CustName] Customer Contact Name ✓ ✓ 
  

✓ 
 

✓ 

[CustCompName] Customer Company Name ✓ ✓ 
  

✓ 
 

✓ 

[PAdd1] Postal Address Line 1 ✓ ✓ 
  

✓ 
 

✓ 

[PAdd2] Postal Address Line 2 ✓ ✓ 
  

✓ 
 

✓ 

[PCity] Postal City ✓ ✓ 
  

✓ 
 

✓ 

[PCounty] Postal County ✓ ✓ 
  

✓ 
 

✓ 

[PPC] Postal Post Code ✓ ✓ 
  

✓ 
 

✓ 

[PCountry] Postal Country ✓ ✓ 
  

✓ 
 

✓ 

[DAdd1] Delivery Address Line 1 ✓ ✓ 
  

✓ 
 

✓ 

[DAdd2] Delivery Address Line 2 ✓ ✓ 
  

✓ 
 

✓ 

[DCity] Delivery City ✓ ✓ 
  

✓ 
 

✓ 

[DCounty] Delivery County ✓ ✓ 
  

✓ 
 

✓ 

[DPC] Delivery Post Code ✓ ✓ 
  

✓ 
 

✓ 

[DCountry] Delivery Country ✓ ✓ 
  

✓ 
 

✓ 

[Phone] Customer Phone Number ✓ ✓ 
  

✓ 
 

✓ 
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[PhoneAlt] Customer Phone Alternate ✓ ✓ 
  

✓ 
 

✓ 

[PhoneMob] Customer Phone Mobile ✓ ✓ 
  

✓ 
 

✓ 

[Fax] Customer Fax Number ✓ ✓ 
  

✓ 
 

✓ 

[Email] Customer Email Address ✓ ✓ 
  

✓ 
 

✓ 

[CustE1] Customer Details Extra Field 1 ✓ ✓ 
  

✓ 
 

✓ 

[CustE2] Customer Details Extra Field 2 ✓ ✓ 
  

✓ 
 

✓ 

[CustE3] Customer Details Extra Field 3 ✓ ✓ 
  

✓ 
 

✓ 

[CustE4] Customer Details Extra Field 4 ✓ ✓ 
  

✓ 
 

✓ 

Supplier Details        

[SupCode] Supplier Code 
  

✓ ✓ 
 

✓ 
 

[SupVATRegNo] Supplier VAT Number 
  

✓ ✓ 
 

✓ 
 

[SupName] Supplier Contact Name 
  

✓ ✓ 
 

✓ 
 

[SupCompName] Supplier Company Name 
  

✓ ✓ 
 

✓ 
 

[PAdd1] Postal Address Line 1 
  

✓ ✓ 
 

✓ 
 

[PAdd2] Postal Address Line 2 
  

✓ ✓ 
 

✓ 
 

[PCity] Postal City 
  

✓ ✓ 
 

✓ 
 

[PCounty] Postal County 
  

✓ ✓ 
 

✓ 
 

[PPC] Postal Post Code 
  

✓ ✓ 
 

✓ 
 

[PCountry] Postal Country 
  

✓ ✓ 
 

✓ 
 

[DAdd1] Delivery Address Line 1 
  

✓ ✓ 
 

✓ 
 

[DAdd2] Delivery Address Line 2 
  

✓ ✓ 
 

✓ 
 

[DCity] Delivery City 
  

✓ ✓ 
 

✓ 
 

[DCounty] Delivery County 
  

✓ ✓ 
 

✓ 
 

[DPC] Delivery Post Code 
  

✓ ✓ 
 

✓ 
 

[DCountry] Delivery Country 
  

✓ ✓ 
 

✓ 
 

[Phone] Supplier Phone Number 
  

✓ ✓ 
 

✓ 
 

[PhoneAlt] Supplier Phone Alternate 
  

✓ ✓ 
 

✓ 
 

[PhoneMob] Supplier Phone Mobile 
  

✓ ✓ 
 

✓ 
 

[Fax] Supplier Fax Number 
  

✓ ✓ 
 

✓ 
 

[Email] Supplier Email Address 
  

✓ ✓ 
 

✓ 
 

[SupE1] Supplier Details Extra Field 1 
  

✓ ✓ 
 

✓ 
 

[SupE2] Supplier Details Extra Field 2 
  

✓ ✓ 
 

✓ 
 

[SupE3] Supplier Details Extra Field 3 
  

✓ ✓ 
 

✓ 
 

[SupE4] Supplier Details Extra Field 4 
  

✓ ✓ 
 

✓ 
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[PONo] Purchase Order Code 
   

✓ 
   

[PODate] Purchase Order Date 
   

✓ 
   

[PORef] Purchase Order Reference 

Number 

   
✓ 

   

[POMess] Purchase Order Message 
   

✓ 
   

[PINo] Purchase Invoice Code 
  

✓ 
    

[PIDate] Purchase Invoice Date 
  

✓ 
    

[PITerms] Purchase Invoice Terms 
  

✓ 
    

[PIDueDate] Purchase Invoice Due Date 
  

✓ 
    

[PIRef] Purchase Invoice Reference 

Number 

  
✓ 

    

[PIMess] Purchase Invoice Message 
  

✓ 
    

[RetNo] Return Code 
     

✓ 
 

[RetDate] Return Date 
     

✓ 
 

[RetMess] Return Message 
     

✓ 
 

Document Details        

[InvNo] Invoice Code ✓ ✓ 
     

[InvDate] Invoice Date ✓ 
      

[InvTy] Invoice Type ✓ 
      

[InvPON] Purchase Order Number ✓ 
      

[JobNo] Job Number ✓ 
      

[InvE1] Invoice Extra Field 1 ✓ 
      

[InvE2] Invoice Extra Field 2 ✓ 
      

[InvE3] Invoice Extra Field 3 ✓ 
      

[InvE4] Invoice Extra Field 4 ✓ 
      

[InvST] VAT: Invoice Total Inc VAT ✓ 
      

[InvET] Invoice Total Ex VAT ✓ 
      

[InvT] VAT: VAT Total ✓ 
      

[InvAP] Invoice Amount Received ✓ 
      

[InvIB] Invoice Balance Owing ✓ 
      

[InvMess] Invoice Message ✓ 
      

[PONo] Purchase Order Number 
   

✓ 
   

[PODate] Purchase Order Date 
   

✓ 
   

[POST] Purchase Order Total Inc VAT 
   

✓ 
   

[POET] Purchase Order Total Excl VAT 
   

✓ 
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[POT] Purchase Order Total VAT 
   

✓ 
   

[POMess] Purchase Order Message 
   

✓ 
   

[PIET] Purchase Invoice Total Exc VAT 
  

✓ 
    

[PIST] Purchase Invoice Total Inc VAT 
  

✓ 
    

[PIT] Purchase Invoice Total VAT 
  

✓ 
    

[PIAP] Purchase Invoice Amount Paid 
  

✓ 
    

[PIIB] Purchase Invoice Balance 
  

✓ 
    

[RetET] Return Invoice Total Exc VAT 
     

✓ 
 

[RetST] Return Invoice Total Inc VAT 
     

✓ 
 

[RetT] Return Invoice Total VAT 
     

✓ 
 

[AdjNo] Credit Note Code 
 

✓ 
     

[AdjDate] Credit Note Date 
 

✓ 
     

[AdjST] VAT: Credit Total Inc VAT 
 

✓ 
     

[AdjET] Credit Total Ex VAT 
 

✓ 
     

[AdjT] VAT: VAT Total 
 

✓ 
     

[AdjMess] Credit Note Message 
 

✓ 
     

[RecNo] Receipt Number or Code 
    

✓ 
  

[RecDate] Receipt Date 
    

✓ 
  

[RecAmt] Receipt Total 
    

✓ 
  

Transaction Details        

[ILA] Invoice Line Sell Price x Quantity ✓ 
      

[ILC] Invoice Line Sell Code ✓ 
      

[ILD] Invoice Line Description ✓ 
      

[ILG] Invoice Line VAT/Tax amount ✓ 
      

[ILUP] Invoice Line Unit Sell Price ✓ 
      

[ILNU] Invoice Line Number of Units 

Quantity 

✓ 
      

[ILT] Invoice Line Total ✓ 
      

[ILDT] Invoice Line Extra Field Custom ✓ 
      

[ALA] Adjustment Line Sell Price x 

Quantity 

 
✓ 

     

[ALC] Adjustment Line Sell Code 
 

✓ 
     

[ALD] Adjustment Line Description 
 

✓ 
     

[ALG] Adjustment Line VAT/Tax 

amount 

 
✓ 
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[ALUP] Adjustment Line Unit Sell Price 
 

✓ 
     

[ALNU] Adjustment Line Number of 

Units Quantity 

 
✓ 

     

[ALT] Adjustment Line Total 
 

✓ 
     

[ALDT] Adjustment Line Extra Field 

Custom 

 
✓ 

     

[POLC] Purchase Order Buy Code 
   

✓ 
   

[POLD] Purchase Order Description 
   

✓ 
   

[POLG] Purchase Order VAT/Tax 

Amount 

   
✓ 

   

[POLUP] Purchase Order Unit Price 
   

✓ 
   

[POLNU] Purchase Order Number of Units 

Quantity 

   
✓ 

   

[POLT] Purchase Order Total 
   

✓ 
   

[PILC] Purchase Invoice Buy Code 
  

✓ 
    

[PILD] Purchase Invoice Description 
  

✓ 
    

[PILG] Purchase Invoice VAT/Tax 

Amount 

  
✓ 

    

[PILUP] Purchase Invoice Unit Price 
  

✓ 
    

[PILNU] Purchase Invoice Number of 

Units Quantity 

  
✓ 

    

[PILT] Purchase Invoice Total 
  

✓ 
    

[PILDT] Purchase Invoice Total 
  

✓ 
    

[RetLC] Return Invoice Buy Code 
     

✓ 
 

[RetLD] Return Invoice Description 
     

✓ 
 

[RetLG] Return Invoice VAT/Tax Amount 
     

✓ 
 

[RetLUP] Return Invoice Unit Price 
     

✓ 
 

[RetLNU] Return Invoice Number of Units 

Quantity 

     
✓ 

 

[RetLT] Return Invoice Total 
     

✓ 
 

[RetLDT] Return Invoice Total 
     

✓ 
 

[RecLIN] Receipt Invoice Number 
    

✓ 
  

[RecLDT] Receipt Invoice Date 
    

✓ 
  

[RecLDoc] Receipt Doctor Field 
    

✓ 
  

[RecLID] Receipt ID Field 
    

✓ 
  

[RecLPN] Receipt Patient Name Field 
    

✓ 
  

Statement History Fields        
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[StaOB] Opening Balance 
      

✓ 

[StaDP] Date Printed 
      

✓ 

[StaCB] Closing Balance 
      

✓ 

[StaNT] Closing Balance – Opening 

Balance 

      
✓ 

Statement History Line Fields        

[StaLDT] Item Date 
      

✓ 

[StaLD] Description 
      

✓ 

[StaLDR] Debit Amount 
      

✓ 

[StaLCR] Credit Amount 
      

✓ 

[StaLRT] Running Balance 
      

✓ 

Statement Header Fields        

[StaOB] Opening Balance 
      

✓ 

[StaDP] Date Printed 
      

✓ 

[StaOBD] Start Date 
      

✓ 

[StaCBD] End Date 
      

✓ 

Statement Payment Fields        

[x][StaPLDT] Payment Date 
      

✓ 

[x][StaPLD] Description 
      

✓ 

[x][StaPLT] Amount 
      

✓ 

Statement Overdue Fields        

[x][StaOLDT] Overdue Date 
      

✓ 

[x][StaOLD] Description 
      

✓ 

[x][StaOLT] Amount 
      

✓ 

Statement Current Fields        

[x][StaILDT] Current Date 
      

✓ 

[x][StaILD] Description 
      

✓ 

[x][StaILT] Amount 
      

✓ 

Statement Footer Fields        

[StaPLGT] Running Total Payments 
      

✓ 

[StaOLGT] Running Total Overdue 
      

✓ 

[StaCGT] Running Total Invoices 
      

✓ 

[StaNT] Running Total Invoices – 

Running Total Payments 

      
✓ 

[StaCB] Closing Balance 
      

✓ 
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Job Numbers 

Job Numbers allow you to apply invoices to jobs to give you information on the income and 

costs for those jobs. For example, a builder may be working on several projects and require 

invoices to be applied to each project. 

If you did not elect to use Job Numbers when setting up your file, click on the Tools menu, 

select Options, then Advanced Preferences and tick Use Job Numbers. 

To open the Jobs List, click on the Tools menu and select Jobs List. 

The Jobs List page will appear. Any existing jobs will be listed. 

For example: a firm of builders has a job to supply and lay bricks at 1 Smith Street. For ease of 

identification they use the address as the job name. 

They have already created a Job and have decided to use sub-jobs to get better information on 

their business. They have created a sub-job for the Supply and now wish to do the same for the 

Lay. 

1. Click on the [New] button. 

2. Record a unique Job Number and Job Name. 

3. Record a Description for the job. 

4. Record the expected Start Date and End Dates for the job to assist you with your project 

management. 

5. Click on the arrow next to the Customer Code to select the customer for the job. 

You will also notice an [Inactive] button. When the job is completed, this button is used to 

remove this job from the list (and reports) of active jobs. 

6. Once you have completed the information, click on [Save]. 

The Jobs List will now include the job at the end of your list of jobs and positioned on the left to 

indicate that this is currently reporting as a job on its own. 

If you wish to move the Job up or down in order, click on the Up or Down arrows at the right of 

the window. 

To find a specific job, enter the job number in the box below the [Find] button, then click [Find] 

to move directly to that job. 

In our example, we wish to make this a sub-job of the 1 Smith Street job (Job 2014-1). With the 

line selected and in the location, we want it (under the master job), click on the right arrow at the 

right of page. This will indent the job and make it a sub-job of the master job above. If you 

wished this to be a sub-job of the 2014-1a job, simply click the right arrow again. We will not do 

this as we just want it to report as a sub-job of 2014-1. 

Click on [Save] to save the changes and then [Cancel] to exit the Jobs List page. 

We now have a Job No. column when recording the supplier’s invoice. When recording the 

invoice for the supply of bricks, select Job No. 2014-1a. When the invoice for bricklaying is 

received, select Job No. 2014-1b. (If the invoice for the supply covers more than one job then 

each line can be allocated a different job number.) 

When creating an invoice for our customer, we can select the job number in the bottom left 

corner of the Invoice page. 

Having recorded our suppliers’ invoices and invoiced our customer, if we now return to our Jobs 

List we will see the following information: 

The master job 2014-1 has income of £10,000 (excluding VAT), total costs of £7000 (made up 

of £5000 for sub-job 2014-1a and £2000.00 for sub-job 2014-1b) and net profit of £3000. If you 
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click on the Show Detail button at the top right of the page, the Jobs List will also show the 

invoice numbers and amounts that make up the total. 

If you wish to edit the details of a job, click on the [Edit] button. This will open the same page 

as the [New] button but will include the details you have recorded for the job. 

Click on the [Print] button to print your Jobs List information. You have the choice of a 

Summary Report or one that also includes Details. If you want to include the details, click on the 

Show Detail checkbox on the Jobs List page prior to clicking on the [Print] button. 

You can also choose to [Print Selected Jobs]. This will print the selected job including any sub- 

jobs that apply. 

Please note: the example has used sub-jobs for demonstrating how the program works. 

However, we would normally only have used sub-jobs if they were large jobs and we wanted 

information about them. In normal circumstances for this example we would have just used the 

one job number. 

 

 

Reports (Jobs) 

The Reports tab in the Invoice Manager section lists reports for Sales, Purchases and 

Inventory. 

 

Report Options - Jobs 

Once a report is selected, there are options to select different parameters for the generation of the 

report. The Report Options listed in the following table are: 

D – Date Period. Choose a report date range from Last Month, Last Quarter, Last Year, This 

Month, This Quarter, This Year or Custom (select report start and end periods where 

appropriate). 

eD- End Date Only. Report relates to a specific period and the only option is to select an end 

date for the report. 

E –Includes reports formatted especially for Microsoft Excel. 

F – Filter report. Report will show information based on filters e.g. Detailed or Summary, 

Include Invoice Manager balances, Single or Multiple Columns etc. 

J – Job selection. Choose either All Jobs or Select Jobs (open a list of all Jobs to select from). 

T – Type of printout. Choice of print layout or specific print media. 

 

Types of Reports – Jobs 

The following table summarises the report available in the Jobs section. 
 

 

REPORT DESCRIPTION Report 

Options 

Jobs Summary of Income and Expenses involved 

in Jobs to determine Profit and Loss 

J 
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Email an Invoice, Order, Report, Statement, etc. 

Anything you create in Invoice Manager that can be printed can also be emailed as an Adobe 

PDF Document. This includes Invoices, Purchase Orders, and Statements but also more 

‘internal’ reports like Order Status reports or Sales reports. Customised Word Documents can 

also be attached and emailed if you wish. 

Whenever you print preview a document or report, simply click the [Email] button and the email 

page will appear. For more information, see ‘Email Reports’ in the ‘Functions Common to All 

Programs’ section of this guide. 

 

Import Customers, Suppliers and Inventory 

Cashflow Manager allows you to import Customers, Suppliers, and Inventory Items by going to 

the File menu and selecting Import. 

Version 11 includes a user-friendly import routine, by selecting the type of data you wish to 

import, and providing ready-made templates to add your data. 

The ready-made templates can be found in the following location; 

C:\Users\Username\AppData\Roaming\CFM\Cashflow11\Import Templates. These templates 

have fixed column headings, allowing you to add the relevant information into the correct 

columns. You can then save these templates ready for import. 

Cashflow Manager also provides additional instructions on how to create import templates. 

These documents can be found in the following location; 

C:\Users\Username\AppData\Roaming\CFM\Cashflow11\Import Help. 

The following information will use importing “Customers” as an example. 

 

The Import Process 

To begin, click on the File menu, and select Import File. 

The Import Data screen will appear, outlining the following information: 

To import your Customers, Suppliers, and Inventory into Cashflow Manager you must ensure 

that the file you wish to import is formatted correctly. 

 
 

There are basically 3 steps you need to follow: 

1. Select the Type of data you want to Import 

2. Copy the data from your own spreadsheet and paste it into the template provided, or Proceed 

to Step 3 if you already have an import file prepared. 

3. Import your file 

Once you are ready to begin, click [Start] 

 
 

Step 1: Select the type of data you want to import 

Select Customers, Suppliers or Inventory (We will use Customers as an example) 

Select Customers and [Next] 

 
Step 2: Your current import 
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a. For this current import, have you already used the Customers Import Template to create your 

Customers import file? 

Or, 

b. For this current import, have you already created an Export file you wish to import? 

 

If you select YES, and click [Next], you will automatically be taken to Step 3 (see Step 3 for 

instruction), where you can import your already formatted file or template. 

Step 3: Import Your File 

1. Select one of the following options relevant to you; 

• Add and Update Records 

• Only Update Records 

• Only Add New Records 

2. Click on [Browse] to select your import file. The program will default to 

C:\Users\Username\AppData\Roaming\CFM\Cashflow11\Files Ready To Import pathway for 

file selection. If your file is in another location, navigate to this destination, select your file and 

click [Open]. 

3. Click [Import] 

4. An Import Complete message will appear, asking if you would like to import another file. 

Click on Yes or No. If you click Yes, repeat the import process. If you click No, your 

Customer’s will be added and updated. 

 
 

If you select NO, and click [Next], a spreadsheet will open on your screen, or on your task bar. 

You can copy the data from your provided spreadsheet and paste it into the one that opens (see 

How to Create your Customer Import Template below). Once you are finished adding your 

data, click [Create File] in the top left of the spreadsheet, and choose a location to save it (the 

default location is recommended; 

C:\Users\Username\AppData\Roaming\CFM\Cashflow11\Files Ready To Import 

 
 

Please Note: the same processes apply for Importing Suppliers and Inventory 

 

How to Create your Customer Import Template 
 

1. Open your file that contains the Customers you want to import. 

2. Check the file for any fancy formatting, report titles, graphs and blank rows and get rid of 

these features. 

3. Compare the Headings in your file to the Headings in the Template. 

4. Once you have identified corresponding data, select the data from your file and add to the 

Customer Import Template by following the steps below. 

 

• From your file, select the first cell in the column. (Do not select your Headings) 

Sample of your file 
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• Press the Ctrl + Shift + Down Arrow keys on your keyboard. This will select every 

record in the column. 

 

• Right click your mouse inside the selected area and select ‘Copy’ from the pop-out 

menu. 
 

 

 

 

 

 
• In the Customer Import Template, select the first cell in the column you want to paste 

the records into. 

 

In our example, you would select the B2 cell because the ‘Customer Code’ records that were 

copied from your file are compatible to the ‘Customer Code’ in the Customer Import Template. 
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• On your keyboard, press the Ctrl + V keys to paste the records into the Customer 

Import Template file. 

• Repeat this process for all other data you need to take form your Customer list file. 

 

Information: Please note that any record you add to the Customer Import Template that have 

a ‘Customer Code’ that already exists in your Invoice Manager Program Customer List, will just 

be updated. Any ‘Customer Code’ added to the Customer Import Template that do not exist in 

your Invoice Manager Program Customer List will be added as new Customer records. 

 

• Once you have pasted all the data from your file, click the [Create File] button. 

 

• If you have recorded any invalid data into the Customer Import Template, the cells 

will be highlighted with a Colour. You can click the Red ‘Colour Error Codes’ tab at the 

bottom of the Template to see an explanation of the error. 
 

 

 

• If all of the data you recorded into the Customer Import Template is valid, you will 

see the following ‘Save’ dialogue screen. 
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The default location will be set to the Cashflow Manager Applications location. This location is 

automatically used when it comes time to import the Customer Import File you created so it is 

best to leave it as it is. 

 
 

Please Note: the same processes apply for Importing Suppliers and Inventory 
 

 
 

Export Data 

Invoice Manager can export Customer, Supplier, and Inventory lists. 

These files will have the following name and extensions: 

• Customer Import.cif 

• Supplier Import.sif 

• Inventory Import.iif 

Click on the File menu, and select Export. 

An Export Data screen will appear, asking you to select the following information to export: 

Customers, Suppliers, Inventory, or Mail Merge 

Select the type of data to be exported and click the [Export] button. A “Save As” window will 

appear, defaulting to C:\Users\Username\AppData\Roaming\CFM\Cashflow11\Files Ready To 

Import. If you wish to save the file in a different location, navigate to this destination. Click 

[Save]. 

An Export Complete message will then appear once the process has completed. 

 

 

Change the VAT Rate 

The VAT rate is set by default at 20%. To change the VAT rate, click on the Tools menu, select 

Options and then select from the Tax Settings list. Type in the new VAT Rate. Click on 

[Save]. 

 

Restoring Default Column Widths 

If you have changed the column widths in your input pages and you wish to restore the default 

column widths, click on the Tools menu and select Restore Default Column Widths. 
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Troubleshooting 
 
 

Problem Potential Solution 

The page freezes when printing 

through Microsoft Word. 

You must have Microsoft Word installed to print with 

this program. Click on the Tools menu, Options and MS 

Word Setup. Click on the boxes to remove any selection 

ticks. 

Some anti-virus programs also prevent invoices being 

printed through Word. 

Printed invoice says Draft. Finalise the invoice and print it again. 

 

My Customer Inquiry balance does 

not equal a Statement or the Aged 

Debtors Report. 

 

You may have Credit Amounts or Credit Notes that have 

not been assigned to invoices. Outstanding Credit 

Amounts are advised at the bottom of the Customer 

Inquiry page. Click on the [Credit Note] button and 

check the Assigned column for any credit notes that have 

not been assigned. 

 
Unable to delete an invoice. 

 
Invoices cannot be deleted once saved. 
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Customer Service 
Customer Engagement Team 

 
The Customer Engagement Team provide software and program support to clients with general queries on how to use the 

software, program errors, database issues, and technical support. 

 

It is important to note: 

The Customer Engagement Team are not Accountants, Bookkeepers, Financial or Tax Advisors. They cannot offer or 

provide this type of support or information. It is illegal for them to do so. If you wish for this type of support please consult 

your Accountant, Bookkeeper, Financial or Tax Advisor. 

 

Contact Us 
The Customer Engagement Team is here to help you with any Sales or Administration related queries. 

If you require assistance, please call the Customer Engagement Team on 0345 1300611. 

Alternatively, you can email us at info@cashflowmanager.co.uk 

 

mailto:support@cashflowmanager.co.uk

